Biennial Conference on Chemical Education 2024 28 Jul - 01 Aug 2024 All times in EDT

Sunday, 28 july

8am

8:30am

8:30am

8:30am

Workshop and Demo Prep
JSB-258
Chaired by: April French

Experiential Chemistry: A hands-on laboratory-based course for
non-majors

JSB-218
Chaired by: Marc Richard

Experiential Chemistry: A hands-on laboratory-based course
for non-majors

» Marc Richard, Elizabeth Pollock

ChemMatters: Building Curiosity and Encouraging Science
Literacy

JSB-108
Chaired by: Kelley Donaghy

ChemMatters: Building Curiosity and Encouraging Science
Literacy

» Kelley Donaghy

Introduction to Integrating Green Chemistry and Sustainability
in Undergraduate Teaching Laboratories

JSB-114
Chaired by: John De Backere

Introduction to Integrating Green Chemistry and
Sustainability in Undergraduate Teaching Laboratories

» Jonathon Moir, John De Backere, David Laviska, Jane Wissinger
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8:30am

8:30am

8:30am

8:30am

8:30am

Activities to develop international standards for ethics in
chemistry

JSB-231
Chaired by: Susan Schelble

Activities to develop international standards for ethics in
chemistry

» Susan Schelble, Kelly Elkins

Designing and implementing high-engagement collaborative
group work activities in chemistry classrooms

JSB-243
Chaired by: Vicente Talanquer

Designing and implementing high-engagement collaborative
group work activities in chemistry classrooms

» Renée Cole, Gregory Rushton, Vicente Talanquer

Peak Potential: Affordable Solutions for Instructing
Electrochemical Techniques

JSB-244
Chaired by: Melissa Hill

Peak Potential: Affordable Solutions for Instructing
Electrochemical Techniques

» Melissa Hill

Moving Students From Description to Explanation with
VisChem

JSB-347
Chaired by: Ellen Yezierski

Moving Students From Description to Explanation with
VisChem

» Ellen Yezierski, Roy Tasker

Cultivating Inclusivity and Equity in the Classroom
JSB-357
Chaired by: Andrea Carter
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Continued from Sunday, 28 July

10am

10:15am

10:15am

11:45am

Tpm

Tpm

1:06pm

Cultivating Inclusivity and Equity in the Classroom
» Andrea Carter, Alexandra Ormond

Break

Play It to Remember It; Effective Activities to Engage Student
Learning

JSB-108
Chaired by: Peggy Au

Play It to Remember It; Effective Activities to Engage Student
Learning

» Peggy Au

Teaching Essential Chemistry Content Through Demonstrations
JSB-244
Chaired by: Jeramy DeBry

Teaching Essential Chemistry Content Through
Demonstrations

» Jeramy DeBry
Lunch

$306: The Post-Exam Classroom: Using Authentic Assessments
to Build 21st-Century Skills

CP-103
Chaired by: Lindy Stoll

Introduction (S306)
» Lindy Stoll

Encouraging Creativity in Chemistry Through Creative Final
Projects

» Teresa Eaton

Powered by Ex Ordo, everything you need to run a research conference.

1:27pm

1:48pm

2:09pm

Tpm

Tpm

1:06pm

1:27pm

1:48pm

2:09pm

Tpm

Using a Lab Practical to Assess Lewis Structures and
Intermolecular Forces

» Hannah Nandor

The ‘Real World’ After Graduation- Insights Into Teaching and
Advising Chemistry Students

» Tim Saarinen

Roundtable Conversation: Integrating Career-Ready Skills
Development Into the Curriculum (S306)

» Lindy Stoll

S310: Professional Development for Pre-College Educators:
Grants, Technology, and Resources within the Education
Community

CP-111
Chaired by: Esther Hines

Introduction (S310)
» Esther Hines

Oh The Places You'll Go! ACS Resources, Opportunities and
Hierarchy

» Roxie Allen

Content, Community, & Cultivating a Love of Chemistry
» Erica Posthuma

Collaboration, reviewer calibration, peer feedback, and
professional development in one PAC!

» Michael Garoutte, Eileen Kowalski, Mary van Opstal, Melissa
Reeves, Caryl Fish, Brandon Fetterly

Mentoring at the United States Chemistry Olympiad Camp
» Esther Hines

$191: ACS-CES Award Symposium for Incorporation of
Sustainability into Chemical Education

CP-114
Chaired by: Jane Wissinger
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Continued from Sunday, 28 July

Tpm

1:06pm

1:27pm

1:48pm

Tpm

Tpm

1:06pm

1:27pm

Introduction (S191)
» Jane Wissinger

Using Green Chemistry to Address Environmental Injustices:
A Set of Assignments that Explore the Intersection of
Scientific Ethics, the Chemical Literature, and
Communication Skills

» Jessica Tischler

Greening the Introductory Organic Chemistry Laboratory:
Sustainable Practices in Action

» Menggi Zhang, Elizabeth Day, Melanie Cooper, Hunter McFall-
Boegeman, Steven Petritis

Incorporating Green Chemistry, Sustainability, and Climate
Change Themes into the First-Year Chemistry Curriculum and
Outreach Activities

» A M Ranjika (Dharshi) Bopegedera

$218: Building Bonds: Fostering a Sense of Belonging in Large-
Enrollment Chemistry Courses

CP-139
Chaired by: Theodore Alivio and Alicia Altemose

Introduction (S218)
» Elinor Soult

Changing Hearts and Minds about Chemistry: Creating a
Productive Learning Environment by Fostering a Sense of
Belonging and Collaboration in Introductory Chemistry

» Amy Graham

Student Sense of Belonging and Confidence in General
Chemistry

» Nicole Karn, Jennifer Collins, Makda Berhe, Sarah Ogrin-
Cortarlan
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1:48pm

2:09pm

Tpm

Tpm

1:06pm

1:27pm

1:48pm

2:09pm

Tpm

Tpm

Using course data to generate student-specific messaging in
large enrollment courses: Preliminary use of personalized
messaging to target less engaged students to improve sense
of belonging and course persistence

» Lisa Nguyen, Rebecca Ricciardo

The Impacts of Science Belonging and Unbelonging in
Gateway POGIL Classes

» Matthew Horn, Charity Lovitt, Tracey Murray, Olga Glebova

$278: Implementing Active Learning in the First Two Years of
Chemistry Coursework

CP-153
Chaired by: Michelle Brooks

Introduction (5278)
» Michelle Brooks

Using Branding and Project-Based Learning in General
Chemistry

» Silas Towne

Experiences from Implementing and Incorporating Active
Learning in Large First-Year General Chemistry classes

» Bhavani Balasubramanian

A Case Study of Classroom Implementation of Active
Learning

» Jack Huang

Active Learning Strategies to Teach Molecular Structure
Using C-13 NMR

» Scott Donnelly

S61: Engaging Students in Organic Chemistry
CP-155
Chaired by: Patricia Kreke

Introduction (S61)
» Elinor Soult
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1:06pm

1:27pm

1:48pm

2:09pm

Tpm

Tpm

1:06pm

1:27pm

1:48pm

Tpm

Card Game for Learning Organic Functional Groups
» Marsha Grimminger

From STEM to STEAM: Bringing the Arts and Pop Culture into
Organic Chemistry via Project-Based Learning

» Jordan Mader

Enhancing Interest, Enthusiasm and Performance in the
Beginning Organic Chemistry Course: History, Biography and
Polymer Science

» Bob Howell

Organic Chemistry and Second Language: A response to
Laszlo (2013)

» Robert Ferguson, David Cartrette

S77: Low Barrier Professional Development
CP-183
Chaired by: Kristina Stefaniak

Introduction (S77)
» Kristina Stefaniak

Faculty Professional Development Opportunities at ACS
» Michelle Brooks, Kerry Barnett, Wasiu Lawal, Ashlie Wrenne

Finding Support in Communities of Practice for a Time of
Transition: An Autobiographical Case Study

» Christine Morales

Panel Discussion, Continued (S77)
» kKim woodrum

S36: Assessment Instruments: Design, Development, and
Evaluation

CP-201
Chaired by: Molly Atkinson and Jack Barbera
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Tpm

1:06pm

1:27pm

1:48pm

Tpm

Tpm

1:06pm

1:27pm

1:48pm

2:09pm

Introduction (S36)
» Elinor Soult

Considerations when Using Assessment Instruments
» David Hamilton, Molly Atkinson

Trends and guidance on presenting validity evidence in
Chemistry Education Research and Practice

» Scott Lewis

Instrument development and use in the Journal of Chemical
Education (2010 - 2024)

» Tina Marcroft, Ruo Ning (Nancy) Qiu, Regis Komperda

S91: Catalyzing Innovations in Chemistry Education Research:
Harnessing the Power of Machine Learning and Generative
Artificial Intelligence

CP-208
Chaired by: Field Watts

Introduction (S91)
» Elinor Soult

Emerging Applications of Generative Artificial Intelligence in
Chemistry Education: Trends and Connections (View from the
Editors’ Porch)

» Elizabeth Yuriev, Donald Wink, Thomas Holme

The Role of Prompt Engineering on ChatGPT-Generated
Explanations of Organic Chemistry Reaction Mechanisms

» Brandon Yik, Amber Dood

Using Machine Learning to Identify Aspects of
Argumentation in Students’ Written Arguments about
Phenomena in Organic Chemistry

» Amber Dood, Field Watts, Ginger Shultz

Q&A Session (S91)
» kim woodrum
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Continued from Sunday, 28 July

Tpm

Tpm

1:06pm

1:27pm

1:48pm

2:09pm

Tpm

Tpm

S177: Assessment and Measurement in Research and Practice
CP-211
Chaired by: Kristen Murphy

Introduction (S177)
» Elinor Soult

What's new at ACS Exams: New exams, instructional
materials, workshops and ways to get involved

» Olga Michels, Sachin Nedungadi, Jaclyn Trate, Kristen Murphy

Investigating the Assessment of Preparatory Knowledge for
the First-Year Chemistry Course

» Pinky A McCoy, David Courson, Joshua Wallach

Planning and Evaluating Large Scale Studies of Student
Chemistry Learning Using Clickers as a Teaching and Data
Collection Tool

» Melonie Teichert, Regis Komperda, Diane Bunce, Maria
Schroeder, Debra Dillner, Dianne Luning Prak

A Program-Level Assessment of Student Understanding of
Thermodynamics, Equilibrium, and Kinetics in the Chemistry
Major

» Melonie Teichert, Shirley Lin, Amy MacArthur, Virginia Smith,
Elizabeth Yates

S$307: TA Training with Global Graduate Students
CP-220
Chaired by: Jennifer Monahan

Introduction (S307)
» Jennifer Monahan

Powered by Ex Ordo, everything you need to run a research conference.

1:06pm

1:27pm

1:48pm

2:09pm

Tpm

Tpm

1:06pm

1:27pm

1:48pm

2:09pm

Implementation 10C Training Course for Graduate Teaching
Assistants (GTAs) to Improve Consistency, Efficiency and
Pedagogy

» Ozlem Yavuz-Petrowski, Evonne Rezler, Jennifer Krill, Abigail
Perkins, Julie Golden-Botti

What a GTA Wants: Training and Professional Development
Requests by Graduate Teaching Assistants

» Michelle Herridge, Chloe Sells

Enhancing Support for International Teaching Assistants in
Chemistry Higher ED: Perspectives and Recommendations

» Jovita Ogechi Daraezinwa, Oluwatosin Obisesan, Udara
Wickramarathne

How to Train Your Teaching Assistants in a Way that is Fun
and Rewarding

» Sandra Lukaszewski-Rose

$25: General Chemistry Lab: Curriculum and Best Practices
CP-222
Chaired by: Jenine Maeyer

Introduction (S25)
» Elinor Soult

Firework Research: A New Twist on a General Chemistry
Laboratory Practical

» Alexandra Tamerius, Zachary Sibila

Transition Metal Coordination Chemistry Lab Re-Design
» Ramona Heitmann

Odyssey by PocketLab: An All-In-One Smart Phone Chemistry
Assistant

» John Suchocki

Using Repetition, Rubrics and Personalized Feedback to
Improve Lab Writing Skills in General Chemistry Labs

» Susan Thomas, Hadi Arman, Sarah Oerther
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Tpm

Tpm

1:06pm

1:27pm

1:48pm

2:09pm

Tpm

Tpm

1:06pm

$223: Solutions to Success: First- and Second-year Initiatives
and Programs to Support STEM Diversity

CP-287
Chaired by: Laura Anna

Introduction (S223)
» Laura Anna

Incorporating Diversity and Inclusivity Through Creative
projects

» Lauren Woods, Jefferson Bates

The Formation and First Three Years of a Chemistry Success
Center at a Large State Institution

» Emily E. Hardy, Chris Freeman, Pinky A McCoy, Andrea Stephen,
Joshua Wallach

Leveraging a Traditionally non-STEM Grant to Fund Summer
Research Experiences (SRE) for Undergraduate STEM
Students.

» Michael Gutierrez

Panel Discussion (S223)
» kim woodrum

$225: Innovative Assessments in Introductory Chemistry
Courses: Introducing More Effective Ways to Determine What
Your Students Know

CP-297
Chaired by: Lisa Hibbard

Introduction (S225)
» Lisa Hibbard

Development of a Novel Measure of Organic Chemistry
Students’ Deep Understanding of Science Practice

» Matthew Breuer, Alena Moon, John Zhou

Powered by Ex Ordo, everything you need to run a research conference.

1:27pm

1:48pm

Tpm

Tpm

1:06pm

1:27pm

1:48pm

Tpm

Tpm

Student Perspectives on Generating and Using Their Own
Crib Sheets for Exams in Introductory Chemistry

» Elizabeth McGinitie, Brian Rempel, Hope Zimmerman

Analyzing Student Generated Exam Crib Sheets in
Introductory Chemistry

» Brian Rempel, Elizabeth McGinitie, Hope Zimmerman

S38: Team-Based Learning: Implementation, Practice, and
Evaluation

JSB-103
Chaired by: Tamra Legron-Rodriguez and Julie Donnelly

Introduction (S38)
» Tamra Legron-Rodriguez

Five Years of Team-Based Learning: The Best, the Worst, &
the Hopes for Continued Growth

» Amy Gottfried

Exploring Team Composition, Function, and Performance in
an Upper-Level, Team-Based Learning Forensic Chemistry
Course

» Tamra Legron-Rodriguez, Linne Goberville, Patria Marcano
Maldonado, Julie Donnelly

Indicators of Team Function in a Large Enrolilment Team-
Based Learning General Chemistry Course

» Julie Donnelly, Patria Marcano Maldonado, Linne Goberville,
Tamra Legron-Rodriguez

$109: Organic Chemistry for Non-Chemistry Majors
JSB-203
Chaired by: Travis Lund

Introduction (5S109)
» Travis Lund
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1:06pm

1:27pm

1:48pm

2:09pm

Tpm

Tpm

1:06pm

1:27pm

1:48pm

Looking Past the Pre-Requisite Pigeonhole: Engaging Non-
Chemistry Majors in Organic Chemistry Courses

» Racquel DeCicco

Fostering Non-Major Student Engagement in Organic
Chemistry 1

» Sarah Zingales

Organic Chemistry Preparation for the Future Physician: the
MEDPREP Approach

» Tayler Hill, Anneke Metz

Incorporating Second-Chance Testing in Undergraduate
Chemistry Education in a Large Classroom

» Akiko Nakamura

$1961: General Papers
JSB-213

Introduction (S1961)
» kim woodrum

Nanomaterials for Sustainable Water Remediation:
Comparative Analysis of Carbon Adsorbents for Dyes
Removal

» Felipe Cordova Lozano, Ana Karen Cordova Estrada, Sandra
Guzman, Adan Zorrila, Miguel San Juan

Exploring Students’ Perceptions and Opportunities for
Curriculum Reform in an Academic Development Programme
Chemistry Course

» Tisetso Mosala, Kgadi Mathabathe, Rethabile Tekane

Assessing the integration of e-learning platforms in achieving
effective teaching and learning of Chemistry in college of
education in Anambra State, Nigeria

» Franklin Ibe

Powered by Ex Ordo, everything you need to run a research conference.

2:09pm

Tpm

Tpm

1:06pm

1:27pm

1:48pm

2:09pm

Tpm

Increasing Student Interest in Chemistry Using Real-World
Applications

» Stacy Stegall

S$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (5267)
» Elinor Soult

Social Dynamics in the Undergraduate General Chemistry
Laboratory

» Riley Eisert-Sasse, Laura Cruz

Embedding Team Science in Course-Based Undergraduate
Research Experiences: Key elements

» Clark Andersen, Joi Walker

Comparing the Progressions of Epistemological Messages and
Laboratory Teaching Assistant Perspectives Across Two
Sequences of a General Laboratory Chemistry Course

» Dalyanne Hernandez, Matt Wu

Teaching Acid-Base Chemistry in the Laboratory: A
comparative case study on teaching assistants’ didactics and
pedagogy

» Cassandra Miller, Matt Wu

Collaborative Huddle Engaging Magnification: CHEM
JSB-218
Chaired by: Kameyo Johnson

Collaborative Huddle Engaging Magnification: CHEM
» Kameyo Johnson
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Continued from Sunday, 28 July 1 pm

Tpm

Tpm

Tpm

Tpm

Tpm

Using Pipet Bulb Rockets to Introduce Stoichiometry
JSB-208
Chaired by: Bean Burr

Using Pipet Bulb Rockets to Introduce Stoichiometry
» Bean Burr

Assessment of Impacts of Green Chemistry Curriculum
JSB-114
Chaired by: Alexey Leontyev

Assessment of Impacts of Green Chemistry Curriculum
» Alexey Leontyev, Yujuan Liu

It's All Fun and Games When Everyone Learns!
JSB-231
Chaired by: Barbara van Kuiken

It's All Fun and Games When Everyone Learns!
» Barbara van Kuiken

Teaching Essential Chemistry Content Through Demonstrations

JSB-244
Chaired by: Jeramy DeBry

Teaching Essential Chemistry Content Through
Demonstrations

» Jeramy DeBry

Food in the Chemistry Class
JSB-261M
Chaired by: Sunil Malapati

Food in the Chemistry Class
» Sunil Malapati, Elizabeth Pollock

Powered by Ex Ordo, everything you need to run a research conference.

2:30pm

2:45pm

2:45pm

2:517pm

3:12pm

3:33pm

3:54pm

REAL Chemistry: Relevant, Equitable, Active Learning
Courseware for General Chemistry

JSB-357
Chaired by: Mark Blaser

REAL Chemistry: Relevant, Equitable, Active Learning
Courseware for General Chemistry

» Mark Blaser, David Yaron, Sandra Raysor, Gizelle Sherwood, Josh
Hartman, Ariel Anbar

Break

$306: The Post-Exam Classroom: Using Authentic Assessments
to Build 21st-Century Skills

CP-103
Chaired by: Lindy Stoll

Introduction (S306)
» Lindy Stoll

Incorporating Elevator Speech Activities Across Multiple
Courses

» Lindy Stoll

Development of an Upper-Level Elective Course Where
Students Determine Course Grading and Course Topics

» Julia Paredes

Roundtable Conversation: Fostering Shared Student
Workloads in Group Projects (S306)

» Lindy Stoll

Roundtable Conversation: Authentic Assessments at Scale
(S306)

» Lindy Stoll
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Continued from Sunday, 28 July 3:12pm

2:45pm

2:45pm

2:51pm

3:12pm

3:33pm

3:54pm

2:45pm

2:45pm

2:51pm

$310: Professional Development for Pre-College Educators:
Grants, Technology, and Resources within the Education
Community

CP-111
Chaired by: Esther Hines

Introduction (S310)
» Esther Hines

ACS Hach Grants and Resources
» Michael Mury, Kenetia Thompson

Using Professional Development to Build Community
» Michael Mury

VisChem Research into Practice: Visualizing the molecular
world to make sense of chemistry symbolism and
mathematics

» Roy Tasker, Ellen Yezierski

Next level professional development for teachers: The Math
and Science Manufacturing Experience

» Brian Aldrich, Audra Swarthout, Heather Brey

$191: ACS-CES Award Symposium for Incorporation of
Sustainability into Chemical Education

CP-114
Chaired by: Jane Wissinger

Introduction (S191)
» Jane Wissinger

Developing Systems Thinking Through the Chemistry of
Laundry Detergent and its Influence on Society, the Economy
and the Environment

» Lynne Pilcher, Micke Reynders, Marietjie Potgieter
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3:33pm

2:45pm

2:45pm

2:51pm

3:12pm

3:33pm

2:45pm

2:45pm

Advancing Public Health Education Through Understanding
UN SDG 6: Clean Water and Sanitation for 12th Grade Pupils

» Altantogos Myagmar

Panel Discussion and Awards (S191)

» Jane Wissinger

$218: Building Bonds: Fostering a Sense of Belonging in Large-
Enrollment Chemistry Courses

CP-139
Chaired by: Theodore Alivio and Alicia Altemose

Introduction (5218)
» Elinor Soult

Mentoring at-risk students in large enroliment General
Chemistry 1

» Martina Sumner

Students’ Senses of Belongingness and Implications for
Improving Classroom Instruction, Diversity, Equity, and
Inclusion in General Chemistry Courses

» Abayneh Gurmu, Keila Muller, Zamira Torres, Camila
Senespleda, Tamra Legron-Rodriguez

Role Models and Representation Affect Pre-Health
Professional Identity (PHPI) Development

» Schetema Nealy, Dorna Ektefaie, Sheba George

$278: Implementing Active Learning in the First Two Years of
Chemistry Coursework

CP-153
Chaired by: Michelle Brooks

Introduction (5278)
» Michelle Brooks
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2:51pm

3:12pm

2:45pm

2:45pm

2:517pm

3:12pm

3:33pm

3:54pm

2:45pm

Measuring the Abundance of Active Learning and Formative
Assessment Use in Chemistry Courses at Two-Year
Postsecondary Institutions: Results of a National Survey

» Kendall Zammit, Megan Connor, Jeffrey Raker

Panel Discussion (S278)
» Michelle Brooks

S61: Engaging Students in Organic Chemistry
CP-155
Chaired by: Patricia Kreke and Animesh Aditya

Introduction (S61)
» Elinor Soult

Investigating Students’ Reasoning on Acid and Base Strength
through Scaffolded Prompts

» Betul Demirdogen, Isaiah Nelsen, Scott Lewis

Building an Immersive Organic Chemistry Learning
Experience

» Jennifer Prado, Vanessa dos Reis Falcao, Allie Brandriet, Ali
Sattari

The use of Chirality-2 in a First Year Organic Chemistry Class:
Student Perceptions of the Mobile Gaming App

» Rethabile Tekane, Tisetso Mosala

EVQ (Embedded Video Question) Feedback as a Mechanism of
Establishing a Communication Channel

» Sarah Dimick Gray

$32: Inclusive Practices for Unrepresented Groups in STEM
CP-179
Chaired by: Nicole Lapeyrouse and Tamra Legron-Rodriguez

Powered by Ex Ordo, everything you need to run a research conference.

2:45pm

2:517pm

3:12pm

3:33pm

3:54pm

2:45pm

2:45pm

2:517pm

3:12pm

3:33pm

3:54pm

Introduction (S32)
» Nicole Lapeyrouse

Deficit and Anti-Deficit Framing: A Systematic Review of the
Literature

» Elizabeth Vaughan, Nicole James

Bridging Chemistry and Society: Integrating Social Justice in
Undergraduate Education
» Omar Villanueva

Is it Possible to Predict a Student's Final Grade in General
Chemistry I?

» Kariluz Davila-Diaz

Panel Discussion and Q&A (S32)
» kim woodrum

S77: Low Barrier Professional Development
CP-183
Chaired by: Kristina Stefaniak

Introduction (S77)
» Kristina Stefaniak

Can Something be Both a Little Thing and a Big Thing? Yes!
» Keith Anliker

Science Communication Volunteering as Low Commitment
Professional Development for Teachers

» Emily Kerr

Building Community Through a STEM Education Journal Club:
Engagement & Projects After Two Years

» Michelle Herridge

Academic Connections & Professional Development Lunch
Series for Non-Tenure Track Faculty

» Jennifer Monahan
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Continued from Sunday, 28 July 3:12pm

2:45pm

2:45pm

2:51pm

3:12pm

3:33pm

2:45pm

2:45pm

2:51pm

$36: Assessment Instruments: Design, Development, and
Evaluation

CP-201
Chaired by: Molly Atkinson and Jack Barbera

Introduction (S36)
» Elinor Soult

Exploring Students’ Confidence Judgments in Two-Tiered
Assessments

» Casandra Koevoets-Beach, Morgan Balabanoff, Karen Julian

Preliminary Results of the Application of an Item Writing
Flaw Analysis for the College Wide Final Exam for an
Introductory Chemistry Course

» Eric Cotton, Linda Prentice, P| Mitchell

Not all incorrect responses are equally incorrect: a modeling
approach to assigning partial credit

» David Schreurs, Jaclyn Trate, Sachin Nedungadi, Olga Michels,
Chrystal Bruce, Melissa Reeves, Patricia Kreke, Keith Marek,
Thomas Pentecost, Jeffrey Raker, Kristen Murphy

S91: Catalyzing Innovations in Chemistry Education Research:

Harnessing the Power of Machine Learning and Generative
Artificial Intelligence

CP-208
Chaired by: Field Watts

Introduction (S91)
» Elinor Soult

Breaking Language Barriers: Allowing Multiple Languages in
Chemistry Courses Via Multilingual Machine Learning

» Paul Martin, Nicole Graulich

Powered by Ex Ordo, everything you need to run a research conference.

3:33pm

3:54pm

2:45pm

2:45pm

2:517pm

3:12pm

3:33pm

3:54pm

2:45pm

Grading with Artificial Intelligence in General Chemistry Lab |
» Olivia Harwick, John Wiginton, Jason Pearson

Using Unsupervised Machine Learning to Investigate
Categorization of Introductory Chemistry Students’
Responses to Open-Ended Assessment Items

» Field Watts, Jon-Marc Rodriguez

Q&A Session (S91)
» kim woodrum

S177: Assessment and Measurement in Research and Practice
CP-211
Chaired by: Kristen Murphy

Introduction (S177)
» Elinor Soult

The development of a constructed response measure of
students’ knowledge of atomic spectra

» Haiyan Alfulaiti, Alena Moon

Embedding Real-world Contexts in a General Chemistry
Lecture Course and Assessment of the Impacts on Learning
Outcomes

» Jacinta Mutambuki, S.M. Ifat Hossain Sristy, Caroline Muteti,
Yolanda Vasquez

Cognitive Diagnosis of Student Performance on Chemistry via
Item Analysis and Data Visualization

» Christian Tang, Yi-Hsin Chen, Sherrisse Bryant, Kristine Hogarty

Use of Gradescope by Turnitin in General Chemistry Course
» Monica Khural, Nataliya A. Markina, Minh-Sang Lu

$307: TA Training with Global Graduate Students

CP-220
Chaired by: Jennifer Monahan
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2:45pm

2:51pm

3:12pm

2:45pm

2:45pm

2:51pm

3:12pm

3:33pm

2:45pm

Introduction (S307)
» Jennifer Monahan

Prioritizing Graduate Teaching Assistants Training for
Introductory Chemistry Courses: An Investigation of How
Graduate Teaching Assistants Influence Student Discourse

» Hannah Nennig, Carson Lovig, Renée Cole

Rehearsal-Based Training in a Mixed-Reality Teaching
Simulator to Support the Diverse Needs of GTAs in Active
Learning Environments

» Erin Saitta

$25: General Chemistry Lab: Curriculum and Best Practices
CP-222
Chaired by: Jenine Maeyer

Introduction (S25)
» Elinor Soult

Enhancing Scientific Writing Skills in Undergraduate
Chemistry: A Curriculum Approach and Assessment

» Michelle Morgan, Grace Murray, Emma Johnson, Eugene
Wagner

Enhancing Science Writing Skills Through Scaffolding and
Consistent Feedback in Lab Courses With Labflow

» Elizabeth Crowe

Backward Laboratory Course Design: Focus on a Central
Theme

» Brenda Harmon, Simbarashe Nkomo

$223: Solutions to Success: First- and Second-year Initiatives
and Programs to Support STEM Diversity

CP-287
Chaired by: Laura Anna

Powered by Ex Ordo, everything you need to run a research conference.

2:45pm

2:51pm

3:12pm

3:33pm

2:45pm

2:45pm

2:51pm

3:12pm

2:45pm

2:45pm

Introduction (5223)
» Laura Anna

A 2-year Institution’s Approach to Providing Accessible
Research Opportunities for Underserved STEM Students

» Brandon White, Becky Mercer

PrepareCTP - ACS' Strategic Initiative on Fostering a Skilled
Technical Workforce

» John-David R. Rocha

Panel Discussion (5223)
» kim woodrum

$225: Innovative Assessments in Introductory Chemistry
Courses: Introducing More Effective Ways to Determine What
Your Students Know

CP-297
Chaired by: Lisa Hibbard

Introduction (S225)
» Lisa Hibbard

Using Specifications-Based Grading in a Flipped General
Chemistry Il Course

» Broden Bunnell, Lauren LeBourgeois, James Doble, Brian Gute,

lacob Wainman

A Hybrid Approach to Specifications Grading in Introductory
Chemistry at Two Community Colleges

» Amy Nicely, Christina Beatty

S38: Team-Based Learning: Implementation, Practice, and
Evaluation

JSB-103
Chaired by: Tamra Legron-Rodriguez and Julie Donnelly

Introduction (S38)
» Tamra Legron-Rodriguez
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Continued from Sunday, 28 July 2:45pm

2:51pm

3:12pm

3:33pm

2:45pm

2:45pm

2:51pm

3:12pm

3:33pm

3:54pm

Collaboration and Career Development in a Research
Methods Course

» Gigi Ray

Unveiling Student Engagement in the Flipped Classroom:
Insights from Self-Determination Theory

» Nikita Burrows

Panel Discussion and Q&A (S38)
» kim woodrum

S$237: Learning Chemistry Beyond the Traditional Classroom
JSB-203
Chaired by: Marco Zimmer-De luliis

Introduction (S237)
» Marco Zimmer-De luliis

External Partners within the Aurora University Chemistry
Curriculum

» Kyle McElhoney, Ami Johanson, Juan Colon Santana, Chetna
Patel

Using a Hybrid Course Structure to Facilitate Three
Dimensional Learning: Incorporating Reform-minded
Instruction within a Traditional General Chemistry
Curriculum

» Jack Eichler

Advancing Students’ Scientific Identities Through
Collaborative Science Workshops: A Case Study Merging
Computational Chemistry and Electrochemistry Alongside
Data Science in a Real-world Context

» Rebekah Duke-Crockett, Chad Risko, Judy Jenkins, Craig Teague

Q&A Session (237)
» kim woodrum

Powered by Ex Ordo, everything you need to run a research conference.

2:45pm

2:51pm

3:12pm

2:45pm

2:45pm

2:517pm

3:12pm

3:33pm

3:54pm

$1961: General Papers
JSB-213

Introduction (S1961)
» kKim woodrum

ChatGPT Assistance in Creating Chemistry Practice Problems:
Pitfalls, Positives, and Possibilities

» Mike Christiansen

Providing a framework: Intermolecular forces using the van
der Waals equation

» William Tucker

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (5267)
» Elinor Soult

Exploring the Relationship Between Undergraduate Students’
Perceptions of Chemistry Labs and Their Career Goals

» Oluwaseun Agunbiade, Oluwatobi Odeleye

The Earlier the Better? A longitudinal study of undergraduate
research experiences

» Hayden Criswell, Jacob Pleasants

Developing Connections Between CURE Labs and Career
Applications Beyond Academia

» Kristel Forlano, Amanda Buchberger

Investigating External Factors That Impact STEM Student’s
Relationship With Their Major and Future Profession

» Amanda Lindquist, Macayla Barnett, Cameron Bechard, Tamra
Legron-Rodriguez, Nicole Lapeyrouse
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Continued from Sunday, 28 July 8am

2:45pm

2:45pm

5pm

5:30pm

Manipulatives for Chemistry: Helping Kids See
JSB-108
Chaired by: Maricar Harris

Manipulatives for Chemistry: Helping Kids See
» Maricar Harris

Building a kinetics unit plan using American Association of
Chemistry Teachers (AACT) resources

JSB-244
Chaired by: Shannon Smith

Building a kinetics unit plan using American Association of
Chemistry Teachers (AACT) resources

» Jeramy DeBry, Shannon Smith

Welcome to BCCE 2024
Singletary Center
Chaired by: Allison Soult

Keynote
Singletary Center for the Arts - Concert Hall

ChemUnity: Coming Together to Shape the Future of
Chemistry Education

» Maria Gallardo-Williams

Monday, 29 july

7am

Breakfast
Champions Kitchen, inside Gatton Student Center

Powered by Ex Ordo, everything you need to run a research conference.

8:30am

8:30am

8:36am

8:57am

9:18am

8:30am

8:30am

8:36am

8:57am

Workshop Demo and Prep
JSB-258

S86: Survival Skills 101: A Guide for Newer Teachers
CP-103
Chaired by: Amiee Modic

Introduction (S86)
» Amiee Modic

We are all Spiders!
» Roxie Allen

Take, Borrow, Share, and Make it Your Own
» Sherri Rukes

Stow and Go
» Amiee Modic

S88: Bridging the Gap Between Secondary and Higher Education
Chemistry

CP-111
Chaired by: Ryan Stowe

Introduction (S88)
» Elinor Soult

Teaching High School Chemistry in a "New Normal":
Strategies That Increase Engagement, Performance and
Equity

» Caroline Gochoco-Tsuyuki

Strengthening College Readiness: Collaborative Research and
Communication Between High School and College STEM
Educators

» Eric Davenport, Kimberley Frederick
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Continued from Monday, 29 July 8:30am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

More preparation for college chemistry is a good thing, right?
Not always.

» Binyomin Abrams

Building Community by Leveraging Opportunities for In-
Service and Pre-Service Teachers to Support Each Other

» Adam Schafer

$242: Integrating Green Chemistry and Sustainability into
Chemistry Education

CP-114
Chaired by: Loyd Bastin and David Laviska

Introduction (S242)
» Loyd Bastin

Why Should We Teach Our Students About Sustainability?
» |essica Parr

Systems thinking in chemistry and visualizing complexity for
future sustainability

» Micke Reynders, Thomas Holme, Bryce Platte

Systems thinking in chemistry: Importance of systems
dynamics

» Katherine Aubrecht

An inquiry based activity: The life cycle analysis of solar
panels with a combined lens of U.N. Sustainable
Development Goals and green chemistry

» Meghna Dilip, Margaret Kerr

$218: Building Bonds: Fostering a Sense of Belonging in Large-
Enrollment Chemistry Courses

CP-139
Chaired by: Theodore Alivio and Alicia Altemose
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8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

Introduction (5218)
» Elinor Soult

Expanding the Teaching Team: Undergraduate Learning
Assistants in General Chemistry

» Paula Weiss

A culture of Care in Chemistry Classrooms

» Jovita Ogechi Daraezinwa

Active Learning at Scale: Enhancing Academic Outcomes in
Introductory Chemistry

» Kimberly Arnold

Social interactions increase belonging in collaborative POGIL
classrooms

» Charity Lovitt, Tracey Murray, Matthew Horn, Olga Glebova,
Giselle Mak, Darian Castillo

S214: Active Learning Strategies in Chemistry with Large
Enrollment Lectures

CP-153
Chaired by: Rebecca Loy

Introduction (S214)
» Elinor Soult

The Effectiveness of Undergraduate Learning Assistants in
Large-Enroliment Courses Across Different Learning Spaces

» Anna Curtis, Carribeth Bliem, Danielle Zurcher

Use of Structured Learning Assistants in Large STEM courses

» Aleeta Powe, Lenore Hoyt, Danielle Franco, Jadwiga Kuta,
Geoffrey Bailey

Effectiveness of Adding Learning Assistants into General
Chemistry | at a Hispanic Serving Institution

» Cynthia Luxford, Case Lasater, Manishabal Kaur, Alice Olmstead,
Eleanor Close, Li Feng, Heather Galloway
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Continued from Monday, 29 July 8:57am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

Flipping After a Pandemic: A Case Study Over Two Years

» Stephen George-Williams, Sue Hemsley, Fran van den Berg,
Timothy Lee

S61: Engaging Students in Organic Chemistry
CP-155
Chaired by: Patricia Kreke and Animesh Aditya

Introduction (S61)
» Elinor Soult

A Sophomore Organic Chemistry Laboratory Course from the
Undergraduates to the High School Students in a Summer
Program

» Niharika Botcha

Strategies for Addressing Post-COVID Deficits in a Large
Enrollment Organic Chemistry Course

» Alicia Frantz

Calculating 1TH-NMR and 13C-NMR Chemical Shifts in Samples
Prepared by Students

» Christine Hermann

Enhancing Spectroscopy Learning in the Undergraduate
Classroom

» Christine Theodore

$32: Inclusive Practices for Unrepresented Groups in STEM
CP-179
Chaired by: Nicole Lapeyrouse and Tamra Legron-Rodriguez

Introduction (S32)
» Nicole Lapeyrouse

Inclusive Pedagogy for Neurodivergent Chemistry Students
» Christin Monroe
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9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

Exploring Socializing Experiences of Students Representing
Historically Marginalized Groups in Chemistry Doctoral
Programs

» Adeesha |ayathilaka, Minjung Ryu

Empowering the Next Generation of Latinas in STEAM
» Liz Diaz

Panel Discussion and Q&A (S32)
» kKim woodrum

S36: Assessment Instruments: Design, Development, and
Evaluation

CP-201
Chaired by: Molly Atkinson and Jack Barbera

Introduction (S36)
» Elinor Soult

Evaluation of the Departmental Climate around Diversity,
Equity, and Inclusion (DCaDEI) Survey

» Lu Shi, Christiane Stachl, Maia Popova

Measuring Affect: Validity and Reliability of the AMS-C in
Postsecondary Inorganic Courses

» Justin Pratt, Anne Bentley, Shirley Lin, Jeffrey Raker, Barbara
Reisner, Sheila Smith, Joanne Stewart

Investigating How Chemistry Students’ Reported Challenges
Inform the Relationship between Mindset and Academic
Performance

» Betul Demirdogen, Scott Lewis

Measuring mindset more accurately with the Undergraduate
Lay Theories of Abilities (ULTrA) Survey

» Lisa Limeri, Nathan Carter, Franchesca Lyra, Joel Martin, Halle
Mastronardo, Jay Patel, Erin Dolan

Page 16


https://www.exordo.com/?utm_source=bcce2024&utm_medium=PDF&utm_campaign=PDF

Biennial Conference on Chemical Education 2024 28 Jul - 01 Aug 2024 All times in EDT

Continued from Monday, 29 July 8:57am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

S156: Educational Research in the Science Classroom
CP-208
Chaired by: Melody Jewell

Introduction (S156)
» April French

Integrating Quantitative Data Collection and Analysis into
Chemistry Demonstrations

» Tom Kuntzleman

Incorporating Action Research into the M.S. Chemistry -
Chemistry Education Program at South Dakota State
University

» Melody Jewell, Matt Miller

Teachers as Researchers: Implementing Action Research in
the Chemistry Classroom

» Ryan Johnson

Engaging College Chemistry Faculty in Collaborative Action
Research for Professional Development

» Abdul Rauf, Donald Wink, Minjung Ryu

S177: Assessment and Measurement in Research and Practice
CP-211
Chaired by: Kristen Murphy

Introduction (S177)
» Elinor Soult

The many flavors and opportunities for modeling national
norms

» David Schreurs, Jaclyn Trate, Sachin Nedungadi, Olga Michels,
Chrystal Bruce, Melissa Reeves, Patricia Kreke, Keith Marek,
Thomas Pentecost, Jeffrey Raker, Kristen Murphy
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9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

Advancing Equity in Chemical Education Research: An
Inclusive Approach to Structural Equation Modeling Path
Analysis with Multigroup Moderation

» Ronia Kattoum, Mark Baillie

North vs. South: An Instructor’s View on the Assessment of
Student Performance in Multiple Choice Questions in Organic
Chemistry Laboratory Final Exam

» Robert Torregrosa

Quantitative Assessment of Self Reported Student Learning
Gains in a Biochemistry Lab CURE

» Arthur Sikora, Monica Aguiar, Santanu De, Ambika Kapil, Omar
Saleh, Radleigh Santos, Raghavi Vuppala

$260: From Theory to Practice: Showcasing How CER
Researchers Apply Theories and Methods for Inquiry

CP-220
Chaired by: Jon-Marc Rodriguez

Introduction (5260)
» April French

Investigating Undergraduate Student Perceptions Related to
Academic Integrity: Theoretical and Methodological
Considerations

» Jon-Marc Rodriguez

Mapping instructor epistemologies as they prompt for and
evaluate knowledge products

» Nicole Greco, Kimberly DeGlopper, Cara Schwarz, Rosemary
Russ, Ryan Stowe

Social science research paradigms and their impact on data
interpretation within chemistry education research

» Stephanie Feola, Lundon Pinneo, Ronia Kattoum, Michael
Moore, Mark Baillie

Feminist Methods for Chemistry Education Research
» Elizabeth Day, Karen Santillan, Jeffrey Olimpo
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Continued from Monday, 29 July 8:57am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

$25: General Chemistry Lab: Curriculum and Best Practices
CP-222
Chaired by: Jenine Maeyer

Introduction (S25)
» Elinor Soult

Characterizing Student Engagement in Planning
Investigations in a Thermochemistry-Based Project in the
General Chemistry Lab

» Oscar Judd, Lyn Haugh, Ruhi Rahman

Open-Inquiry Project-Based General Chemistry Lab: We Did It,
You Can Too

» Sara Almansberger, William Kennerly, Cindy Sood

Incorporating Inquiry and Instrumental Analysis in General
Chemistry Laboratory

» Kyle Knust

Moving Away From Experiment of the Week: Creating a More
Cohesive General Chemistry Lab Experience

» Graeme Wyllie

S34: Activation Barriers to Well-being: Challenges and
Approaches to Promoting Well-being for Students, Faculty, and
Staff

CP-287
Chaired by: Margaret Meadows

Introduction (S34)
» Kathryn Kloepper

Promoting Well-being and Learning in the Classroom
» Holly Currie
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9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

Potential Effects of Undergraduate Research Participation on
Student Well-being

» Evelyn Boyd, Kelly Lazar

Achieving Outcomes While Focusing on Student Self-Care in
the Analytical Classroom

» Gretchen Potts

Ten Minutes a Semester: Updates on a Wellness Intervention
» Kathryn Kloepper, Margaret Meadows

$199: Best Practices in Academic Advising and Mentoring
CP-297
Chaired by: Amanda Carroll

Introduction (5199)
» Elinor Soult

Chemistry Advising at Tennessee Tech University-
Experiences and Advice With a Student Centered Focus

» Amanda Carroll

Communicating Information to Students via Advising
» Amy Gottfried

The Development of an Al Academic Advising Assistant to
Support Underserved, First Time in College, and Transfer
Students in a Chemistry and Physics Department.

» Christopher Randles, Zhongzhou Chen, Maria Langworthy, Mary
Nelson, Jana lbrahim

Empowering Underrepresented Students in Science
Education Through Personalized Coaching

» Stephanie Santos-Diaz

$255: Biochemistry Education: Discussions of the Lecture
Learning Environment

JSB-103
Chaired by: Carly Schnoebelen
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Continued from Monday, 29 July 9:18am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

Introduction (S255)
» Elinor Soult

Using Augmented Reality in Molecular Case Studies to
Enhance Biomolecular Structure-Function Explorations in
Lecture Courses

» Didem Vardar Ulu, Saif Ragab, Swati Agrawal, Shuchismita Dutta

From Competence to Practice: Engaging with Relational
Ontology for a Post-Human Framework to Investigate
Biochemistry Students Learning With External
Representations

» Song Wang, Stanley Lo, Thomas Bussey

Exploring Biochemistry Students' Mechanistic Reasoning in
Metabolism

» Sara Johnson, Sharifa Love-Rutledge, Keenan Noyes

Panel Discussion (S255)
» kim woodrum

S$241: ChemEd X Presents Demonstrations to Engage Your
Students and Augment Student Learning

JSB-121
Chaired by: Deanna Cullen

Introduction (S241)
» Deanna Cullen

Dollar Store Demonstrations
» Karen Sorensen

Am | Breaking Bonds?
» Scott Milam
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9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

Pedagogy for Engaging Demonstrations for the High School
Classroom

» Chad Husting

Simple and Effective Demonstrations for 11/AP Chemistry
Using Simple Chemicals and Equipment

» Michael |ansen

$237: Learning Chemistry Beyond the Traditional Classroom
JSB-203
Chaired by: Marco Zimmer-De luliis

Introduction (S237)
» Marco Zimmer-De luliis

Bringing Significant Scientific Discoveries to Life: Executing a
Travel Class that Connects the History of Science and
Chemistry with Cultural Events

» Sharon Hamilton, Sara Hubbard

Exploring the Value of Video Beyond Lecture Recordings
» Silas Towne

Chemistry Concepts on YouTube: How Well Do Educational
Videos Support Conceptual Learning of Intermolecular
Forces?

» Sophia Gudinas, Leah Zajac, Ryan Sweeder, Deborah Herrington

Connecting Classroom Concepts to Daily Life Using the
Podcast Chemistry For Your Life

» Melissa A. Collini

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (5267)
» Elinor Soult
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8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:30am

Characterizing Resources Students Use to Understand

Chemical Equilibrium Phenomenon 8:30am
» Veeda Scammahorn, Melanie Cooper
The Challenge of Knowledge Integration in Chemistry
» Onyinye lkenyirimba, Vicente Talanquer
Cognitive Resource Activation by Chemistry Graduate
Students and Faculty when Discussing Entropy 8:30am
» Jennifer England, Rebecca Weber, Molly Atkinson
Investigating Students’ Mechanistic Reasoning of Solubility
Equilibria Concepts from General Chemistry through
Graduate Chemistry
» Uche Osuji, Suazette Mooring
Centering High School Chemistry Class on Making Sense of
Phenomena 8:30
JSB-218 :30am
Chaired by: Brie Bradshaw
Centering High School Chemistry Class on Making Sense of
Phenomena
» Brie Bradshaw, Adam Schafer, Lindsay Wells, Emily Adams, Ryan
Stowe
Inclusive first day and syllabus tips
8:30am

JSB-108
Chaired by: Sarah Kennedy

Inclusive first day and syllabus tips
» Sarah Kennedy, Merrie Winfrey, Kristina Stefaniak

The POGIL Project Workshop: Fundamentals of POGIL
JSB-114
Chaired by: Laura Parmentier

Powered by Ex Ordo, everything you need to run a research conference.

The POGIL Project Workshop: Fundamentals of POGIL
» Laura Parmentier, Joan Rogue

From pedagogical research to classroom implementation
JSB-231
Chaired by: Jack Huang

From pedagogical research to classroom implementation

» Jack Huang

Transforming Chemistry Education: The Power of
Personification, Storytelling, and Inclusivity

JSB-243
Chaired by: Rajasree Swaminathan

Transforming Chemistry Education: The Power of
Personification, Storytelling, and Inclusivity

» Rajasree Swaminathan

Reimagining Introductory Chemistry Laboratory Curriculum:
Skills-Based, Competency-Focused Lab Curriculum

JSB-337
Chaired by: Sean Mo

Reimagining Introductory Chemistry Laboratory Curriculum:
Skills-Based, Competency-Focused Lab Curriculum

» Sean Mo, Simba Nkomo

Fueling Education Transformation: The Dynamic Chemistry of
Community-Based Learning

JSB-347
Chaired by: Carmen Velez, PhD

Fueling Education Transformation: The Dynamic Chemistry of
Community-Based Learning
» Carmen Velez, PhD, Yi |in Kim Gorske, PhD, Emily Lesher, PhD,

Wendy E. Schatzberg, PhD, Melanie DiLorenzo, Ria |. Betush, PhD,
Kamila Deavers, Ph.D
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8:30am

10am

10:15am

10:15am

10:36am

10:57am

11:18am

10:15am

10:15am

10:217am

Computational Chemistry in Your Learning Space
JSB-357
Chaired by: Jason Sonnenberg

Computational Chemistry in Your Learning Space
» Jason Sonnenberg, Angela Migues

Break

S86: Survival Skills 101: A Guide for Newer Teachers
CP-103
Chaired by: Amiee Modic

Introduction (S86)
» Amiee Modic

Pedagogy for College Chemistry: Training Future Faculty
» Betsy Ratcliff, Michelle Richards-Babb

Nurturing Inquiry: Simple Phenomena for New Chemistry
Teachers

» Eric Davenport

Panel discussion (S86)
» Amiee Modic

$263: The Evolution of ALEKS Organic Chemistry
CP-111
Chaired by: Elizabeth Walters

Introduction (S263)
» Elizabeth Walters

Employing ALEKS to Maximize Student Potential in Organic
Chemistry

» Elizabeth Walters
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10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

The DNA of an ALEKS Organic Learning Objective
» Brandon Dietrich

New Challenges for ALEKS in Organic Chemistry
» Christopher Grayce

Adaptive Homework Platforms in Large Classroom Settings
» Andrea Baldwin

S242: Integrating Green Chemistry and Sustainability into
Chemistry Education

CP-114
Chaired by: Loyd Bastin and Jonathon Moir

Introduction (5242)
» Loyd Bastin

Green chemistry and the U.N. Sustainable Development
Goals: Harnessing their combined power

» Meghna Dilip, Margaret Kerr

An educational framework for teaching chemistry using a
systems thinking approach

» Vicente Talanquer, Alisha Szozda

Sustainable polymers in the classroom and laboratory:
Teaching a systems thinking approach towards responsible
chemistry innovations

» Jane Wissinger

Q&A Session (5242)
» Kim woodrum

$218: Building Bonds: Fostering a Sense of Belonging in Large-

Enrollment Chemistry Courses
CP-139
Chaired by: Theodore Alivio and Alicia Altemose

Page 21


https://www.exordo.com/?utm_source=bcce2024&utm_medium=PDF&utm_campaign=PDF

Biennial Conference on Chemical Education 2024 28 Jul - 01 Aug 2024 All times in EDT
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10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

Introduction (S218)
» Elinor Soult

CAMP: Chemistry Applications Media Projects - An Online
Chemistry Learning Community

» Josh Edwards, Zachary Martinez, Alicia Altemose

The role of undergraduate laboratory assistants in bridging
the divide between instructors and students in General
Chemistry courses.

» Lea Gustin, Stephen Block

Synergistic Transformations: Interplay of Research Initiatives
in Chemical Education and Pedagogical Practice

» Resa Kelly, John Kim

The Summer Enrichment Chemistry Workshop: Empowering
Students for Success

» Rita Hatfield, Mustafa Demirbuga, Donald Wink

S214: Active Learning Strategies in Chemistry with Large
Enroliment Lectures

CP-153
Chaired by: Rebecca Loy

Introduction (S214)
» Elinor Soult

Semi-Flipped Technique to Engage General Chemistry
Students

» Mohammad Rabbani

Distributed Active Learning (DAL): An Approach to Reduce
Class Size in Large Enrollment Courses

» Ted Clark, Rebecca Ricciardo, Daniel Turner
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11:03am

11:24am

10:15am

10:15am

10:21am

10:42am

11:03am

11:24am

10:15am

10:15am

Making Large-Enroliment Classes Seem Smaller - A Menu of
Effective Techniques

» Aleeta Powe, Lenore Hoyt, Sarah Zurkhulen, Haley McCoy

Pedagogical Reform in Introductory Chemistry: Impacts on
Student Attitudes and Learning

» Nicole James, Kodinna Anachebe

S61: Engaging Students in Organic Chemistry
CP-155
Chaired by: Patricia Kreke and Animesh Aditya

Introduction (S61)
» Elinor Soult

Finding the Time for Active Learning in Organic Chemistry
and Why It's Worth It

» Brian Woods

Helping Students Bridge Between General Chemistry and
Organic Chemistry: Introducing Mindful Doodling into
Organic Chemistry | Courses at Georgia Gwinnett College

» Michael Morton

Effectiveness of Active Learning Techniques Coupled with
Student Self-Reflection in an Organic Chemistry Classroom at
a 4-Year Public College

» Ajay Mallia
Bridging the Gap Between Organic Chemistry and

Biochemistry at a Regional Campus
» Ryan Yoder, Renee Bouley

S32: Inclusive Practices for Unrepresented Groups in STEM
CP-179
Chaired by: Nicole Lapeyrouse and Tamra Legron-Rodriguez

Introduction (S32)
» Nicole Lapeyrouse
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10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

Recruiting, Retaining, and Preparing Underrepresented STEM
Students

» Mark Jensen

DEl in Practice at DePaul
» Timothy French

ICABL Workshops: A Community of Practice for Diversifying
Leadership and Representation in Biochemistry and
Molecular Biology Education

» Kimberly Lane, Jennifer Bobenko, Kimberly Cortes, Victoria Del
Gaizo Moore, Daniel Dries, Peter Kennelly, Jennifer Loertscher,
Ludmila Tyler

Panel Discussion and Q&A (532)
» kim woodrum, Nicole Lapeyrouse

$82: Small Teaching - Making Modest but Powerful Changes to
Improve Student Learning

CP-183
Chaired by: Kevin Stewart

Introduction (S82)
» Kevin Stewart

Spaced Retrieval Practice in Introductory Chemistry Courses:
Designing Learning Objectives and Questions

» Lenore Hoyt, Campbell Bego, Patricia Ralston, Jason Immekus,
Keith Lyle

Student Study Plan Reflection Assignment: A Small
Intervention to Improve Student Learning

» Stephanie Brouet, Jennifer Chaytor, M. Patricia Cavanaugh

Establishing a Growth-Mindset Framework in the Chemistry
Classroom

» Kevin Stewart
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11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:21am

Making Stoich Stick
» Laura Prescott

S36: Assessment Instruments: Design, Development, and
Evaluation

CP-201
Chaired by: Molly Atkinson

Introduction (S36)
» Elinor Soult

Development and Evaluation of a Measure of Student By-in in
Undergraduate Chemistry Laboratory Courses

» Elizabeth Vaughan, Jack Barbera

Supporting chemistry students’ science practice self-efficacy
» Leah Zohner, Sachel Villafane-Garcia, Alena Moon

Development and validation of the Perceptions of Grading
Schemes instrument

» Brandon Yik, Haleigh Machost, Adriana Streifer, Michael Palmer,
Lisa Morkowchuk, Marilyne Stains

Assessing Answer-Until-Correct Item Validity

» Kristen Murphy, David Schreurs, Jaclyn Trate, Shalini Srinivasan,
Melonie Teichert, Cynthia Luxford, Jamie Schneider

S156: Educational Research in the Science Classroom
CP-208
Chaired by: Melody Jewell

Introduction (S156)
» April French

Measurement of Time to Interpret and Draw Four Different
Representations of Organic Molecules
» Daniel Silverio, Julianna Decker, Emily Diproperzio, Scott

Buzzolani, Matthew Mistretta, Aleksandra Bugajczyk, Samantha
Elezi
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10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

Student Generated Connections to Chemistry Content in
Introductory Chemistry

» Michael Hands Hands

Making “Electrons in Atoms” a Relevant and Engaging
Curriculum Unit that Incorporates the Everyday Life of Non-
College Bound Students

» Brenna Mcllvoy, Susan Wiediger

Beyond the Spectacle of the Hydrogen Balloon
Demonstration, Increasing the Impact of Demonstrations on
Learning

» Daniel Willems

$132: The Theory and Practice of Analytical Chemistry In the
Classroom

CP-211
Chaired by: Matt Queen

Introduction (S132)
» Matt Queen

Investigation of Student Understanding and Attitudes
Towards an Analytical Chemistry Laboratory Case Study on
the East Palestine Train Derailment

» Nicole Karn

Reframing the instrumental chemistry curriculum:
Imbedding a comprehensive conceptual framework within
professional skill-building, guided-inquiry activities

» Juliette Lantz, Caryl Fish

Formulating Learning Goals, Tasks, and Assessment
Strategies to Integrate Professional Skills into Classroom
Activities

» Caryl Fish, Juliette Lantz
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10:15am

10:217am

10:42am

11:03am

10:15am

10:15am

10:21am

10:42am

11:03am

$260: From Theory to Practice: Showcasing How CER
Researchers Apply Theories and Methods for Inquiry

CP-220
Chaired by: Jon-Marc Rodriguez

Introduction (5260)
» April French

A Semiotic Approach to Studying Students’ Representational
use During Collaborative Impasses

» |oel Beier, Martina Rau, Sam Pazicni

Conceptual Analysis: Modeling Student Understandings of
Electron Configurations

» Morgan Vincent, Neil Hatfield

Leveraging the Pedagogical Content Knowledge model to
understand how instructors’ prior knowledge and students'
difficulties affect symmetry instruction

» Lu Shi, Shanna Hilborn, Zoe Edmonson, Sam Pazicni, Maia
Popova

S25: General Chemistry Lab: Curriculum and Best Practices
CP-222
Chaired by: Jenine Maeyer

Introduction (S25)
» Elinor Soult

Reimagining the Chemistry On-Ramp: Accessible, Affordable
Scaffolding in the General Chemistry Laboratory

» Karen Downey, Sarah Wolf, Andrew Roering, Jeff Werner

Linking Core Concepts and Competencies: Towards an
Integrated Framework for General Chemistry

» Vijay Vyas, Scott Reid

When Curricular Emphases Change
» Stephen Block, Lea Gustin
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10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

S34: Activation Barriers to Well-being: Challenges and

Approaches to Promoting Well-being for Students, Faculty, and

Staff
CP-287
Chaired by: Kathryn Kloepper

Introduction (S34)
» Kathryn Kloepper

Advisor-Advisee Relationships in Chemistry Doctoral
Programs: Conflict Resolution and Mental Health

» Tingting Qu, Jordan Harshman

Overcoming Adversity in the Classroom: Using a Mixed-
Reality Training Simulator to Instill Resilience Among
Graduate Teaching Assistants

» J]abdiel Laboy Santana, AJ Sona, Chelsea LeNoble, Erin Saitta

Tools, Tips, and Resources: A Time Management Workshop
for First-Year Graduate Teaching Assistants

» Daria Sokic-Lazic, Sebastian Arteaga

Morning Panel Discussion (534)
» Kathryn Kloepper

$255: Biochemistry Education: Discussions of the Lecture
Learning Environment

JSB-103
Chaired by: Carly Schnoebelen

Introduction (S255)
» Elinor Soult

Utilization of a Problem-Based Learning Activity in a
Nonmajors Biochemistry Course

» Daniel Landfried
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10:42am

11:03am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

Effective Pedagogies in Biochemistry Lecture at a Regional-
Public University

» Ashley M. Loe

Assessing Depth of Knowledge and Understanding of Protein
Structure from Individual Student-created Activities in a
First-Semester Biochemistry Course

» Stephen Testa

S$241: ChemEd X Presents Demonstrations to Engage Your
Students and Augment Student Learning

JSB-121
Chaired by: Deanna Cullen

Introduction (5241)
» Deanna Cullen

The Material History of Soap: Thirty Demonstrations
Exploring the Beauty, Utility, and Versatility of Soap

» Julian Silverman

Chemical Demonstrations with Household Items
» Tom Kuntzleman

Q&A Session (5241)
» kim woodrum

Conductivity Demos: Teaching Chemistry with "Current
Events”

» Michael Farabaugh

S$237: Learning Chemistry Beyond the Traditional Classroom
JSB-203
Chaired by: Marco Zimmer-De luliis

Introduction (5237)
» Marco Zimmer-De luliis
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Continued from Monday, 29 July 11:24am Proficiency in Structure Decoding: Exploring the impact of
structural features on students’ consideration of resonance

] . » Irina Braun, Nicole Graulich
10:21am How to Navigate the Content vs. Context Balance in General -

Chemistr,
» Bradle zahlman 10:15am Integrating Artificial Intelligence in Chemistry Education:
Y h h ; -
Strategies for Enhancing Higher Ed Learning

B-1
10:42am Leveraging the Lab Experience: Inspiring Students in First- b5 .08 )
Year Chemistry Chaired by: Corey Beck

» Marco Zimmer-De luliis, Kris Kim, Svetlana Mikhaylichenko

Integrating Artificial Intelligence in Chemistry Education:
Strategies for Enhancing Higher Ed Learning

11:03am Investigating the Impact of Aquatic Chemistry Focused
Activities on Undergraduate Students' Interest and » Corey Beck
Understanding of Aquatic Chemistry
» Heike Gomez, Sonia Miller Underwood 10:15am  Digital Learning Strategies for K-12 Chemistry Classrooms
JSB-243
11:24am Q&A Session (S237) Chaired by: Dorothy Holley

» kim woodrum
Digital Learning Strategies for K-12 Chemistry Classrooms

10:15am  $267: Chemistry Education Research: Graduate Student » Dorothy Holley
Research Symposium
SRR . . 11:45am  Lunch
Chaired by: Michelle Herridge
. 2pm $242: Integrating Green Chemistry and Sustainability into
10:15am Introduction (S267) Chemistry Education
» Elinor Soult CP-114

Chaired by: Loyd Bastin and Amelia Anderson-Wile
10:21am A Perceptual Learning-Based Intervention Study of Molecular
Polarity and the Role of Molecular Representations

Introduction (5242
» Cheryl Lavoie, Christopher Bauer 2pm ( )

» Loyd Bastin

10:42am Characterizing Undergraduate Students’ Cognitive Resource

Activation when Solving VSEPR Theory Problems 2:06pm Green chemistry modules: Creation and implementation
» Olajumoke Ayeni, Molly Atkinson using Faculty Mentoring Networks (FMNs) as an innovative
Sl Al approach
) L » David Laviska, Sarah Prescott
11:03am How Ordering Concrete and Abstract Representations in
Intermolecular Force Chemistry Tasks Influences Students’
Thought Processes on the Location of Dipole-Dipole 2:27pm Isolation of microplastics and student perceptions of their
Interactions environmental footprint
» |saiah Nelsen, Ayesha Farheen, Scott Lewis » Kelly Hall, Amelia Anderson-Wile
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2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

2pm

2pm

Creating a culture of sustainability and green chemistry at
Widener University

» Loyd Bastin

Fostering a culture of sustainability; Is teaching the
principles of green chemistry sufficient?

» David Laviska

$133: Active and Inquiry Learning in the Chemistry Teaching
Laboratory

CP-139
Chaired by: Alex Grushow and Melissa Reeves

Introduction (S133)
» Alex Grushow

Guided-inquiry capstone experiments in genchem labs to
promote critical thinking

» John Farrar

Developing scientific writing abilities across the laboratory
curriculum through guided and active learning cycles

» Emma Johnson, Eugene Wagner, Michelle Morgan, Grace
Murray

What to do with only a single semester of physical chemistry
lab?

» Alex Grushow

S214: Active Learning Strategies in Chemistry with Large
Enroliment Lectures

CP-153
Chaired by: Rebecca Loy

Introduction (S214)
» Elinor Soult
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2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

“Is Didactic Lecturing Dead?": Crafting a Dynamic Learning
Experience Through Playposit in a Large Enrolilment Extended
General Chemistry

» Christine Altinis-Kiraz

Coupling iClicker And Peer-To-Peer Learning to Maintain a
High Engagement of the Students in Large Enroliment STEM
Classes

» Jelena Samonina

Beyond Active Learning: Using 3-Dimensional Learning to
Create Scientifically Authentic, Student-Centered Classrooms

» Melanie Cooper

Leveraging Practice Exams for Test-Enhanced Learning: A
Multifaceted Approach

» Matt Stoltzfus

S61: Engaging Students in Organic Chemistry
CP-155
Chaired by: Patricia Kreke

Introduction (S61)
» Elinor Soult

Carbohydrate Sweetener Identification (CSI): An
Undergraduate Laboratory Experiment to Identify
Carbohydrates and Non-Nutritive Sweeteners

» Ann E. Shinnar

Teaching Medicinal Chemistry as Context for Concepts in
Physical Organic Chemistry

» Sarah Dimick Gray

Pushing Arrows in Enzyme Active Sites: Anchoring a
Medicinal Chemistry Elective with Fundamentals of Organic
Chemistry

» Animesh Aditya
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3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

Development of the “Active Atom” Technique to Increase
Student Proficiency in Proposing and Interpreting
Mechanisms in Organic Chemistry

» Daniel Silverio

$217: Cultivating Inclusivity and Equity in the Classroom
CP-179
Chaired by: Alexandra Ormond

Introduction (S217)
» April French

Generating Chemistry : Community Building, Metacognition,
and the First Day of Class

» Allison Kelly

Redesign of General Chemistry - Who Is It Really Helping?
» Estelle Lebeau

Impact of Learning Assistants on Students’ Sense of Inclusion
and Identity Within the STEM Classroom

» Elijah Roth, Karstin DuPont, Kaitlyn Fitzgerald, Bradley McCoy

Using Student Faculty Partnership Program (SFPP) To
Enhance Inclusivity in Active Learning Classrooms.

» Sari Paikoff

$82: Small Teaching - Making Modest but Powerful Changes to
Improve Student Learning

CP-183
Chaired by: Kevin Stewart

Introduction (S82)
» Kevin Stewart

Chemistry: The Coupling Science
» Laura Van Dorn, Andrei Sanov
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2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

The Impact of Small Teaching Innovations on Student
Participation and Engagement in an Upper-Level Chemistry
Course at a Large Public Research University over Multiple
Semesters

» Chris Freeman

The Price of Precision: Significant Figures and the Student
Experience

» Ryan Britt, Melissa Weinrich

Lab Report Revisions in Undergraduate Organic Laboratory
» Justine Olson

S36: Assessment Instruments: Design, Development, and
Evaluation

CP-201
Chaired by: Molly Atkinson

Introduction (S36)
» Elinor Soult

Two instruments for assessing student green chemistry
knowledge: the Green Chemistry Generic Comparison (GC)2
prompt and the Assessment of Student Knowledge for Green
Chemistry Principles (ASK-GCP)

» Krystal Grieger, Annie Schiro, Alexey Leontyev

Adaptation and Validation of a Concept Inventory for
Undergraduate Organic Chemistry

» Christopher Nix, Esther Francom, Keven Luciano, Paul Lawrence,
Dmitry Kolpashchikov, Erin Saitta

Different Types of Validity Evidence Gathered During the
Development of a Resonance Concept Inventory

» Grace Tetschner, Sachin Nedungadi

Using the organic chemistry representational competence
assessment (ORCA) to understand student competence with
representations of molecular structure

» Lyniesha Ward, Fridah Rotich-Too, Jeffrey Raker, Regis
Komperda, Maia Popova
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2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

$175: Reflections from Pandemic Teaching and Beyond: Caring
for our Students While Learning to Care for Ourselves and Each
Other

CP-208
Chaired by: Clarissa Sorensen-Unruh

Introduction (S175)
» Clarissa Sorensen-Unruh

COVID and the Nature of Science: Bringing in Real-Life
Experiences to the General Chemistry Curriculum

» Geri Kerstiens

COVID Impact on Freshman Student Preparedness for
General Chemistry

» Kathleen Morrissey, Alex Ma

Student Engagement in Makeshift HyFlex General Chemistry
Courses

» Jayashree (Jay) Ranga

Care in the Classroom as a Tool of Transformation
» Sushilla Knottenbelt, Clarissa Sorensen-Unruh

$132: The Theory and Practice of Analytical Chemistry In the
Classroom

CP-211
Chaired by: Matt Queen

Introduction (S132)
» Matt Queen

Does it Sink or Float? - Investigating Density, Hydrophilicity,
and log P

» David Fraley
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2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

Using Al to personalize learning and support student skill
development in Analytical Chemistry

» Kimberley Frederick

Pick your Own Adventure: Orthogonal Methods for Analyzing
Polyphenols

» Amanda Buchberger, Madeline Lund, Pamela Doolittle, Dominic
Colosi, Kristel Forlano, Kyoung-Shin Choi, Robert Hamers

Instructional Strategies for a Stand-Alone Instrumental
Analysis Course

» Kristina Proctor

$260: From Theory to Practice: Showcasing How CER
Researchers Apply Theories and Methods for Inquiry

CP-220
Chaired by: Jon-Marc Rodriguez

Introduction (5260)
» Jon-Marc Rodriguez

Knowledge in pieces theory and card sorting methodology
provide complimentary information about students’
knowledge of molecular symmetry

» Robin Morgenstern, Sam Pazicni, Sarah Swineheart, Sarah
Fullington

How are students using bonding models in chemistry?: A
Knowledge-in-Pieces perspective exploring students’
cognitive and epistemic knowledge about bonding

» Sarah Fullington, Yujian Zhang, Nicole Becker, Sam Pazicni

Coordination class theory as a lens for understanding how
undergraduate chemistry students interpret and use
graphical representations as predictive tools

» Ayesha Farheen, Sarah J.R. Hansen, Nicole Becker

Modeling concept use through the coordination class theory:
Students’ (un-)productive consideration of resonance in
organic chemistry tasks

» Irina Braun, Nicole Graulich
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2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

$25: General Chemistry Lab: Curriculum and Best Practices
CP-222
Chaired by: Jenine Maeyer

Introduction (S25)
» Elinor Soult

Students Mentoring Students: Senior Undergraduate
Laboratory Instructors

» Brian Rempel, Elizabeth McGinitie, James Kariuki, David King,
Magrieta Snyman

Assessing Student Lab Skills Using At-Home Technique
Quizzes

» Faith Jacobsen

Improving the Grading Experience: An Analysis of the Factors
That Impact the Quality of Rubrics in Chemistry Laboratory
Courses

» Mandy Dark, Dane DeSutter

Curriculum Enhancement and Student Perception of a First-
Year Laboratory Course

» Daria Sokic-Lazic, John Throgmorton

S34: Activation Barriers to Well-being: Challenges and
Approaches to Promoting Well-being for Students, Faculty, and
Staff

CP-287
Chaired by: Kathryn Kloepper

Introduction (S34)
» Kathryn Kloepper
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2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

Departmental Climate Surveys: An Approach to Enhancing
Well-Being and Creating a More Inclusive Community

» Arielle Mensch, Michael Bertucci, Wendy Hill, Chip Nataro,
Rebecca Miller, Daniel Griffith

Emotions Associated with Challenging Teaching Situations:
An Analysis of an Often-Ignored Aspect of Instruction

» Emily Kable, Haleigh Machost, Marilyne Stains

Assessing and Addressing the High Fail Rates Across the
Faculty of Science

» Stephen George-Williams

Safe and Inspiring Learning Environments
» Samantha Glazier

$49: Cross-Course or Whole Curriculum Reform Efforts
CP-297
Chaired by: Douglas Mulford

Introduction (S49)
» Elinor Soult

Electrochemical Methods Across the Undergraduate
Chemistry Curriculum

» Ted Pappenfus

Integration of Career Exploration Into a Chemistry
Undergraduate Degree Program

» Clarice Kelleher, Benjamin Turnpenny, Alexsa Silva

An Assessment of STEM Education Research Institute’s
Contributions in Advancing Innovative Practices

» Patrick Wilson, Pratibha Varma-Nelson

Fostering Inclusive Teaching Culture: A Case Study of
Organizational Change in the Chemistry Department at the
University of lowa

» Casey Wright, Lindsay Jarratt, Renée Cole, Wayne Jacobson
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2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

$255: Biochemistry Education: Discussions of the Lecture
Learning Environment

JSB-103
Chaired by: Carly Schnoebelen and Keenan Noyes

Introduction (S255)
» Elinor Soult

Testing the Ability of Protein-Protein Docking Programs to
Model Known Complexes: A Project for the Biochemistry
Classroom

» Renee Bouley, Ryan Yoder, Lauren Frank, Blaise Koehler

Introducing Activities to Enhance Literature Reading Skills in
Biochemistry

» Mary Kopecki

Keeping it Real in Biochemistry
» Angie Spencer

Panel Discussion (S255)
» kim woodrum

S$241: ChemEd X Presents Demonstrations to Engage Your
Students and Augment Student Learning

JSB-121
Chaired by: Deanna Cullen

Introduction (S241)
» Deanna Cullen

Why We Standardize
» Amiee Modic

Using Chemical Demonstrations to Highlight Student
Understanding

» Ryan Johnson
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2:48pm

2pm

2pm

2:06pm

2:27pm

2:48pm

2pm

2pm

2:06pm

2:27pm

Q&A Session (5241)
» kKim woodrum

$206: “Message In A Bottle”: How Do We Reach Generation Z in
Class?

JSB-203
Chaired by: Jim Zubricky

Introduction (S206)
» [im Zubricky

Enhancing Engagement and Critical Thinking: Key Take-aways
and Best Practices for Using Pop Culture in Introductory
Chemistry Classes

» Michele Lansigan, Mac Crite

Game On! for General Chemistry: Engaging Students Through
Gamified Curriculum Design

» William Kennerly, Kimberley Frederick

Connecting General Chemistry With Issues that Matter to
Students

» Will Wiebe-Friesen

$159: Beyond Open Educational Resources (OER): User
Experience, Benefits, Challenges and Opportunities

/SB-213

Chaired by: K Joseph Ho and Jillian Stafford and Diana Habel-
Rodriguez

Introduction (S159)
» Elinor Soult

OER Adoption and Adaptation: Customizing Resources for
Diverse Learning Needs in Chemistry

» Mary-Kate Finnegan

Using Open Educational Resources in Two Different Lower-
Level Chemistry Courses

» |effrey Pribyl
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2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

An OER Journey from General Chemistry to Faculty
Development

» Emily Ragan

2pm
Panel Discussion (S159)
» kim woodrum

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321

Chaired by: Michelle Herridge

Introduction (5267) 2pm
» Elinor Soult

Metacognition and Organic Chemistry
» Nghiem Tieu, Oluwatobi Odeleye

An EpiC Quest - Finding epistemic messages in the organic
chemistry lecture
» Elias Heinrich, Nicole Graulich me

Beyond Arrows: Organic chemistry students' understanding
of electron pushing formalism as scientific modeling

» Abdul Rauf, Minjung Ryu

Characterizing Students’ Epistemic and Operational Atomic
Modeling Knowledge

» Salawat Lateef, Morgan Balabanoff

Empowering Tomorrow's Molecule Innovators: Design Thinking,
Sustainable Solar Cells, and Digital Molecule Making Workshop 2pm

JSB-218
Chaired by: James Planey
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Empowering Tomorrow's Molecule Innovators: Design
Thinking, Sustainable Solar Cells, and Digital Molecule
Making Workshop

» James Planey, Sabrina Abdulla, Nolan Green, Rachel Switzky

Beyond canceling: Developing authentic proportional reasoning
in chemistry

JSB-208
Chaired by: Mitchell Sweet

Beyond canceling: Developing authentic proportional
reasoning in chemistry

» Brenda Royce, Mitchell Sweet

A Day in the Life of an Academic: Case Studies in Support of
Your Diversity, Equity, Inclusion (DEI) and Belonging Work

JSB-108
Chaired by: Anne Baranger

A Day in the Life of an Academic: Case Studies in Support of
Your Diversity, Equity, Inclusion (DEI) and Belonging Work

» Anne Baranger, Stacey Brydges, Tracy McGill

A “Micro-Scale” Community of Practice for Promoting Student
Engagement in General Chemistry: Discuss, Dream, Develop,
and Practice

JSB-114
Chaired by: Jill Ellenbarger

A “Micro-Scale” Community of Practice for Promoting Student
Engagement in General Chemistry: Discuss, Dream, Develop,
and Practice

» Jill Ellenbarger, Tricia Hahn
The POGIL Project Workshop: Real-world Context and POGIL

JSB-231
Chaired by: Daniel King
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2pm

2pm

2pm

2pm

The POGIL Project Workshop: Real-world Context and POGIL
» Daniel King, Charity Lovitt

A Chemical Inquiry: Let's Master Equilibrium!
JSB-243
Chaired by: Greg Dodd

A Chemical Inquiry: Let’s Master Equilibrium!
» Greg Dodd

American Association of Chemistry Teachers (AACT) Resources
for AP Chemistry

JSB-244
Chaired by: Jeramy DeBry

American Association of Chemistry Teachers (AACT)
Resources for AP Chemistry

» Jeramy DeBry

Foundations for Chemistry Education Research & Publications
JSB-347
Chaired by: Michelle Herridge

Foundations for Chemistry Education Research &
Publications

» Michelle Herridge, Chloe Sells

Teaming up with undergraduate Learning Assistants (LAs) to
foster active and inclusive chemistry learning environments

JSB-357
Chaired by: Ira Caspari-Gnann

Teaming up with undergraduate Learning Assistants (LAs) to
foster active and inclusive chemistry learning environments

» [ra Caspari-Gnann, Brittney Morgan, Katy Hosbein
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3:30pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

Break

$229: ELIPSS and Beyond: Celebrating the work and impact of
2023 James Flack Norris Awardees Renée Cole, Juliette Lantz,
and Suzanne Ruder

CP-103
Chaired by: Rick Moog

Introduction (5229)
» Elinor Soult

Stories and Insights From Five Years of the ELIPSS Project
» Gil Reynders

MICRO CURE: A Course-Based Undergraduate Research
Project Designed to Develop and Assess Student Skills

» Kimberley Frederick, Maury Howard, Rebecca Hunter, Kelly
Neiles, Daniel Scott

Outside the ELIPSS: Using the Rubrics to Promote Career
Development

» Ashley Mahoney

Panel Discussion (5229)
» kKim woodrum

S66: Views from the Classrooms of Award Winning Chemistry
Teachers

CP-111
Chaired by: Deanna Cullen

Introduction (S66)
» Deanna Cullen

How to Stand Out While Also Fitting In as an Educator
» Kristen Drury

Improve Engagement with Chemistry-Themed Brain Breaks
» Melissa Hemling
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4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

Developing Process Skills with POGIL
» Laura Trout

Q&A Session (S66)
» kKim woodrum

S$242: Integrating Green Chemistry and Sustainability into
Chemistry Education

CP-114
Chaired by: Loyd Bastin and Kelly Hall

Introduction (S242)
» Loyd Bastin

Reimagining a Bachelor of Science in Green Chemistry for the
future

» Nicholas Kingsley

Building a green chemistry program

» Cynthia Woodbridge, Omar Villanueva, Joseph Sloop, Veronica
Sublett-Breeden, Kathryn Zimmerman

Exposing Students to Real Green Chemistry Projects: The
Green Chemistry Challenge Awards

» Stephanie Brouet

New Real-World Cases in Green Chemistry for the
undergraduate curriculum

» lennifer Tripp, Thomas Umile

$133: Active and Inquiry Learning in the Chemistry Teaching
Laboratory

CP-139
Chaired by: Alex Grushow and Melissa Reeves

Introduction (S133)
» Alex Grushow
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3:51pm

4:12pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

Developing and assessing the 'stretchy-pants' lab manual;
one-size can fit all!

» Robin Stoodley

Observing Intermolecular Forces in Surface-Liquid
Interactions: A Study of Causal Mechanistic Reasoning using
Functionalized Silanes in the Undergraduate Laboratory

» Robert Milligan, Donald Wink

S214: Active Learning Strategies in Chemistry with Large
Enrollment Lectures

CP-153
Chaired by: Rebecca Loy

Introduction (5214)
» Rebecca Loy

Gamification to Enhance Student Learning in Large
Enrollment Lectures

» Alexis Courtney

Student Construction of a Flow Chart to Achieve Better
Engagement in a Large Enrollment Organic Chemistry Course

» Rebecca Loy

Incorporating Peer Review as an Active Learning Tool in a
Large Enroliment Introductory Biochemistry Course

» Wen Yi Low, Didem Vardar Ulu

Q&A Session (S214)
» kim woodrum

S61: Engaging Students in Organic Chemistry
CP-155
Chaired by: Patricia Kreke and Animesh Aditya

Introduction (S61)
» Elinor Soult
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3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

Helping Pre-Health Students Prepare for the DAT and OAT:
Insights into the Design and Evolution of the Organic
Chemistry Subsection in the Survey of Natural Sciences

» Jay Wackerly, Shakena West, Michael Wentzel, Sarah Zingales

Assessing Organic Chemistry Student Perceptions of Learning
through Post Exam Survey of Metacognition and Study Habits

» Sari Paikoff, Rachel Campbell

llluminating Student Growth: Specifications Grading in
Organic Chemistry

» Michael Evans

Second implementation of Specifications-Based Grading for
Organic Chemistry Il at a PUI: Modifications from Lessons
Learned during the First Implementation

» Joel Karty

$217: Cultivating Inclusivity and Equity in the Classroom
CP-179
Chaired by: Alexandra Ormond

Introduction (S217)
» April French

A Latent Transition Analysis of How Student Attitudes
Towards Science Evolve Over a Semester in General
Chemistry

» Oluwatobi Odeleye, Oluwaseun Agunbiade, Adam Garber, Karen
Nylund-Gibson

Listening to Students To Transform the General Chemistry
Experience

» |ennifer Collins, Nicole Karn

Good Science Is Inclusive Science: Lessons From Analytical
Chemistry

» Ginevra Clark
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4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

3:45pm

3:45pm

3:51pm

Embedding a Course-Based Research Project into an Honors
Capstone Course: Our Challenges and Celebrations

» Amanda Glass, Kristy Wittman Howell

$82: Small Teaching - Making Modest but Powerful Changes to
Improve Student Learning

CP-183
Chaired by: Kevin Stewart

Introduction (S82)
» Kevin Stewart

Using Spaced Practice with Online Homework: Effect on
Performance in Chemistry

» Blain Mamiya, Hadi Arman, Sarah Oerther

Practicing Researchers’ Perceptions of Systems Thinking in
Research and Education

» MaryKay Orgill, Guizella Rocabado

Using Science Practices to Reframe Assessment and
Instruction

» Deborah Herrington, Ryan Sweeder

S$175: Reflections from Pandemic Teaching and Beyond: Caring
for our Students While Learning to Care for Ourselves and Each
Other

CP-208

Introduction (S175)
» Clarissa Sorensen-Unruh

Reframing the Chemistry Classroom through equitable care
practices and authentic, equity-centered assessment and
evaluation

» Clarissa Sorensen-Unruh
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3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

$132: The Theory and Practice of Analytical Chemistry In the
Classroom

CP-211
Chaired by: Matt Queen

Introduction (S132)
» Matt Queen

Building Student Career Competencies through Peer-Led
Instrumental Chemistry

» Keir Fogarty, Elizabeth McCorquodale

"Your Time Starts Now.": Taskmaster-esque in class activities
for Instrumental Lectures

» Alexander Jacobs

Calibrating Demands on Memory to Enhance Learning in
Analytical Chemistry

» David Thompson

Using Digitized Image Manipulation to Reinforce Excel Skills
of both Mathematical Function Creation and Graphing
Abilities in Analytical Chemistry

» Michael Morton, lan Krouse

$45: 3D Printing in Chemical Education: Engaging Students and
Creating Tools for Active Learning

CP-220
Chaired by: Lon Porter

Introduction (S45)
» Lon Porter

3D Printable Analytical Instrument Designs for Active
Learning: Inexpensive and User-Friendly Kits for Engaging
Students in the Chemistry Laboratory

» Lon Porter
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4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

Design and Construction of a 3D Printed Space-Filling
Molecular Model Set

» hannah martin, Brina Nguyen, Jeremy Klosterman

3D Printed Noble Metal Nanoparticle Shapes
» Anne Bentley, Sara Skrabalak

A Thin Layer Chromatography Prelaboratory Activity Using a
3D-Printed Model to Address Student Misconceptions about
Polarity and Intermolecular Forces

» William Howitz

S47: Beyond Confirmatory Experiences: Teaching in the
Chemistry Laboratory

CP-222
Chaired by: David Styers-Barnett

Introduction (S47)
» Elinor Soult

A Modified Argument-Driven Inquiry Laboratory Model as a
Curriculum Transformation Tool: The Case of the Buffers
Experiment

» Deborah Santos

Community Engagement in General Chemistry: Nutrient
Analysis for a Community Garden

» Yuemei Zhang, Kim Borges, Langdon Martin

Introducing the “Big Questions” of Experimental Science to
General Chemistry Lab Students

» Katie Gesmundo, Veronica Berns

The Role of Materiality in General Chemistry Laboratory
Teaching and Research

» Donald Wink, Robert Milligan, Jim Coombs, Mustafa Demirbuga

S$49: Cross-Course or Whole Curriculum Reform Efforts
CP-297
Chaired by: Douglas Mulford and Nichole Powell
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3:45pm Introduction (S49)
» Douglas Mulford

3:51pm Intentional Decreasing of the Chemistry Degree Plan

Complexity
» Stephanie Jones, Eric Eitrheim

4:12pm Creating a Three-Semester General and Organic Chemistry

Curriculum

» Leslie Knecht, Cesar Gonzalez, Marc Knecht, James Wilson

4:33pm Shifting the Undergraduate Chemistry Curriculum to

Enhance Student Success (SUCCESS)
» Deirdre Belle-Oudry

4:54pm Chemistry Unbound at Emory University: Implementation

and Assessment Results
» Douglas Mulford, Tracy McGill, Leah Williams

3:45pm  s255: Biochemistry Education: Discussions of the Lecture

Learning Environment
JSB-103
Chaired by: Carly Schnoebelen and Keenan Noyes

3:45pm Introduction (S255)
» Elinor Soult

3:51Tpm Making Relevant Connections of Metabolic Processes

Utilizing Systems Thinking
» Corina Brown, Richard Hyslop

4:12pm Teaching Carbohydrate Metabolism in Biochemistry Using

Contemporary Examples of Synthetic and Natural
Sweeteners

» Ann E. Shinnar
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4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

3:45pm

3:45pm

3:51pm

Strategies for Engagement in a Biochemistry Lecture
» Bhavani Balasubramanian

Panel Discussion (S255)
» kim woodrum

S206: “Message In A Bottle”: How Do We Reach Generation Z in
Class?

JSB-203
Chaired by: Jim Zubricky

Introduction (S206)
» [im Zubricky

Encouraging student questions: Methods for in-class and out-
of-class

» Kyle McElhoney

Students’ Challenge Perceptions Influencing Performance
and Persistence Within General Chemistry

» Dianna Kim, Scott Lewis

Improved Motivation Through Enhanced Engagement in a
Principles of Chemistry I class

» Patricia Todebush, Paula Nolibos

$159: Beyond Open Educational Resources (OER): User
Experience, Benefits, Challenges and Opportunities

/SB-213

Chaired by: K Joseph Ho and Jillian Stafford and Diana Habel-
Rodriguez

Introduction (S159)
» Elinor Soult

LibreTexts: Past, Present and Future
» Delmar Larsen
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4:12pm

4:33pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

The General Principles of ALEKS Product Design and How
They Have Evolved

» Christopher Grayce

Panel Discussion (S159)
» kim woodrum

§267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (S267)
» Elinor Soult

“Benzene is the archetype for aromaticity”: Students ideas
for defining aromatic, antiaromatic, and nonaromatic
compounds

» Rebecca Chan - Chao, Justin Pratt

Lessons in Symmetry: How inorganic chemistry instructors
select and use representations to teach molecular symmetry

» Shanna Hilborn, Lu Shi, Zoe Edmonson, Sam Pazicni, Maia
Popova

Students’ Use of Strategic Knowledge While Interrogating the
Symmetry of Molecules

» Robin Morgenstern, Sam Pazicni, Sarah Swineheart, Sarah
Fullington

Towards a Model of Cognition for UV/Vis Spectroscopy
» Haiyan Alfulaiti, Alena Moon

Copper: Two Inquiries to Begin and End the School Year
JSB-243
Chaired by: Greg Dodd
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3:45pm

6pm

Copper: Two Inquiries to Begin and End the School Year
» Greg Dodd

Facilitating Lesson Plan Development for Chemistry Outreach
Opportunities

JSB-244
Chaired by: Glenn Gilyot

Facilitating Lesson Plan Development for Chemistry
Outreach Opportunities

» Glenn Gilyot, John Himmelberg

Poster Session 1
Gatton Student Center, 2nd floor

Hybrid General, Organic and Biochemistry at PSU Altoona
» William Van Der Sluys

Beyond the Classroom: Fostering Holistic Wellness in STEM
Education at Saint Louis University

» Jacob Stefanko, Merideth Vieson, Asimra Alagic

Qualitative study on the effect of the STEM Wellness
Initiative on undergraduate student wellbeing

» Merideth Vieson, Jacob Stefanko, Asimra Alagic

“What if you were the Chemist?” Transformative Learning in
Analytical Chemistry: A Case Study Approach Encouraging
Critical Thinking and Soft Skill Development.

» Thushani Herath

An Analytical Chemistry lab cycle comparing methods for
quantifying iron in supplement tablets

» Kathryn Davis, Rachael Pickett

Inquisitive lab experiments as a tool for teaching logical
thought and scientific writing

» Evan Vanable
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Using Undergraduates to Screen Soil for Antibiotic-Producing
Species
» Daniel Marous, Celeste Hartings, Andy Dozal

From Research to an Undergraduate Lab Bench: Integrating
C-H Activation via Iridium Catalysis into a 4-Hour Inorganic
Course

»Joan Roque

Quantitative Analysis at Ashland University: Two Decades of
Project-Based Instruction

» Rebecca Corbin, Jeffrey Weidenhamer

Out with the old, in with the new: the impact of Argument
Driven Inquiry

» Morgan Polk, Deborah Santos

ADI Chemistry Labs' Effect On Perceived Science Practice,
Science Identity, and Nature of Science

» Riona Soosaidas, Deborah Santos

Incorporation of the Extraction and Analysis of Cannabidiol
from Hemp Flowers into Organic Chemistry Lab and
Undergraduate Research Curricula

» Treasure Sucheck, Faith Butler, Michael Young, Robert Sucheck

A Research-Based Capstone Project for Organic Chemistry
Lab

» Brian Woods

An inquiry-based activity for exploring carbocation stability
using articulating molecular models.

» Deepali Butani, Michelle Nelson, Joseph Rezents, Patricia
Hernandez
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Investigating English Learners Engagement and Challenges in
a Process Oriented Guided Inquiry Learning (POGIL) Based
General Chemistry Classroom.

» Sylvia Zakher, Gregory Rushton, Shaghayegh Fateh, Amy Phelps,
O. Theresa Ayangbola, Joshua Reid

A Case Study in Reimagining General Chemistry after a
College-wide Curricular Reform: Incorporating Active
Learning and Societal Impact into a Large Plenary Course

» Katherine Van Heuvelen

Performance-Based Learning Modules for Enhanced Student
Engagement and Success In General Chemistry at SHSU

» Adrian Villalta-Cerdas, Steven Hegwood, Donovan Haines

Chemistry Learning Assistant Program: A Peer Learning
Model Curated for Large Enroliment General and Organic
Chemistry Classes

» Suzanne Ellenberger, Eman Abdelrahman, Matthew Seivert

Teaching Toxicology Using The Poison Squad and The
Poisoner’s Handbook.

» James Goll, Brooke Christianson

Addressing the knowledge gap through professional
education initiatives for educators to promote the global
integration of sustainable chemistry into curricula

» Monica Nyansa, Natalie J. O’'Neil, Amy Cannon

Enhancing Native American Student Engagement in
Chemistry: A Systems Thinking Approach Integrating Their
Tribal Knowledge

» Chun-Hung Wang

Adjusting for Math Preparedness: Redesign of General
Chemistry | to Support Student Success

» Ariel E. Vaughn

Project MUSE: Museum Sabbatical Experience for Faculty
Teaching at the Arts-Science Interface

» Gregory Smith
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When Paul Gauguin arrived at the Studio of the South, did he
possess his painting supplies or use Van Gogh's?

» |eff Fieberg, Gregory Smith

Institutional Transformation for Inclusive Excellence
» Cheryl Bailey, Kathleen Boyle, Jeremy Edison

Peer stories of overcoming challenges in STEM at a Hispanic
Serving Institution

» Colleen Conway, Wendy Weaver, Jason Meyler

Creating digitally literate graduates through the curriculum
» Wendy Weaver, Jeremy Edison, Rita Quinones de Magalhaes

Streamlining Program and Course Assessment with the
Canvas LMS

» Heather Larson, Kagna Sampson, Victor Waingeh, Jan Fleischer

Evaluation of Teaching and Mentoring in Undergraduate
Research Experiences: The Development and Pilot Study of a
New BURET Survey Instrument

» Anthony Garcia, Casey Messersmith, Xing Chan, Ernesto
Sanchez, Helen Li, Laleh Cote, Elisa Stone, Anne Baranger

Observational Protocols for Peer-Led Team Learning (PLTL)
» Christopher Bauer, Lauren Edwards

Argument-Driven Inquiry in the Organic Chemistry
Laboratory: Experiments and Assessment

» Shannon Saluga, Renée Link

Affordable and Available: Exploring OERs in a Chemistry
Course for Engineering Majors

» Leah Williams, Beulah Narendrapurapu, Mykhayla Carroll, Sarah
Melvin
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Remixing and Creating an Interactive OER for an
Undergraduate Non-Majors Chemistry Course

» Erin Avram

Purification and Characterization of His-Tagged Fluorescent
Proteins in an Undergraduate Biochemistry Lab

» Samantha Wilner

The Better Way to Analyze Michaelis-Menten Data
» Katherine Bichler, Jeffrey Potratz

“CHEMISTRY FRIDAYS"” A Program to Foster Community
Among Undergraduates in the Chemistry Department

» Jlennifer Monahan, Paul J. Bracher, Melissa C. Hopfinger, Michael
J. Hankins, Asimra Alagic, Michelle A. Pillers, Natalie R. Schleper

Customizing GPTs for training students in molecular sciences
while minimizing hallucinations

» Scott Reed

Colorful Chemistry Magic: Solution Separation Using Science
» Sarah Shoemaker

Cost Effective modeling for visualization of symmetry
concepts in Inorganic Chemistry

» Meghan Knapp

Impact of Disciplinary Context on Graphical Reasoning
Abilities

» Ariel Adams, Sydney Black, Kathleen Bowe, Brock Couch, Melissa
Aikens, Christopher Bauer

Quantitative Exploration of Self-Efficacy and Anxiety Trends
Among Undergraduate Chemistry Students

» Cody Beck, Kristen Murphy, Preston Burdett

An Exploration of Students' Mindset Beliefs About
Visualization in Biochemistry

» Andrew McVay, Suazette Mooring
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7pm

Development of a week-long short course for incoming
synthetic graduate students.

» Deseree Dufek, Anne Baranger

Post-Lab Wrap-Up: Strengthening engagement through
metacognitive practice in organic chemistry lab courses

» Kaitlyn Pasquarella

Poster Session 2
Gatton Student Center, 2nd floor

Students’ Perception of the Benefits and Challenges of
Systems Thinking in Chemistry Education

» Navid Ahmed Sadman, Corina Brown

A Qualitative Investigation of the Ways in Which
Undergraduate and Graduate Chemistry Engage in Scientific
Practices Within an Authentic Research Context

» Brianna Martinez, Zahilyn Roche Allred, Sonia Miller Underwood

Using Eye-Tracking to Investigate Notetaking and Learning
Outcomes in Organic Chemistry Lectures

» Victoria Yu, Annemarie Wolff, Amanda Bongers

Data Source Triangulation for Deeper Insight Into the
Relationship Between Power and Mechanistic Reasoning in
Organic Chemistry

» Lee Price, Ira Caspari-Gnann

Synthesis and Characterization of Phosphonium lonic Liquids
» Brennan Schuler, Benjamin Wicker

Exploration of a Tandem Pauson-Khand Reaction for the
Synthesis of Polycyclic Aromatic Hydrocarbons

» Scott Van Ornum, Hunter Moore, Fraser Bain, Abigail Larsen
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Inquiry on Information Literacy in Florida Postsecondary
Chemistry Curricula

» Han Le, Kaitlyn Medina, Matilynn Lam, Christopher Randles

A tale of two surveys: Validation and utilization of two
instruments to understand and measure the anxiety and
motivation of general chemistry students

» Mira Beranek, Preston Burdett, Cody Beck, Allison Tomczyk,
Kristen Murphy

User Experiences with an Al Academic Advising Assistant to
Support Students in a Chemistry and Physics Department

» lana Ibrahim, Maria Langworthy, Mary Nelson, Zhongzhou Chen,
Christopher Randles

The Instruction of K-12 Students in Scientific Information
Literacy and its Ethical Concerns

» Autumn LeBleu, Matilynn Lam, Christopher Randles

Running an undergraduate research project when no one is
an expert: Bootstrapping a new analytical technique

» David Gardner, Sontee Irvin, Skye Kessler

Developing Science Practices Assessment Tasks in
Mathematical Thinking for General Chemistry

» Andrew Kivlighn, Norda Stephenson

Variations in Malt Protein Patterns During Fermentation with
Ale Brewing Yeast

» Destiny LaFlesh, Ajila Chandran Matheyambath

Distinguishing Cinnamon Species: A Hands-On HPLC Analysis
» Luke Chitwood, Laura Walther

Investigating Student Stress Increases when Exposed to
Biochemical Visual Representations by Using Galvanic Skin
Response and Working Memory Limitations

» Gavin Winslow, Christopher Randles, Marjan Roshandel, Evan
Rodman
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Understanding the presence of test anxiety in large
enrollment lower division chemistry classes: A survey study.

» Draven Ruiz, Christopher Randles, Marjan Roshandel

Exploring how Test Anxiety Manifests, Impacts and is
Perceived by Students Taking Introductory Chemistry Classes

» Noor Alaraj, Gavin Winslow, Draven Ruiz, Marjan Roshandel,
Christopher Randles

Changes in Malt Polyphenolics During Fermentation with Ale
Brewing Yeast

» Tatum Snyder, Ajila Chandran Matheyambath

Measurement of the Time it Takes to Draw and Interpret
Four Representations of Organic Molecules

» Julianna Decker, Emily Diproperzio, Daniel Silverio

Incorporation of computer aided drug design into the
biochemistry laboratory

» Mi-Sun Kim

An Interactive, Inorganic Chemistry Python Notebook for
Predicting IR and Raman Activity

» Olajumoke Ayeni, Ignacio Migliaro, Mohammad Omary, Molly
Atkinson

Time for TD-DFT: An Interactive Colab Tutorial

» Jacob Hirschi, Dayana Bashirova, Evan Lambertson, Tim
Zuehlsdorff

Open Source Tools to Facilitate Teaching of Skills Needed by
Chemists

» Jonathan Gutow

2025 Cheminformatics OLCC and the InChl OER

» Robert Belford, Sunghwan Kim, Ehren Bucholtz, Jordi Cuadros,
Andrew Cornell, Carla_Karen Fortune
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IUPAC FAIR Chemistry Cookbook: Recipes to make your
Chemical Data FAIRer

» Stuart James Chalk, Leah McEwen, Jordi Cuadros

Partnering a Perovskite Research Project with an
Undergraduate Analytical Chemistry Course

» Kristel Forlano, Eliana Bernat, Song Jin, Pamela Doolittle

Progress Towards Identification of Antimicrobial Compounds
in Liquidambar styraciflua

» Tracy Terry, Onawa Henson, Anja Dombrowski

Integrating Organic and General Chemistry within a Four-
Semester Chemistry Program

» Xavier Prat-Resina, Dihua (Victoria) Xue, Shannon Anderson,
Deepali Butani, Olivia Crandell, Tim Doherty, Rachel Doughty,
Michelle Nelson

The Mentor's Perspective: Exploring Inclusivity Within the
University of Utah's Learning Assistant Program for Biology,
Chemistry and Physics Introductory Courses

» Kim Weaver, Mark Jareczek, Hector Torres, Regina Frey

We Think, We Smell, We Remember: The Effect of Smell on
Memory for Chemistry Lab Learning

» Michael Marino, Francine Wisnewski, Andre Alexis, Catherine
Reilly

The Use of the Science Writing Heuristic to Allow for Students
to Gain Greater Conceptual Understanding of Density

» ]Jim Coombs, Donald Wink

Comparison of Lab Skill Development and Proficiency in
Remote and On-Campus Labs

» Josh Marell, Kelly Befus, William Boyle, Sharon Herbelin

Unveiling Students' Quantum Mechanics Understanding:
Insights from Knowledge-in-Pieces Methodology:

» Mustafa Demirbuga, Donald Wink
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Outcomes and Student Perceptions of Specifications Grading
in Organic Chemistry

» Joseph Houck, Christopher Haines

Investigating Students’ Perspectives Related to Alternative
Grading in STEM

» Tia Kledzik, Elizabeth Vaughan, Nicole James

Alternative Grading in STEM: A Systematic Literature Review
» Harnoor Nagra, Elizabeth Vaughan, Nicole James

Perceived Teacher Support by Students in High School STEM
Classrooms

» Tina Lewis

Faculty Perspectives on the Use of Learning Assistants (LAs)
in Undergraduate Introductory Science Classes.

» Monsour Zakariyah, Katy Hosbein

Utilizing Real-Word Connections to Enhance Student
Attitudes Toward Chemistry

» Rashmi Capece, Hannah Sturtevant

General chemistry students’ language fluency in the context
of a precipitation reaction

» James Nyachwaya, Krystal Grieger, Tarah Dahl

Engineering-First Chemistry: Tailored Chemistry Curriculum
for Engineering Students at the University of Kansas

» Shuai Sun

Changing Assessment Methods for a More Student-Friendly
General Chemistry

» Catherine McCusker, Ray Mohseni, Anita Paul

Beyond the Exam: Adding Varied Assessment in General
Chemistry for Non-Majors

» Amanda Patrick
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Investigating Potential Over-use of Technology in General
Chemistry Lecture - Including the Student Viewpoint

» Kristen Funck

Impacts of Pre-Service Teachers' Undergraduate Research
Experiences on K-12 STEM Education: A Descriptive
Assessment with Qualitative Instruments and Analysis

» Anthony Garcia, Casey Messersmith, Xing Chan, Ernesto
Sanchez, Helen Li, Laleh Cote, Elisa Stone, Anne Baranger

Tuesday, 30)uly

7am

8am

8:30am

8:30am

8:36am

8:57am

Breakfast
Champions Kitchen, inside Gatton Student Center

Workshop and Demo Prep
J5B-258

$229: ELIPSS and Beyond: Celebrating the work and impact of
2023 James Flack Norris Awardees Renée Cole, Juliette Lantz,
and Suzanne Ruder

CP-103
Chaired by: Rick Moog

Introduction (S229)
» April French

Federal Science and Technology Workforce Readiness
» Gail Webster

ELIPSS Rubrics Revolutionized Writing POGIL Activities
» Caryl Fish
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9:39am
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8:30am
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8:57am

9:18am

9:39am

8:30am

8:30am

Let's Talk About It! The Role of Collaborative Discourse and
Reflection on Students’ Reasoning Skills

» Gwendolyn Lawrie

Making Process Visible: Personal Stories of the Evolution and
Application of ELIPSS

» Christopher Bauer

S66: Views from the Classrooms of Award Winning Chemistry
Teachers

CP-111
Chaired by: Deanna Cullen

Introduction (S66)
» Deanna Cullen

Making Connections that Matter!
» Laura Slocum

Girls in STEM Club
» Alice Putti

Elements of a Thermodynamically Favorable Classroom:
Cultivating the Best of Yourself and Your Students

» Derrick Wood

Q&A Session (566)
» kim woodrum

$242: Integrating Green Chemistry and Sustainability into
Chemistry Education

CP-114
Chaired by: Loyd Bastin and Manisha Nigam

Introduction (S242)
» Loyd Bastin

Powered by Ex Ordo, everything you need to run a research conference.

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

“1 did the best | possibly could”: Supports and barriers that
influence teachers’ incorporation of climate science in high
school chemistry courses

» Nicole James, Kieran Wharton

Integration of a research-based laboratory project into the
General Chemistry Il laboratory

» Yujuan Liu, Joshua Jaison, Kaeryn Cruz, Xisen Wang

Going green in general chemistry: Progress and planning
» Penny Workman

Analysis of Climate Change in General Chemistry Textbooks
» Patrick Wilson, Melissa Weinrich

$164: Inside the Division of Chemical Education
CP-139
Chaired by: Stephanie Ryan and Kimberly Cortes

Introduction (S164)
» Stephanie Ryan

The Executive Committee
» Thomas Bussey

Connecting Chemical Educators and Learners to ACS
» Michael Adams, MaryKay Orgill, Jodi Wesemann

Strategic Planning Insights
» Resa Kelly

DivCHED Program Committee
» Ryan Sweeder

$59: Engaging Students & Curriculum Development in Large
Classes

CP-153
Chaired by: Alicia Paterno
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8:36am
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9:39am

8:30am

8:30am

8:36am

8:57am

Introduction (S59)
» Elinor Soult

Using OneNote for Multi-Modal Note Delivery, Answering
Homework Questions, and Distributing Worksheets for
Active Learning in Large Chemistry Lecture Courses.

» Joshua Owen

A Cloze Style Hybrid Lecture Note Manual/Textbook to
Enhance Engagement in Large Enrollment General Chemistry
Lecture

» James Peploski

Helping Students Build Metacognitive Skills - Assessment
Wrappers in a Large First-Semester Organic Chemistry
Lecture Course

» Shawn Miller, Alex Ambrose, Bo Pei, Thomas Joyce

Harnessing the Power of Exam Reflections on First Semester
General Chemistry Exams

» Rita Hatfield

S83: Developing Mechanistic Reasoning in Organic Chemistry:

Research and Practice
CP-179
Chaired by: Benjamin Burlingham

Introduction (S83)
» April French

Behind the Scenes of Mechanistic Reasoning in Organic
Chemistry

» Gautam Bhattacharyya

Contrast Between Students’ Operative and Epistemic
Modeling Knowledge in the Context of Organic Acid-Base
Reactions

» Emmanuel Echeverri, Morgan Balabanoff

Powered by Ex Ordo, everything you need to run a research conference.

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

Undergraduate Organic Chemistry Students’ Epistemic
Cognition Within a Novel Activity

» Matthew Breuer, Alena Moon

Exploring Patterns in Learner Explanations of Organic
Chemistry Reaction Mechanisms Using Text Network
Analysis

» Caroline Crowder, Jeffrey Raker

$82: Small Teaching - Making Modest but Powerful Changes to
Improve Student Learning

CP-183
Chaired by: Kevin Stewart

Introduction (S82)
» Elinor Soult

Characterization of Shame Experiences in Introductory
Organic Chemistry Courses Using the AEQ-OCHEM
Instrument

» Stephanie Frost, Justin Pratt, Jeffrey Raker

Implementation of Extra Credit Quizzes in General Chemistry

» Eric Johnson

Unifying Topics in First-Semester General Chemistry: A
Semester-Long Project Fostering Connectivity and
Understanding

» Andrew Thomas, Paula Nolibos, Bhawani Regmi

Building Thinking Classrooms: Quick Ways to Turn Worksheet
into Thinking Tasks

» Kate Fritts, Courtney Eddleman

$239: Exploration of Student-centered Assessments in
Chemistry Education

CP-201
Chaired by: Erin Saitta
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8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

Introduction (S239)
» April French

Investigating Inorganic Chemistry Students’ Strategies when
Characterizing Symmetry of Geometrical Shapes

» Alvir Sangha, Joel Beier, Sam Pazicni, Maia Popova

Creative Exercises in Inorganic Chemistry

» Janet Shaw

Investigating How Students Cognitively Engage with
Feedback Generated Through Peer Review

» Mary Tess Urbanek, Danny Vinton, Alena Moon

An Investigation of General Chemistry Instructors’ Purposes
of Assessing

» Ying Wang, Lu Shi, Jherian Mitchell-Jones, Marilyne Stains

$233: Computers in Chemical Education
CP-208
Chaired by: Robert Belford and Tanya Gupta

Introduction (S233)
» Elinor Soult

Teaching programming with diversity in mind
» Marie van Staveren

Using a Scroll-Bar Approach in Excel to Simulate Multi-Peak
UV/Vis Spectra of Food Dyes

» Kathryn Thigpen, lan Krouse, Mai Yin Tsoi

Teaching Coding to Undergraduate and Graduate Chemists
» Benjamin Lear, Christopher Johnson

Powered by Ex Ordo, everything you need to run a research conference.

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

OER chemical education resources advancing Fourth
Paradigm science and curriculum integration of semantic
and symbiotic web technologies.

» Robert Belford, Sunghwan Kim, Jordi Cuadros, Ehren Bucholtz

$132: The Theory and Practice of Analytical Chemistry In the
Classroom

CP-211
Chaired by: Matt Queen

Introduction (S132)
» Matt Queen

Kombucha Katastrophe; A Lesson In Statistics From the
Wrong Side of the Key

» Matt Queen

Using the River in Our Backyard for Research in Our
Classrooms

» Kristina Stefaniak

From trash to knowledge: Building instrumentation models
from recycled materials

» lllya Medina Velo

Flow Injection Analysis as a Platform to Understanding
Modern Analytical Instrumentation

» llkka Lahdesmaki

S75: Alternative Pathways in General Chemistry: Meeting the
Needs of Varied Student Populations

CP-220
Chaired by: Rebecca Ricciardo and J. Dafhne Aguirre

Introduction (S75)
» Elinor Soult
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9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

Rethinking the Math requirement Timing for General
Chemistry: a New Pathway for STEM Students at a Large
Public University

» Rebecca Ricciardo

A Slower Paced Two-Semester Sequence for the Completion
of General Chemistry |

» Verna Baron

Enhancing Access and Success in STEM through a Three-
Semester Approach to General Chemistry

» |. Dafhne Aguirre

Factors Influencing Success in a Traditional General
Chemistry Sequence versus a Sequence Spread over Three
Semesters

» Amanda Burkhart, Justin Sims, Robbie Montgomery

S47: Beyond Confirmatory Experiences: Teaching in the
Chemistry Laboratory

CP-222
Chaired by: David Styers-Barnett

Introduction (S47)
» Elinor Soult

Advanced Organic Chemistry Laboratory Experiment:
Synthesis of Biaryls via an ipso-Borylation and Suzuki-
Miyaura Coupling

» Elsa Hinds

"Look Mom, | Made Drugs!" A Skills-Based Approach in the
Organic Chemistry Laboratory Leading to a Self-Designed,
Pharmaceutical Experiment.

» Bethany Melroe Lehrman

Powered by Ex Ordo, everything you need to run a research conference.

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

Linking Organic Chemistry Il, Physical Chemistry, and
Biochemistry Laboratories in the Study of the Inhibition of
Alkaline Phosphatase by Phenylalanine Derivatives

» Shelby Lash, Bella Ruozzi, Catherine Boino, Eric Ballard,
Benjamin Wilson, Scott Witherow

Creating a Collaborative Organic-Inorganic Cross-Course
Discovery-type Experiment for Undergraduate Chemistry
Students

» John De Backere, Barb Morra

S$114: Integrating Humanities into Chemistry Education
CP-287
Chaired by: Feier Hou and Rebecca Jones

Introduction (S114)
» Feier Hou

Engaging Non-Science Majors in Chemistry through Pop
Culture

» Jennifer Fishovitz

The Sound of Science
» Kathryn Rust, Colin Hill

"Chemistry on Screen" - An Engaging Approach to Teaching
General Chemistry for Non-Science Majors

» Dana Horgen

Fostering Interdisciplinary Connections through High Impact
Learning Communities

» Pinky A McCoy, Leanne White, Jonathan Lopez, Lashay McQueen

S60: Promoting Global Collaboration in Chemistry Education:
Insights from International Initiatives

CP-297
Chaired by: Adrian Villalta-Cerdas

Introduction (S60)
» Adrian Villalta-Cerdas
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8:30am

8:36am

8:57am

ACS Recognition for Global Programs in the Chemical
Sciences

» Michelle Brooks, Wasiu Lawal, Lily Raines

Green Chemistry Education: Empowering the Global
Community

» Amy Cannon, Jonathon Moir, Monica Nyansa, Natalie J. O'Neil,
Juliana Vidal

Globalizing STEM students: Building Accessible International
Research Experiences

» |sabelle Lagadic

Insights from the IUPAC Global Women's Breakfast:
Empowering Women in Science

» Akiko Nakamura

S$254: Biochemistry Education: Discussions of the Laboratory
Learning Environment

JSB-103
Chaired by: Sara Johnson and Sharifa Love-Rutledge

Introduction (S254)
» Elinor Soult

Folate Biochemistry: A Comprehensive Investigative Learning
Opportunity

» Gopal Periyannan

Development of an RNA Biochemistry Lab Module for
Undergraduate Education: Integrating Protein
Overexpression and Purification Skills With Enzyme Activity
Measurements Using the T7 RNA Polymerase System

» Ruchi Shukla, Nicholas Reiter, Aashay Mardikar, Sahar Alishiri,
Sudiksha Pandey, Dulmi Senanayaka
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9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

Industry or Research? A Biochemistry Lab Curriculum
Integrating Chemical Techniques Across Contexts

» Amanda Hughes

Teaching Principles and Optimization of Native Gel
Electrophoresis

» Blair Szymczyna, Didem Vardar Ulu

S$21: Grading for Growth
JSB-121
Chaired by: Joan Esson

Introduction (S21)
» Elinor Soult

Grading for Growth in a First-Year General Chemistry Course
» Stacy Stegall

Combining Traditional Grading with Mastery Grading in
Introductory Chemistry Courses

» Kathryn Davis, Kyle Watson, Jeff Osborne

Specifications Grading in the General Chemistry Laboratory:
Do All Students Benefit From It?

» Lisa Morkowchuk, Brandon Yik, Marilyne Stains, Lindsay
Wheeler, Josipa Roksa

Characterizing Implementations of Specifications Grading
Through an Analysis of Syllabi

» Haleigh Machost, Brandon Yik, Marilyne Stains

$188 -

S188 Process Oriented Guided Inquiry Learning (POGIL) in the
Classroom and laboratory

JSB-203
Chaired by: Marty Perry and Laura Parmentier

Introduction (S188)
» Marty Perry
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8:36am

8:57am

9:18am

Successes and Challenges of Implementing and Assessing
POGIL-like Activities in the General Chemistry Sequence

» Brett Cagg

Decreasing DFWs in General Chemistry: Potential Synergistic
Effects of POGIL in Conjunction with Various Pedagogies

» |essica Fautch, Gregory Foy, Rachel Foy

Exploring the Nexus of Self-Efficacy and Process-Oriented
Guided Inquiry Learning (POGIL) in a Hispanic-Serving
Institution: Insights and Implications

» Maryanne Long, Paulette Vincent-Ruz

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (S267)
» Elinor Soult

Analysis of Academic Integrity Statements in Chemistry
Course Syllabi

» Slade McAfee, Jon-Marc Rodriguez

A Comparative Case Study of Instructor Perspectives of
Biochemistry Courses Taught in Different Departments at the
Same Institution

» Kodi Nix, Thomas Bussey, Sonia Miller Underwood

Elements of Culturally Relevant Instruction: An instructional
framework for college chemistry instructors

» Destinee Cooper, Matthew Voigt

Powered by Ex Ordo, everything you need to run a research conference.

8:30am

8:30am

8:30am

A Tale of Two Platforms: Using Achieve and Smart Worksheets
in Labs

JSB-218
Chaired by: Jim Zubricky

A Tale of Two Platforms: Using Achieve and Smart
Worksheets in Labs

» Jim Zubricky, Bill Heslop, Christian Perlee, M. Naeem Shahid,
April French

Making the Most of the Syllabus: Centering Learning from the
Start

JSB-108
Chaired by: Julie Donnelly

Making the Most of the Syllabus: Centering Learning from
the Start

» Julie Donnelly, Kurt Winkelmann

An ACS Exams committee experience: Writing and editing exam
items as well as considering partial credit assignment of
incorrect responses in the writing process

JSB-114
Chaired by: Kristen Murphy

An ACS Exams committee experience: Writing and editing
exam items as well as considering partial credit assignment
of incorrect responses in the writing process

» Kristen Murphy, David Schreurs, Jaclyn Trate, Sachin Nedungadi,
Olga Michels, Chrystal Bruce, Melissa Reeves, Patricia Kreke,
Thomas Pentecost

LibreTexts: Building your OER textbook for your class
JSB-231
Chaired by: Joshua Halpern

LibreTexts: Building your OER textbook for your class
» Joshua Halpern, Delmar Larsen
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8:30am

8:30am

8:30am

The POGIL Project Workshop: Introduction to POGIL Labs
JSB-243
Chaired by: Michael Garoutte

The POGIL Project Workshop: Introduction to POGIL Labs
» Michael Garoutte, Craig Teague

Art and Archaeology-Inspired Chemistry Labs and Activities
JSB-244
Chaired by: Kristin Labby

Art and Archaeology-Inspired Chemistry Labs and Activities
» Kristin Labby, Kevin Braun, Annelise Gorensek-Benitez

Real Intelligence (Still) Beats Artificial Intelligence: Engaging
Students with Inquisitive Molecular Modeling

JSB-337
Chaired by: Jurgen Schnitker

Real Intelligence (Still) Beats Artificial Intelligence: Engaging
Students with Inquisitive Molecular Modeling

» Jurgen Schnitker

Summative rubric evaluation for the assessment of mechanism
questions in the second-year organic chemistry course
sequence

JSB-347
Chaired by: Sarah Zingales

Summative rubric evaluation for the assessment of
mechanism questions in the second-year organic chemistry
course sequence

» Jay Wackerly, Michael Wentzel, Sarah Zingales

Powered by Ex Ordo, everything you need to run a research conference.

8:30am

10am

10:15am

10:15am

10:21am

10:37am

11:23am

10:15am

10:15am

Backward-Design Your Laboratory Course
JSB-357
Chaired by: Annette Neuman

Backward-Design Your Laboratory Course
» Annette Neuman, Brenda Harmon

Break

$229: ELIPSS and Beyond: Celebrating the work and impact of
2023 James Flack Norris Awardees Renée Cole, Juliette Lantz,
and Suzanne Ruder

CP-103
Chaired by: Rick Moog

Introduction (5229)
» April French

A Celebration of Excellence and Impact
» Rick Moog

Going Beyond Content Knowledge: Aligning Classroom
Activities and Assessment to Promote Transferable Skill
Development

» Juliette Lantz, Renée Cole, Suzanne Ruder

Panel Discussion (5229)
» Kim woodrum

S66: Views from the Classrooms of Award Winning Chemistry
Teachers

CP-111
Chaired by: Deanna Cullen

Introduction (S66)
» Deanna Cullen
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10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

ACS National and Regional Awards for High School Chemistry
Teaching

» Adam Boyd

Increasing Student Engagement in the Chemistry Classroom
» Stacey Balbach

Making Chemistry Relevant and Yours!
» Sherri Rukes

Q&A Session (566)
» kim woodrum

$242: Integrating Green Chemistry and Sustainability into
Chemistry Education

CP-114
Chaired by: Loyd Bastin and John De Backere

Introduction (S242)
» Loyd Bastin

Perspectives of Undergraduate Chemistry Instructors on
Teaching Climate Change

» Patrick Wilson, Melissa Weinrich

Teaching greener analytical chemistry: Some ideas & tips
» Andy Dicks

Advancing Green Chemistry Education
» Manisha Nigam

Q&A Session (5242)
» kim woodrum

Powered by Ex Ordo, everything you need to run a research conference.

10:15am

10:21am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

$164: Inside the Division of Chemical Education
CP-139
Chaired by: Stephanie Ryan and Thomas Bussey

Introduction (S164)
» Stephanie Ryan

Bylaws: What Are They Good for? (Say It Again ...)
» Daniel King

Living Large
» Amiee Modic

Navigating Leadership: Insights from Chairing the Division of
Chemical Education

» Resa Kelly

The Leadership Launchpad: All About the Early Career
Chemistry Education Scholars Committee

» Olivia Crandell

S59: Engaging Students & Curriculum Development in Large
Classes

CP-153
Chaired by: Alicia Paterno

Introduction (S59)
» Elinor Soult

The Middle Ground: An “Atoms to Reactions” Approach to
General Chemistry

» Kevin Revell

A Study on Student Recall of the Elements in the Periodic
Table in a First-Semester General Chemistry Course

» Stephen Testa
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11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

Curriculum Redesign for Inclusivity in a High-Enroliment
General Chemistry Sequence

» Shaunna McLeod, Hannah Lant

Investigating Student Engagement in Clicker Questions Using
the Activity Engagement Survey (AcES)

» Pallavi Nayyar, Scott Lewis

$83: Developing Mechanistic Reasoning in Organic Chemistry:
Research and Practice

CP-179
Chaired by: Benjamin Burlingham

Introduction (S83)
» April French

Analyzing and Fostering Students’ Argumentation Patterns of
Alternative Reaction Pathways in Organic Chemistry

» Leonie Lieber, Krenare lIbraj, Ira Caspari-Gnann, Nicole Graulich

Mapping Chemistry Students’ Learning Paths When
Reasoning About Reaction Mechanisms

» Paul Martin, Brandon Yik, Benjamin Burlingham, Nicole Graulich

Exploring Adaptive Support to Derive Guidelines for an
Intelligent Tutoring System for Problem-Solving in Organic
Chemistry

» Marc Rodemer, Gyde Asmussen, Sascha Bernholt

Designing a Formative Assessment Task to Support Student
Construction of a Mechanistic Explanation for a Complex
Phenomenon.

» Kriti Seth, Elizabeth Day, Melanie Cooper

Powered by Ex Ordo, everything you need to run a research conference.

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

$158: Designing and Facilitating Chemistry Learning
Environments Anchored in Phenomena

CP-183
Chaired by: Adam Schafer and Lindsay Wells

Introduction (S158)
» April French

Building Community By Crafting Learning Environments With
Shared Accountability

» Adam Schafer, Emily Adams, Lindsay Wells, Jennifer Timmer

Using CER to Develop Models Explaining Chemical
Phenomenon

» lennifer Timmer

Chemistry & ELA Cross Curricular Projects & Instructional
Strategies

» Kevin Cram

Web-based simulations built with Unity
» Steven Sogo

$239: Exploration of Student-centered Assessments in
Chemistry Education

CP-201
Chaired by: Erin Saitta

Introduction (5239)
» April French

Creative Final Projects in Biochemistry 'Inspired by Enzymes'
» Melissa Mullen Davis

Using Creative Exercises to Apply Prior Knowledge and
Improve Critical Thinking in Biochemistry Learning

» Yulia Gerasimova, Samantha Partlow, Dylan Leemok, Jonathan
Caranto, Dmitry Kolpashchikov, Christopher Nix, Erin Saitta
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11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

Enhancing student success and linking of chemistry concepts
through a learner-centered assessment implemented in
introductory chemistry

» Li Ye, Alex Gilewski

Making Connections: Designing Final Projects Around
Student’s Communities

» Ariel E. Vaughn

$233: Computers in Chemical Education
CP-208
Chaired by: Robert Belford and Jonathan Gutow

Introduction (S233)
» Elinor Soult

Not all flipped class resources are created equally: improving
out-of-class student learning with question-embedded videos

(QEVs)

» Binyomin Abrams

The Use of Al to Grade Open-Ended Questions in a Large
Enroliment Lab Course

» John Wiginton, Olivia Harwick, Jason Pearson

Breaking the "Golden Handcuffs" that bind courses to
Commercial Homework platforms with the ADAPT Open
Homework and Assessment Platform

» Delmar Larsen

Development of an open-access, community-driven, peer-
reviewed library of green chemistry educational materials in
Drupal 10: The Green Chemistry Teaching and Learning
Community (GCTLC)

» Jonathon Moir, Nimrat Obhi, Sarah Prescott, Amy Cannon

Powered by Ex Ordo, everything you need to run a research conference.

10:15am

10:217am

10:42am

11:03am

10:15am

10:15am

10:21am

10:42am

11:03am

$132: The Theory and Practice of Analytical Chemistry In the
Classroom

CP-211
Chaired by: Matt Queen

Introduction (S132)
» Matt Queen

Incrementally Building a Toolkit of Chemical Analysis Skills
though Short Projects

» Erin Wilson

Classroom simulations for teaching analytical chemistry
concepts

» Mark Jensen

Analytical chemistry is the future! Preparing students to
address global challenges.

» Ginevra Clark

S75: Alternative Pathways in General Chemistry: Meeting the
Needs of Varied Student Populations

CP-220
Chaired by: Rebecca Ricciardo

Introduction (S75)
» Elinor Soult

The STEMentors Program: Promoting Community Building
and Academic Readiness through Peer-Learning

» Josie Nardo

MAX CHEM: a Sidecar Course to Support Student Success in
General Chemistry 1

» Daniel Blumling, Ashleigh Baber

Creating Social Belonging and Connectedness in an Online
Forensic Science Course

» Gina Londino-Smolar
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11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

Group Discussion (S75)
» kim woodrum

S47: Beyond Confirmatory Experiences: Teaching in the
Chemistry Laboratory

CP-222
Chaired by: David Styers-Barnett

Introduction (S47)
» Elinor Soult

A Laboratory Predicated on Non-Confirmatory Data: Using
Surface Water Quality Analyses as a Framework

» Neil A. Law, Barbara L. Brabetz

Linking Current Ecological Challenges to a Non-science Major
Chemistry Laboratory

» |effrey Pribyl

Investigation of Bath Bomb Kinetics as an Inquiry or
Research Experience for Chemistry Students at Different
Levels

» Jennifer Mihalick

What's on my Surfaces? Design and Implementation of an
Indoor Surface Films CURE

» Andrea Van Wyk, Lauren Andrews, Alexandria Julius, Binaya
Shrestha, Scott Shaw, Renée Cole

S$114: Integrating Humanities into Chemistry Education
CP-287
Chaired by: Feier Hou and Rebecca Jones

Introduction (S114)
» Feier Hou
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10:21am

10:42am

11:03am

11:24am

10:15am

10:15am

10:21am

10:42am

11:03am

11:24am

Creative-Writing and Art Projects in General and Inorganic
Chemistry Classes

» Feier Hou

Story of Colorants: Creative Writing as a Way to Convey
Personal Investigations into Chemistry

» Patricia Jue

Exploring the Overlap of Chemistry, Literature, and Language
in an Upper-Level Lecture Course

» Carrigan Hayes

Q&A (S114)
» Feier Hou

S60: Promoting Global Collaboration in Chemistry Education:
Insights from International Initiatives

CP-297
Chaired by: Adrian Villalta-Cerdas

Introduction (S60)
» Adrian Villalta-Cerdas

Professional Development for Chemistry Teachers in the USA
and the Balkan Countries on Solution Energetics

» Thomas Greenbowe, Marian DeWane

International Collaborations Provide Transformative
Experiences in a "Chemistry in Art" Study Abroad Course in
France

» |eff Fieberg

Chemical Imagination and Innovation - A US-Hungary Study
Abroad Collaboration

» David Thompson, llona Petrikovics

On the Impact of Virtual Laboratory Simulations During and
Post COVID-19 in South African Chemistry Departments

» Dudley Shallcross, Bill Heslop, lain Thistlethwaite
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Continued from Tuesday, 30 July 10:42am gon:jr'nunsicating Student Progress in Courses with Alternative
rading Systems

. . . . . » Kyle Broaders
10:15am  s254: Biochemistry Education: Discussions of the Laboratory

Learning Environment
JSB-103
Chaired by: Sara Johnson and Sharifa Love-Rutledge

11:03am Standards-Based Grading in Analytical Chemistry
» Joan Esson

10:15am  s124: George R. Hague Memorial AP/IB Chemistry Symposium
JSB-203
Chaired by: Alice Putti

10:15am Introduction (S254)
» Elinor Soult

10:21am Shaping Learning in an Upper Division Biochemistry
Laboratory Using Fink’'s Taxonomy

» Satya Dulam, Juliana Lessa Sacoman

10:15am Introduction (S124)
» Elinor Soult

10:21am Harnessing Social Media for Bite Size Review

10:42am The Summer Science Program in Biochemistry: Lessons » Nora Walsh

Learned Over Five Years at Indiana University
» Jessica Hollenbeck, Martha Oakley, Amy Barr, Mark Hall .
10:42am Using POGIL to Target Common Challenges and
Misconceptions in AP Chemistry

11:03am Using Mastery Grading in a Biochemistry Lab Class Based on » Paula Butler
Modularly Designed Experiments -
» Kyle Willian 11:03am  Teaching acid/base chemistry with POGIL

» Laura Trout
11:24am A Biochemistry Lab Course-Based Undergraduate Research
Experience in Assembling Biodegradation Pathways for

enviPath 11:24am Improving Your Skills as an Item Writer
» |eff Osborne » Michael Farabaugh

10:15am  $37: Chemistry Education Research: Undergraduate Student
Research Symposium

JSB-213
Chaired by: Julie Donnelly and Nicole Lapeyrouse

10:15am  s21: Grading for Growth
JSB-121
Chaired by: Joan Esson

10:15am Introduction (521) 10:15am Introduction (S37)

» Elinor Soult » Elinor Soult

10:21am Enhancing Student Success in Organic Chemistry Through 10:21am The STEM Pipeline Metaphor as an Agent of Dehumanization
Specifications Grading and Marginalization
» Samuel Touchette, Joseph Simard » Claudia Trevino, Paulette Vincent-Ruz
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Continued from Tuesday, 30 July 10:15am

10:42am

11:03am

11:24am

10:15am

10:15am

10:21am

10:42am

11:03am

11:24am

Student Reflections of Their Sense of Belonging in General
Chemistry Courses

» Zamira Torres, Keila Muller, Camila Senespleda, Tamra Legron-
Rodriguez

Exploring Students’ Professional Identity to Their STEM Major

» Jackson Ellis, Cameron Bechard, Abigail Castillo, Tamra Legron-
Rodriguez, Nicole Lapeyrouse

Analyzing Potential Factors That can Impact Students’
Professional Identity in Forensic Science

» Abigail Castillo, Cameron Bechard, Tamra Legron-Rodriguez,
Nicole Lapeyrouse

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (S267)
» Elinor Soult

(Dis)Ability and Accommodation: Exploring the accessibility
of general and organic chemistry course design

» Samantha Chrin, Josie Nardo

STEM Identity: How students’ see themselves as future STEM
graduates

» Cameron Bechard, Abigail Castillo, Jackson Ellis, Tamra Legron-
Rodriguez, Nicole Lapeyrouse

Marginalized Students’ Sense of Belonging in Organic
Chemistry Practices

» Anais Nevarez, Ira Caspari-Gnann

Understanding the Concealable Stigmatized Identities of
LGBTQ+ Students in Undergraduate Chemistry

» Johnathan Chisam, Josie Nardo

Powered by Ex Ordo, everything you need to run a research conference.

11:45am

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

Beyond “verbatim” transcription: Using techniques from
applied linguistics to enhance the analysis of classroom talk in
chemistry education research

JSB-108
Chaired by: Alissa Hartig

Beyond “verbatim” transcription: Using techniques from
applied linguistics to enhance the analysis of classroom talk
in chemistry education research

» Alissa Hartig, Safaa El-Mansy, Jack Barbera
Lunch

$167: Playing Fun-tastic Games in Chemistry
CP-103
Chaired by: theresa gaines

Introduction (S167)
» theresa gaines

It’'s In The Syllabus! A First-Day Syllabus Scavenger Hunt to
Gamify A Boring Task

» Rachel Doughty

“CLUES, CHEMISTRY, AND NOBEL LAUREATES” GAME! An
Engaging Peer-Learning Chemical Education Review Game for
Undergraduate Health Sciences Students

» Angela Mahaffey

NanoAdventure: Development and Assessment of a Text-
Based Adventure Game in English, Spanish, and Chinese for
Communicating about Nanoscience

» Natalie Hudson-Smith, Wilanyi Alvarez-Reyes, Xiaoxiao Yao, Jiayi
He, Rebeca Rodriguez, Stephanie Mitchell, Mahmoud Matar Abed,
Eleni Spanolios, Miriam Krause, Christy Haynes

Chemistry and Chaos - A Chemistry Role-Playing Game
» James Mendez

Page 56


https://www.exordo.com/?utm_source=bcce2024&utm_medium=PDF&utm_campaign=PDF

Biennial Conference on Chemical Education 2024 28 Jul - 01 Aug 2024 All times in EDT

Continued from Tuesday, 30 July

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

$230: Honoring Laura Trout: Making POGIL at the High School
Level a Reality

CP-111
Chaired by: Rick Moog

Introduction (S230)
» Rick Moog

Crafting Powerful POGIL Models
» Melissa Hemling

Using POGIL to Secure Strong Outcomes Among Diverse
Academically Talented High School Students

» Michael Bruno

College vs. High School POGIL Facilitation - The Blowback, the
Buy-In, and the Benefits!

» Rachel Foy

Professional Development Extraordinaire: From a Workshop
in Wabash to a Career using POGIL

» Paula Butler

$242: Integrating Green Chemistry and Sustainability into
Chemistry Education

CP-114
Chaired by: Loyd Bastin and Matthew Tracey

Introduction (S242)
» Loyd Bastin

An Inquiry Based Friedel-Crafts Acylation Experiment,
Utilizing a Greener Approach

» Verna Baron, Charles Ketron

Powered by Ex Ordo, everything you need to run a research conference.

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

Making Teaching Organic Chemistry Laboratory Courses
Safer, More Sustainable, and With Holistic Learning by
Employing Greener Protocols.

» Marlius Castillo

Going Green in Organic Chemistry: Optimizing an Aqueous
Suzuki Reaction
» Andy Dicks, Alicia Battaglia

Green Oxidation of Alcohols Using an Oxoammonium Salt

» John Milligan

$164: Inside the Division of Chemical Education
CP-139
Chaired by: Stephanie Ryan and Thomas Bussey

Introduction (S164)
» Stephanie Ryan

Board of Publications - Journal of Chemical Education
» Deborah Herrington, Maria Oliver-Hoyo

JChemEd 101: Past, Present and Future of Publishing
Educational Innovation

» Thomas Holme

Chemical Education Xchange (ChemEd X)
» Deanna Cullen, Jon Holmes

Long-Range Planning Committee
» William Donovan

S59: Engaging Students & Curriculum Development in Large
Classes

CP-153
Chaired by: Alicia Paterno

Introduction (S59)
» Elinor Soult
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2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

High Success in Student Engagement and Retention in
General Chemistry for Science yet Non-Chem Majors

» Benjamin Turnpenny, Steven Murphy, Clarice Kelleher, Alexsa
Silva

Stemble: Enhancing Chemistry Education With Al for Effective
Large Class Management

» Paul Seward

Reinventing Recitation
» Erin Peters

Insights From Piloting (REALLY) Large Recitation Sessions in
General Chemistry

» Megan Bucks, Daniel Waddell, Soumalya Sinha, Artur Huseinov

§298: Present and Future Directions in Organic Chemistry
Laboratory Courses

CP-155
Chaired by: Noel Paul

Introduction (S298)
» Noel Paul

Organic Lab Skills Practical: A Checkpoint for Success
» Erica Merriett

New Bromination Reactions for the Organic Chemistry
Laboratory

» Michael Korn, Alex Glase, Claudia Kennedy

A Multistep Synthesis Incorporating Polymers for the Organic
Chemistry Lab

» Jonathan Moerdyk

Powered by Ex Ordo, everything you need to run a research conference.

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

Scaling the Synthesis of a COVID-19 Antiviral Drug Down From
the Process Laboratory to the Organic Chemistry Teaching
Laboratory

» Pamela Lundin, Andrew Wommack, Aaliyah Holloway, Kaitlyn
Stallings

S83: Developing Mechanistic Reasoning in Organic Chemistry:
Research and Practice

CP-179
Chaired by: Benjamin Burlingham

Introduction (S83)
» April French

Emphasizing Explanations Every Day: Investigating Student
Engagement With Explanation in Organic Chemistry

» Olivia Crandell, Michelle Nelson

Causal Reasoning as Decoration or Driver for Decision-
Making in Organic Mechanism Practice

» [ra Caspari-Gnann, Rebecca Scheck, Lee Price, Julia Eckhard

Bringing Real Data Into the Organic Chemistry Lecture:
Exercises

» Brian Esselman, Ryan Stowe, Mary Beth Anzovino, Kimberly
DeGlopper

Bringing Real Data Into the Organic Chemistry Lecture:
Assessments

» Mary Beth Anzovino, Brian Esselman, Ryan Stowe, Kimberly
DeGlopper

$158: Designing and Facilitating Chemistry Learning
Environments Anchored in Phenomena

CP-183
Chaired by: Adam Schafer

Introduction (S158)
» April French
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2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

Making Space for Chemistry Student Agency During
Consensus Building

» Stacey Balbach

Construct and critique: Changing what it means to “know
Chemistry” on tests and exams.

» Aaron Burg, Katilyn Schrader

Assessments as sites for framing and communicating
teachers’ epistemic learning goals

» Lindsay Wells

Mapping the Epistemic Environment of Two Phenomena-
Based High School Chemistry Classrooms

» Brie Bradshaw, Ryan Stowe

$239: Exploration of Student-centered Assessments in
Chemistry Education

CP-201
Chaired by: Erin Saitta

Introduction (S239)
» April French

Connecting with Science: An Evaluation of the Types of Real-
World Chemistry Applications Identified by General
Chemistry | Students and the Connection to Course Material

» Natalie Leon, Ariel E. Vaughn

Fostering Inclusivity and Engagement through Student-
Centered Assessments in Organic Chemistry Il

» Jocelyn Lanorio

Utilizing Scientific Posters as a means for Formative and
Summative Assessment in Major and non-Major Courses

» Daniel King

Powered by Ex Ordo, everything you need to run a research conference.

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

$233: Computers in Chemical Education
CP-208
Chaired by: Robert Belford

Introduction (S233)
» Elinor Soult

Complementing Computer-Based Learning Activities with
Physical Experiences

» Joel Beier, Martina Rau, Sam Pazicni

The chemistry textbook of the future, today.
» Joshua Halpern

Using molecular computation and visualization to teach
chemistry

» Kevin Range

Wolfram Notebooks for Chemical Education

» John McNally

S98: Effective Approaches to Inclusive Chemistry Education
CP-211
Chaired by: Kate Ries

Introduction (S98)
» April French

Fostering a sense of belonging on the Green Chemistry
Teaching and Learning Community (GCTLC) online platform

» Nimrat Obhi, Jonathon Moir, Andrea Oseolorun, Sarah Prescott,
Amy Cannon

Investigating the Significance of Mental Visualisation Ability
on Chemistry Students’ Representational Competencies and
Visuospatial Abilities

» Lauren Baade, Gwendolyn Lawrie, Effie Kartsonaki, Hassan
Khosravi
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2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

A Second Glance - An Eye-Gaze-Augmented Retrospective to
Stimulate Reflection on Problem-Solving in Organic
Chemistry

» Axel Langner, Nicole Graulich

Using Anonymous Feedback to Create a Dynamic and
Responsive Classroom

» Stephanie Knezz

$136: Data-driven Approaches for Using Interactive Online
Courseware to Improve Learning and Increase Equity

CP-220
Chaired by: Mark Blaser

Introduction (S136)
» April French

Applying Learning Engineering to the Design of Equitable
Online Courseware for Introductory Chemistry

» Sandra Raysor, Ariel Anbar, Norman Bier, David Yaron, Mark
Blaser, Ken Koedinger, Kim Larson, Kathryn Rico, Melissa Renfrey,
Miasha Brunkhorst, Melanie Narish, Mark Landry, Robert Hunt,
Julia Lehman, Shree Lakshmi Rao

Learning about Learning from Millions of Student
Interactions with Online Courseware

» David Yaron, Mark Blaser, Elizabeth Mclaughlin, Hui Cheng,
Sandra Raysor, Kenneth Koedinger

Insights into Improving Outcomes by Monitoring the
Learning Process in Hybrid General Chemistry Courses
» Mark Blaser, David Yaron, Kenneth Koedinger, Elizabeth
Mclaughlin, Hui Cheng, Sandra Raysor

Preliminary Implementation of a Mastery Grading System in
a Large Enrollment General Chemistry Course: Impact on
Overall Outcomes and Equity Gaps

» Joshua Hartman, |ack Eichler

Powered by Ex Ordo, everything you need to run a research conference.

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

S47: Beyond Confirmatory Experiences: Teaching in the
Chemistry Laboratory

CP-222
Chaired by: David Styers-Barnett

Introduction (S47)
» Elinor Soult

Arrows Point the Way: Titrating Inside of a Flowchart

» Joseph Lomax

Shedding Light on Perovskites: A Project Lab for llluminating
Analytical Chemistry Principles

» Pamela Doolittle, Kristel Forlano, Eliana Bernat, Song Jin,
Amanda Buchberger

Short Research Projects in the Analytical Laboratory
» Chris Dahm

A Research-based Instrumental Analysis Lab with an Industry
Collaboration

» Keith Marek, Katie Peterson, Justin Schiro

S$114: Integrating Humanities into Chemistry Education
CP-287
Chaired by: Feier Hou

Introduction (S114)
» Feier Hou

A Change of Pace: Offering Food Chemistry as an Online,
Summer Course

» Heather Clontz

Bridging Disciplines: The Chemistry of Chocolate Project for
Non-Science Majors

» Bozena Widanski
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2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

Interdisciplinary Perspectives of Culinary Chemistry
» Melissa Mullen Davis

Cuisine, Chemistry and Culture: An Interdisciplinary Course
Connecting Anthropology and Chemistry through Food

» Racquel DeCicco, Celeste Gagnon

$228: Multilingual Learners in Chemistry
CP-297
Chaired by: Julia Chamberlain

Introduction (S228)
» Julia Chamberlain

Chemistry for All: Developing linguistically accessible
assessment items in general chemistry

» Eshani Lee, Erin Bock, Anna Eunji Kim, Jack Barbera

Small Group Conversations in a POGIL-Based Class: How
English Learners Engage in a Joint Knowledge Construction
Process to Reach a Shared Understanding

» Gregory Rushton, Shaghayegh Fateh, Amy Phelps

Enhancing Bilingual Student Engagement in STEM: Insights
from POGIL at a Hispanic-Serving Institution

» Taiwo Adesunloye, Paulette Vincent-Ruz

Engaging with Multilingual Chemistry Learners

» Julia Chamberlain

$253: Biochemistry Education in Honor of Vicky Minderhout
JSB-103
Chaired by: Tracey Murray

Introduction (S253)
» Elinor Soult
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2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

Vicky Minderhout: Teacher, Community Builder, Change
Agent

» Jennifer Loertscher, Tracey Murray

Comprehensive Scheme to Integrate Visualization in
Undergraduate Biochemistry

» Sunil Malapati

Growing and learning together in community: Celebrating
Vicky Minderhout’'s impact on community building in
biochemistry education

» Stephanie Feola

Use of a concept inventory to assess long-term conceptual
change in Biochemistry

» Tracey Murray, Rodney Austin

S174: Disrupting Grading
JSB-121
Chaired by: Clarissa Sorensen-Unruh

Introduction (S174)
» April French

Alternative Grading Considerations in Diverse Courses
» Kristi Closser

Grading: Seeking a Balance
» Langdon Martin

Success in Their Hands: How Students Use Token Systems to
Get What They Need

» Renée Link

Discussion (S174)
» kKim woodrum
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2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

$124: George R. Hague Memorial AP/IB Chemistry Symposium
JSB-203
Chaired by: Alice Putti

Introduction (S124)
» Elinor Soult

Strategies For Teaching Entropy.
» Alice Putti

Introduction to Microstates via Coin Toss (AP Chemistry)

» Jennifer Cook Gregory

Inquiry Activities in AP Chemistry
» Amanda Horan

Updates and Instructional Resources for AP Chemistry

» Jamie Benigna

S37: Chemistry Education Research: Undergraduate Student
Research Symposium

JSB-213
Chaired by: Julie Donnelly and Nicole Lapeyrouse

Introduction (S37)
» Elinor Soult

The Impact of Test Anxiety on Student Test Performance in
Large Enrollment Lower Division Chemistry Classes: A Survey
Study

» Draven Ruiz, Christopher Randles, Marjan Roshandel

Interview Insights on Test Anxiety in Lower Division
Chemistry Courses and How it is Perceived by Students.

» Noor Alaraj, Gavin Winslow, Draven Ruiz, Marjan Roshandel,
Christopher Randles

Powered by Ex Ordo, everything you need to run a research conference.

2:48pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

The Evolution of Conversations on Scientific Information
Literacy With Post-Secondary Education Stakeholders

» Autumn LeBleu, Matilynn Lam, Christopher Randles, Barbara
Chiu

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (5267)
» Elinor Soult

Exploring the Cultural Capitals Latine Undergraduate
Students Use When Applying to STEM Graduate Programs

» Jorge Rivera-Colén, Danielle Maxwell, Sam Pazicni

Doctoral Chemistry Students' Perceptions Concerning the
Value and Development of Professional Skills

» |herian Mitchell-Jones, Brandon Yik, Haleigh Machost, Marilyne
Stains

Evaluating Professional Development Opportunities within
United States Chemistry Graduate Programs

» Contessa Maggard, Candis Aiken, Debra Mlsna

Faculty Perspectives on the Overall Goal of Doctoral
Education in Chemistry

» Benedicta Donkor, Melissa A. Collini, Jordan Harshman

Classroom Exercises for General and Organic Chemistry
Involving Wildlife Forensics and Food Fraud

JSB-108
Chaired by: Scott Donnelly

Classroom Exercises for General and Organic Chemistry
Involving Wildlife Forensics and Food Fraud

» Scott Donnelly
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2pm

2pm

2pm

2pm

ACS Custom Exams: How you can build and use an ACS exam
that fits your needs while still having national data for
comparison.

JSB-114
Chaired by: Olga Michels

ACS Custom Exams: How you can build and use an ACS exam
that fits your needs while still having national data for
comparison.

» Olga Michels, David Schreurs, Jaclyn Trate, Sachin Nedungadi,
Chrystal Bruce, Melissa Reeves, Patricia Kreke, Thomas Pentecost,
Kristen Murphy

ADAPT: LibreTexts Online Homework System
JSB-231
Chaired by: Delmar Larsen

ADAPT: LibreTexts Online Homework System
» Delmar Larsen

The POGIL Project Workshop: Student-Centered Learning in the
Laboratory: The Science Writing Heuristic Approach

JSB-243
Chaired by: Steve Gravelle

The POGIL Project Workshop: Student-Centered Learning in
the Laboratory: The Science Writing Heuristic Approach

» Steve Gravelle, Brandon Fetterly

A Culminating General Chemistry Laboratory Experiment that
Reviews Key Learning Goals Using Natural Pigments

JSB-244
Chaired by: Jennifer Schmeisser

A Culminating General Chemistry Laboratory Experiment
that Reviews Key Learning Goals Using Natural Pigments

» Jennifer Schmeisser, Nadia Marano, Emily Metzger

Powered by Ex Ordo, everything you need to run a research conference.

2pm

2pm

3:30pm

3:45pm

3:45pm

3:51pm

Reducing Barriers to Learning with Digital Chemistry
Notebooks

JSB-337
Chaired by: Jason Sonnenberg

Reducing Barriers to Learning with Digital Chemistry
Notebooks

» Jason Sonnenberg

Aligning laboratory experiments with learning objectives for
focused formative assessment

JSB-347
Chaired by: Justin Shorb

Aligning laboratory experiments with learning objectives for
focused formative assessment

» Justin Shorb, Mandy Dark

Active Learning in Organic Chemistry: Backward Design
JSB-357
Chaired by: Cathy Welder

Active Learning in Organic Chemistry: Backward Design
» Cathy Welder, Catherine Serrano Lugo

Break
$167: Playing Fun-tastic Games in Chemistry
CP-103

Chaired by: theresa gaines

Introduction (S167)
» theresa gaines

Organic Chemistry Telestrations™ - Using a Party Game to
Teach Nomenclature

» David Crisostomo
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4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

Card Games for Kids
» Wendy Foulis

Gamification with EMC2
» Courtney Eddleman, Kate Fritts

Games in chemistry education research: Where do we go
from here?

» theresa gaines

$230: Honoring Laura Trout: Making POGIL at the High School
Level a Reality

CP-111
Chaired by: Rick Moog

Introduction (S230)
» Rick Moog

Transformative Professional Development Through the High
School POGIL Initiative

» Ellen Yezierski

The Continuing Impact of Laura Trout
» Rick Moog

Panel Discussion (S230)
» kim woodrum

Panel Discussion, Continues (S230)
» Kim woodrum

S242: Integrating Green Chemistry and Sustainability into
Chemistry Education

CP-114
Chaired by: Loyd Bastin and Andy Dicks

Powered by Ex Ordo, everything you need to run a research conference.

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

Introduction (5242)
» Loyd Bastin

Enhancing the organic chemistry laboratory experience:
“Green” experiments

» Anju Sharma

Green improvements of reductions of a/B-unsaturated
carbonyl compounds

» Matthew Tracey, Manisha Nigam

Effective and environmentally friendly bromination reactions
of benzene derivatives

» Jose Boquin Romero, Dell Jensen Jr

Green Synthesis of the Crystal Violet via Deep Eutectic
Solvents

» James Plampin

$164: Inside the Division of Chemical Education
CP-139
Chaired by: Stephanie Ryan and Resa Kelly

Introduction (S164)
» Stephanie Ryan

ACS Examinations Institute: Structure, Function and Fit
Within the Division of Chemical Education

» Kristen Murphy, Alex Grushow, Olga Michels, Sachin Nedungadi,
Jaclyn Trate

Chemistry Education Research Committee
» Ryan Stowe, Alena Moon

Introducing the Biennial Conference Committee
» Renée Cole, Justin Carmel

International Activities Committee
» Stephanie Ryan, James Mendez
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3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

S59: Engaging Students & Curriculum Development in Large
Classes

CP-153
Chaired by: Alicia Paterno

Introduction (S59)
» Elinor Soult

Development of a Learning Assistant Program With Limited
Resources

» Alan Gift, Sachin Nedungadi

Using Learning Assistants to Facilitate Student Engagement
in a Large Enrollment General Chemistry Course

» Emily Pelton

Providing Professional Growth for Learning Assistants (LAs)
» Lisa Funari

Q&A Session (S59)
» kim woodrum

$298: Present and Future Directions in Organic Chemistry
Laboratory Courses

CP-155
Chaired by: Noel Paul

Introduction (S298)
» Noel Paul

Authenticity-Driven Design of a High-Enrollment Organic
Laboratory Course

» Brian Esselman, Nicholas Hill, Kimberly DeGlopper, Aubrey
Ellison, Ryan Stowe, Cara Schwarz, Niall Ellias

Powered by Ex Ordo, everything you need to run a research conference.

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

Making It E-Z: Incorporating 2D NMR in the Organic
Chemistry Lab (Part I)

» Will O'Neal

Making It E-Z: Incorporating 2D NMR in the Organic
Chemistry Lab (Part Il)

» Will O'Neal

Q&A Session (S298)
» Noel Paul

S83: Developing Mechanistic Reasoning in Organic Chemistry:
Research and Practice

CP-179
Chaired by: Benjamin Burlingham

Introduction (S83)
» April French

Affordances Offered by Electrostatic Potential Maps While
Investigating Students' Understanding in Organic Chemistry

» Ayesha Farheen, Bradley Chem, Isaiah Nelsen, Betul
Demirdogen, Melissa Weinrich, Scott Lewis

Examining Organic Chemistry Students’ Usage and Perceived
Utility of Electrostatic Potential Maps

» Chloe Robinson, Scott Lewis, Melissa Weinrich

Once Upon a Reaction: Storytelling Through Electron-Pushing
Arrows

» Danielle Jacobs

Building a Reasoning-Centered Course That Works for
Students: A Case Study

» Benjamin Burlingham

$158: Designing and Facilitating Chemistry Learning
Environments Anchored in Phenomena

CP-183
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3:45pm

3:51pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

Introduction (S158)
» April French

Teaching Science with a Purpose
» Laura Walther, Wilson Shafer

$131: Engaging Students using the Chemistry of Beverage
Alcohol

CP-201
Chaired by: Leonard Demoranville

Introduction (S131)
» April French

The Degradation of Wine: An Experimental Design Project for
Analytical Chemistry and Beyond

» vy Fortmeyer

Creating Picobreweries in the General Chemistry Lab: A Guide
to Creating and Analyzing Beer with Undergraduates in less
than 3 Hours a Week.

» Daniel Blumling, Christine Hughey, Brycelyn Boardman, Oscar
Judd, Dylan Boeckmann, Daniel Paunovic, Lauren Slaber, Hayden
Chewning

Using Kombucha and Vodka to Engage Students and Drive
Research Projects

» Benjamin Smith

Using the Chemistry of Beer, Wine, and Bourbon to Teach
Primary Scientific Literature and Science Communication

» Leonard Demoranville

$233: Computers in Chemical Education
CP-208
Chaired by: Robert Belford and Tanya Gupta
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3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

Introduction (5233)
» Elinor Soult

Quantum chess workshops as a method to introduce
qguantum information science through quantum
superposition for high school students

» Heidi Hendrickson, Leah Boyle, Padmanabh Kaushik, Nick Sorak,
Kusum Subedi, Swetha Tadisina, Vedit Venkatesh, Lucas Villamil,
Nam Vu, Crystal Yeung, Maya Zilberstein, Delmar Azevedo Cabral,
Brandon Allen, Pouya Khazaei, Andrew Projansky, James
Whitfield, Victor Batista

Exploring the Potential of Computational Chemistry Inquiries
in High School

» Benjamin Polloth

Thermochemistry: Enhancing Chemical Education through
Computational Chemistry

» Felipe Cordova Lozano, Ana Karen Cordova Estrada

Combining Computer Algebra Systems and Data Analysis
using Open Source Tools

» Jonathan Gutow

S98: Effective Approaches to Inclusive Chemistry Education
CP-211
Chaired by: Kate Ries

Introduction (S98)
» April French

Fostering Inclusive Environments in Undergraduate
Chemistry Courses: Collaborative Class Norms

» Akiko Nakamura

The Inclusive STEM Teaching Project: An Online Faculty-
Development Program for Instructors Teaching STEM
Undergraduates

» Regina Frey
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4:33pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

Culturally Responsive Teaching in the Science Classroom:
How Science Teachers in Rural Alaska Build Relationships
With the Community

» Danielle Maxwell, Archer Harrold, Safron Milne, Jeffrey Spencer,
Ginger Shultz

$136: Data-driven Approaches for Using Interactive Online
Courseware to Improve Learning and Increase Equity

CP-220
Chaired by: Mark Blaser

Introduction (S136)
» April French

Adopting Active Learning Encourages Student Agency and
Supports Student Success

» Michele Stover, Michelle Herridge

Insights into How Students’ Engagement with Online
Instructional Materials Impacts Learning

» Mark Blaser, Josh Hartman, Gizelle Sherwood, Slava Bekker

REAL Explorations in Chemistry

» Mark Blaser, Chris Mead, Bayli Gray, Ethan Chang, Kim Larson,
Joe Tamer, Ariel Anbar, David Yaron, Kathryn Rico, Miasha
Brunkhorst, Melanie Narish, Richard Hines

Q&A Session (S136)
» kim woodrum

S47: Beyond Confirmatory Experiences: Teaching in the
Chemistry Laboratory

CP-222
Chaired by: David Styers-Barnett

Introduction (S47)
» Elinor Soult
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4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

Choose Your Own Adventure: Student Choice of Application
of Visible Light Absorbing Ruthenium Complexes as a Final
Project in Inorganic Chemistry Laboratory

» Robert Perkins

Synthesis of MAO-B Inhibitors and Analysis of Their Inhibition
Properties: A Medicinal Chemistry Research-Based
Laboratory for Undergraduates

» Vincent A. Sichula

Taking it on the Road: Labs as Outreach
» David Styers-Barnett, Brad Neal

Q&A Session (S47)
» kim woodrum

S114: Integrating Humanities into Chemistry Education
CP-287
Chaired by: Feier Hou

Introduction (S114)
» Feier Hou

Chemistry in the Kitchen: A new Capstone CURE at George
Mason University

» Rebecca Jones

A Glass and Ceramic Laboratory for an Art Focused Chemistry
Class

» Sarah Pierce

Can Art Make Science More Personal?
» Maria Gallardo-Williams

Q&A (S114)
» Feier Hou
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3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

$228: Multilingual Learners in Chemistry
CP-297
Chaired by: Julia Chamberlain

Introduction (S228)
» Julia Chamberlain

Multilingual college students’ identity construction in STEM
learning environments

» Minjung Ryu, Roshni Bano, Maggie Jeong O'Brien

College Multilingual Learners’ Use of Translanguaging in
Chemistry Learning Contexts

» Adeesha |ayathilaka, Fatima Ali, Maggie Jeong O'Brien, Minjung
Ryu

Panel Discussion (S228)

» Julia Chamberlain

S$174: Disrupting Grading
JSB-121
Chaired by: Clarissa Sorensen-Unruh and Renée Link

Introduction (S174)
» April French

Proficiency Instead of Partial Credit: Implementation of
Specifications Grading in an Organic Chemistry Course

» Matthew DeMatteo

Lessons Learned using Specifications Grading in Organic
Chemistry Courses

» Joseph Simard, Samuel Touchette

How Student Buy-In to Specifications Grading Changes Across
Semesters

» William Howitz
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4:54pm

3:45pm

3:45pm

3:50pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

Discussion (S174)
» kim woodrum

$124: George R. Hague Memorial AP/IB Chemistry Symposium
JSB-203
Chaired by: Alice Putti

Introduction (S124)
» Elinor Soult

Summary of Student Successes and Challenges on the 2024
AP Chemistry Exam

» Kyle Beran, Jamie Benigna

S37: Chemistry Education Research: Undergraduate Student
Research Symposium

JSB-213
Chaired by: Julie Donnelly and Nicole Lapeyrouse

Introduction (S37)
» Elinor Soult

Investigating Student Perceptions of Learning in the Flipped
Biochemistry Course

» Lacey Sharman, Amanda Chee-Awai, Tamra Legron-Rodriguez

Exploring Students’ Perceived Engagement in a Flipped-
Classroom Biochemistry Course

» Amanda Chee-Awai, Lacey Sharman, Tamra Legron-Rodriguez

Exploring Student Reasoning When Translating Between
Dash-Wedge Diagrams and Chair Conformations

» Amala Jones

Examining the effectiveness of student-created instructional
videos in an Organic Chemistry lecture course

» Hunter Roadhouse, Maximus Schultz, Ashley Steelman, Jennifer
Osterhage
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3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

6pm

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (S267)
» Elinor Soult

How Does Peer-Review Affect Students’ Epistemic
Engagement in Selecting Between Alternative
Explanations?00

» John Zhou, Alena Moon

An Analytical Framework to Identify the Influence of Power
Dynamics on Students’ Organic Chemistry Learning

» Chinwendu Igboekulie, Ira Caspari-Gnann

The Role of Affect in Learning: Understanding how
motivation can impact instructional interventions

» Allison Tomczyk, Mira Beranek, Kristen Murphy

Panel Discussion (S267)
» kim woodrum

Writing equitable assessments: Strategies for chemistry
educators and chemistry education researchers to construct
more accessible and inclusive assessments

JSB-108
Chaired by: Eshani Lee

Writing equitable assessments: Strategies for chemistry
educators and chemistry education researchers to construct
more accessible and inclusive assessments

» Eshani Lee, Jack Barbera, Anna Eunji Kim

Poster Session 3
Gatton Student Center, 2nd floor
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Utilizing Eye-Tracking Technology to Identify and Quantify
Different Knowledge Levels that Students Have of The
Periodic Table of the Elements

» Victor Okuo, Stephen Testa

Undergraduate chemistry students definitions of success:
Supporting factors

» Nhan Nguyen, Marina Tanizawa, Siobhan Wills, Tyler Kinner,
MaryKay Orgill

New Course Design of "Safety and Quality of Fermentation
Chemistry"

» Xiaoping Li

Fostering Scientific Writing Skills Through Interactive
Learning: A Scaffolded Approach

» Grace Murray, Michelle Morgan, Emma Johnson, Eugene
Wagner

Can Online Chemistry Laboratories Be Effective?
» Carla Karen Fortune

Using Digital Notebooks in a Second Semester Laboratory
» Robert Grimminger

Dyeing to Learn Kinetics
» Kristen Fulfer, Kai Oddo, Erin Wacther

Specifications Grading in Survey of Chemistry I: Impacts on
Grades, Content Knowledge, and Student Attitudes

» Lori Wilson, Theresa Butori, Ana Rumbao, Myles Sedgwick,
Kaylee Todd, Irene Kokkala

Benevolent Grading
» Sarah Shoemaker

Cooperative Organic Chemistry Manual: A Practical Guide to
Sustainable Practices

» Menggi Zhang, Elizabeth Day, Melanie Cooper
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Incorporating Green Chemistry in the Undergraduate Organic
Chemistry Laboratory Curriculum and in Student Research
Projects

» Ashley Bartelson

Active Learning to Explore Periodic Trends at Madison College
» Christine Hustmyer, Christen Smith

Using a Deliberation Module in Introductory Chemistry
Courses to Encourage Learning, Communication, and Civic
Skills at 2- and 4-Year Colleges

» Sara Drury, Amanda Nienow, Jessica Imholte, Reni Joseph, Laura
Wysocki, Katherine Knobloch, Pamela Conners

Student-centered Instructional Practices Identified from the
Syllabus are Associated with more Positive Student
Perceptions of their Instructors’ Mindset, Particularly for
Vulnerable Student Populations in STEM

» Ronia Kattoum, Cole Dwyer, Mark Baillie

The Current State of Literature on the Education of Blind and
Visually Impaired (BVI) Students in Chemistry

» larah Nelson, Erin Saitta

PR-SPRINT: to engage the new generation of explorers
» Maria Gil, Liz Diaz, Eduardo Nicolau

Capturing GTAs Authentic Use of UDL-Aligned Practices in
University Chemistry Labs

» Sloan Berry, Kathleen Lugo Charriez, Julia Willison, Erin Scanlon,
Jacquelyn Chini, Erin Saitta

Chemistry is Everywhere: Analyzing Student Responses to a
General Chemistry | Homework Assignment for Additional
Explanations and the use of Scientific Language

» Elizabeth Rodriguez, Ariel E. Vaughn
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Implementing an Anonymized and Scaffolded Search at A
Primarily Undergraduate Institution

» Barbara Reisner, Donna Amenta, Christopher Berndsen, Daniel
Blumling, Kevin Caran, Thomas DeVore, Jill Hagmaier, Christine
Hughey, Qingsheng Liu, Isaiah Sumner, Linette Watkins

Inclusive Excellence in STEM: Illinois College AERO-STEM's
Collaborative Path to Success

» Jocelyn Lanorio

From the Desktop to the Benchtop: Making Data and Lab
Tools Accessible to All

» Emily Alonzo, Travis Lato, Levi Garza, Mayte Gonzalez, Bryan
Shaw

Fostering an Inclusive and Active Learning Environment in
Introductory Chemistry to Improve Student Success in STEM
at a Hispanic Serving Institution

» Betzaida Castillo, Wilson Gonzalez-Espada, Josee Védrine-
Pauléus, Lilliam Casillas

Improving Accessibility for Students with Blindness and Low
Vision in the Organic Chemistry Teaching Laboratory

» Roxane Jourdain, Levi Garza, Bryan Shaw

Instructional Lab Videos: Increasing Engagement and Making
the Most of Lab Time

» Adam Kleman

Analyzing Instructor Feedback During Active Learning
Knowledge Construction: Considering the Tensions Between
Ideological and Pragmatic Priorities

» Ryleigh Porter, Amy Phelps, Gregory Rushton, Aspen Malone,

Joshua Reid, Shaghayegh Fateh, ZUBEYDE DEMET KIRBULUT
GUNES

An Experience with Using Alternative Assessments in a
Second Semester General, Organic and Biological Chemistry
(GOB) Course

» Vivian Mativo
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Sequestration of Pb2+ from aqueous solution using bio-
based-alkaline modified sorbent from waste Irvingia
gabonensis seed husk

» Hillary Abugu

Introduction to the Chemistry of Materials: a sustainability-
themed general education course

» Jennifer Mihalick

Building civic engagement and understanding in chemistry
classes with the C-SPAN Archives

» William Donovan, Andrea Langrish

Rebuilding Online Introductory Chemistry Curriculum:
Building Community, Metacognition, and Self-Confidence in
Our Students

» Rebecca Laird

Evaluation of a low barrier supplemental instruction
program: Mindset, self-efficacy, metacognition, and
performance of general chemistry students

» Summer Bouillon, Hannah Sturtevant

An Empathetic Face to Failure: What Does Failure Mean in
Chemistry Laboratories

» Shauna Schechtel, Amanda Bongers

Forensic Chemistry - Establishing a Forensic Track at
Georgetown College

» Todd Hamilton

Factors within an Introductory Course that Influence
Students’ Perception of Chemistry

» Oluwatobi Odeleye, Courtney Glenn

Integrating Campus Sustainability Activities and their
Assessment into the First-Year Engineering Curriculum

» |ulio Teran
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Comparison of qNMR and Enzyme Methods for the
Determination of Ethanol in a Non-alcoholic Beer: An
Example of Method Validation

» Jessica Bluitt, Elisa Woolridge, Neil Fitzgerald

A system-orientated concept map extension (SOCME) for
sulfuric acid

» Craig |. Donahue, Faith Culp, Lauryn Hoover, Devin Nagy

Chemistry for a sustainable future: An international NSF
Research Experience for Undergraduates (REU) in the United
Kingdom

» Anne Glenn, Norman Chiu, Terence Nile

Querying ISSAQ Data for Insights into Student Potential for
Success in General Chemistry |

» Brittany Long, Oscar |udd, Daniel Blumling

ACS' PrepareCTP Seed Grant - A pilot grant program for
Community College-Industry Partnerships

» John-David R. Rocha

A pragmatic approach to using generative Al in chemistry lab
writing
» Tim Doherty

Photoacoustic Experiment using Smartphones and LEGO
» Han Park, Jordan Taylor

Evaluating Chemistry Achievement and Persistence through
Student Science and Math Motivation and Sense of Belonging
» Emily E. Hardy, Tony Perez, Arianna White-Levatich, Melissa
Colangelo, David Courson, Chris Freeman, Lisa Linnenbrink-
Garcia

Mentoring the United States Chemistry Olympiad Team:
Professional Development for High School and College
Faculty

» Esther Hines, Joseph Houck, Laura Serbulea, Songwen Xie
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7pm

Poster Session 4
Gatton Student Center, 2nd floor

Undergraduate chemistry students definitions of success:
Barriers and mitigation strategies

» Marina Tanizawa, Nhan Nguyen, Tyler Kinner, Siobhan Wills,
MaryKay Orgill

Integration of Inquiry-Based Hands-On Activities in a Physical
Science Course for Education Majors

» John Trombley

“l was reading what | didn't know": a qualitative study of how
students approach reading in a college-level introductory
chemistry class

» Leah Johnson, Fatoumata Diawara, Anja Blecking

STEMulate the vote: Strategies to improve chemistry student
engagement in democracy

» Bridget Trogden

Teaching the non-controversy: Using critical thinking in a
non-majors class on the chemistry of climate change

» Christopher Dunlap

The Elements of a Chemistry Program
» Ray Dudek

NSF Programs that Support Chemistry Education
» Jennifer Lewis, Kalyn Owens, Dawn Rickey

Enhancing STEM Student Preparedness: A Holistic Approach
» Richard Boniak, Ami Johanson, Michelle Korir, Chetna Patel

Development of entrepreneurial skills in the production of
rose water in the undergraduate chemistry laboratory

» Sangeeta Kumar, Viniti Gupta, Neha Kamal, Manisha Nigam
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Capitalizing on Curiousity: Putting Chemistry on Display
» David Kiely, Amy Phelps

Harry Potter: The Science Behind the Magic
» Olivia Owens

Reactive Intermediates in Organic Chemistry Education:
Results of a National Survey

» Teresa Gibbons, Sachin Nedungadi

Unlocking Excellence: 3-D Models as the Key to Pre-Class
Mastery

» Michelle Nelson, Olivia Crandell

Development of an Organic Chemistry Laboratory Course for
Biological Sciences Majors

» Satya Dulam, Juliana Lessa Sacoman

Innovations in Chemical Education: Developing New Labs and
Revamping Old Classics in Physical Chemistry labs

» Lauren Woods, Michael Murphy, Jay Foley, Jessica White

Embedding Information Literacy Practices in an Upper
Division Chemistry Lab Class at a University in the United
States of America

» Christopher Randles, Matilynn Lam, Katy Miller

Escape the Chemistry Lab! (an escape room experience)
» Breeyawn Lybbert

Directing Group Patterns Exhibited by (Halomethyl)benzenes
in Electrophilic Aromatic Nitration Reactions

» Nathan Hazel, Noel Paul

A colorful liquid-liquid extraction experiment for the Organic
Chemistry laboratory

» JOSe JuNcosa
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Theory in practice: Iterative design of an introductory, large-
enrollment organic chemistry laboratory

» Kason |. Glover, John P. Wolfe

The Muti-Step Synthesis of a Nicotine Analog in an Organic
Chemistry Il Laboratory Course

» Perry Corbin, Robert Bergosh

Alternative Assessments of Spatial Reasoning and
Mechanisms using Models in the Organic Chemistry
Classroom

» Anna Sigmon

HELP or WELP? Using Multiple Metrics to Categorize Students
Based on Effort and Performance

» Rachel Doughty, Olivia Crandell, Xavier Prat-Resina

There's Always Bloom for Improvement: A Metacognitive
Approach to Redesigning Student Assessments within
CANVAS

» Amanda Hughes

Engaging students outside the classroom in popup
workshops

» Angie Spencer

Women's gender stigma consciousness when communicating
about NMR spectra

» Alex Browning, Ally Parvin, Megan Connor

Increasing Success of STEM Students through Cohort
Building, Mentoring and Career Discerning Experiences: An
NSF SSTEM Project

» Lori Watson, Michael Deibel

The Perceptions of Participants and Volunteers Before and
After a STEM Outreach Event for Middle School Girls

» Mary Fennimore
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Fostering STEM Interest Through Chemistry Connections with
the Community

» Dilani Koswatta, PhD., Carmen Velez, PhD

Middle Grades in the Mix - STEM Outreach in North Louisiana
» William Deese, Kristie Ruddick, Cathi Cox-Boniol, Missy Wooley

Science For Everybody - Concordia Science Academy
» Graeme Wyllie

Outreach resources for science engagement and education:
this is the mission of the ACS Committee on Community
Activities

» Lori Stepan

Cutting edge science research being used in elementary
school classrooms, the | bet you didn't know project

» Dudley Shallcross, Alison Trew

Explore how Undergraduate Teaching Experiences Shape
Students’ Career Goals in a Primarily Undergraduate
Institution

» Dihua (Victoria) Xue

ChatGPT vs Students: Who wrote it better?
» Morgan Clark, Micke Reynders, Thomas Holme

Chemical safety and security education: laboratory
personnel views

» Rethabile Tekane, Francinah Futhane, Kgadi Mathabathe

Safety is Essential: An Analysis of Teachers' Safety Culture
» Lydia Richardson, Dawn Del Carlo

3-Dimensional Learning and Assessments in the Context of
Analytical Chemistry

» Amanda Buchberger, Kimberly DeGlopper, Kyoung-Shin Choi,
Robert Hamers, Lloyd M. Smith, Ryan Stowe
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Exploring Interdisciplinary Knowledge Integration using
Systems Thinking and Mechanistic Reasoning frameworks

» Vinutha Ravinageswaran, Maria Oliver-Hoyo

Bridging Between General and Organic Chemistry with
Solubility and The Scientific Method

» Sarah |oiner

Implementing High-Impact Activities Aimed at Metacognitive
Development into a Two-Semester Organic Chemistry Course

» Matthew Siebert

Solvatochromism and Preferential Solvation in Binary
Mixtures

» Bret Findley

Fool Around and Find Out: Using Microwave Generated
Plasma as a Source of Undergraduate Research Topics

» Julia Buccola, Eugene McGough, Eniko Szabad, Samuel Williams,
George Harakas, Shawn Huston

<The Dirac | Notation Game>
» Trilisa Perrine

Introducing Python and Jupyter Notebooks a First Semester
Physical Chemistry Course

» Amanda Nienow, Caden Gunnarson

A system-orientated concept map extension (SOCME) for
primary aluminum production

» Craig |. Donahue, Aaron Engelhardt, Tyler Stewart, Noah Zain

Supporting Our Students: Utilizing Google Apps to Work
Smarter Not Harder

» |essica Imholte
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Continued from Tuesday, 30 July

Wednesday, 31 july

7am

8am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

Breakfast
Champions Kitchen, inside Gatton Student Center

Workshop and Demo Prep
JSB-258

$303: Teaching Chemical Safety In The Classroom/Laboratory
CP-103
Chaired by: Steven Wietstock

Introduction (S303)
» Steven Wietstock

Resources for Teaching Safety in the Classroom and
Laboratory

» Steven Wietstock

Introducing RAMP in General Chemistry Laboratory Through
An Asynchronous Online Curriculum

» Chad Rezsnyak, Olivia Furr

The General Chemistry Lab as a Launchpad for a Culture of
Safety

» Kaitlyn Connelly

Safety and Laboratory Techniques for Introductory
Chemistry

» Deborah Rosenthal

S$275: Integrating Forensic Science Courses Into the Curriculum
and Growing Forensic Science Programs

CP-111
Chaired by: David Cunningham
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Continued from Wednesday, 31 July 9:18am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

Introduction (S275)
» David Cunningham

Teaching Forensic Chemistry at Alabama State University
» Harvey Hou

Forensics Summer Camp - A Week-long Journey from Crime
Scene to Court Case

» Laura Walther

Let’s Solve It: Designing an Interactive and Engaging Online
Forensic Science Laboratory Course

» Gina Londino-Smolar

Establishing a Forensics Program: Bridging Academia and
Investigative Practice

» Michael Ward, Davy Jones, Isabel Mellon

S59: Engaging Students & Curriculum Development in Large
Classes

CP-153
Chaired by: Alicia Paterno

Introduction (S59)
» Elinor Soult

Connecting the Dots: Investigating the Relationship Between
Self-Concept, Social Belonging, Academic Mindset, and
Imposter Syndrome and Student Performance in General
Chemistry

» Vanessa Bustamante

Examining the Relationship Between Motivation and Course
Performance for Transfer Students in a PLTL General
Chemistry Classroom

» Jacob McAlpin, Jennifer Lewis
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9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

Understanding Student Attitudes and Topic Confidence in a
Series of Novel BIO-Focused General Chemistry Courses

» Candis Aiken, Debra Mlsna

Addressing Academic Challenges: A Drill Session Initiative in
General Chemistry |

» Eric Eitrheim, Amanda Waters

S84: Active Learning in Organic Chemistry
CP-155
Chaired by: Cathy Welder and Danielle Jacobs

Introduction (S84)
» Danielle Jacobs

Flipped Classroom for Implementation of Higher Complexity
Problem-Solving Sessions in Organic Chemistry

» Marwa Abdel Latif

Measuring the Effectiveness of a Flipped Classroom on
Higher-Order Learning Objectives

» Matt Casselman

A Data-Driven Exploration of Substituent Directing Effects in
Organic Chemistry

» Stuart Moon, Rebecca Broyer

Adding In-Class Learning Checks to Improve the Quality of
Pre-Class Learning in Flipped Classrooms

» Doug Schirch

$76: Mixing It Up With Informal Chemistry Education: An
Unconventional Chemistry Circus - Where Formal Meets Fun!

CP-183
Chaired by: Matt Queen

Introduction (S76)
» Matt Queen
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Continued from Wednesday, 31 July 9:39am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

Chemistry Under The Big Top; ACES Put Chemistry Center
Stage

» Matt Queen, Amanda Obery

Informal chemistry education and rockets: Using a novel
online source to connect chemistry to science events

» Kathleen Holley, John Galloway

The Big Blue Demo Crew: Informal science education
outreach through student demonstration shows

» Kathleen Holley

"10 Cent" Demos for General Chemistry
» Laura Prescott

$131: Engaging Students using the Chemistry of Beverage
Alcohol

CP-201
Chaired by: Leonard Demoranville and Kameyo Johnson

Introduction (S131)
» April French

An Honors Program Course: The Chemistry of Beer and
Brewing

» Benjamin Shepler, Derek Behmke

An Integrated Team-Taught Undergraduate Fermentation
Science Course to Promote the Interconnectedness of
Chemistry and Biology

» Kyle Schnitzenbaumer, Paul Duffin

Teaching GOB Sequence in the Context of Applied Beverage

Chemistry
» chelsea gustafson, Jenette L. Anderson
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8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

Integration of Chemical Concepts into General Education and
Upper Division Fermentation Science Courses

» Cory Emal, Taylor Heckaman, Gregg Wilmes

$252: Connecting Course Based and Traditional Research
Experiences

CP-208
Chaired by: William Carroll

Introduction ($252)
» Elinor Soult

Integrating Research and Education Through the Chemistry
Lab Curriculum

» William Carroll, Edward Lisic

The Effects of Silver Nanoparticles on Plants: An
Interdisciplinary Course-Based Undergraduate Research
Experience (CURE)

» Emma Downs, Erin Rehrig, Catherine Buell

The Power of Undergraduate Research Experiences in
Students’ Performance, Motivation, and Belonging.

» lllya Medina Velo, Curtis Henderson

Connecting New First-Year and Transfer Students to Research
at a Large R1 University through CUREs

» Whitney Duim

S$40: Communities of Practice Transforming Chemistry
Education

CP-211
Chaired by: Jeffrey Raker

Introduction (S40)
» Elinor Soult

Chemistry Communities of Practice as Agents of Change in
Chemistry Education

» Joanne Stewart
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8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

Intentionality in Fostering Social Cohesion of STEM Faculty
through a Community of Practice around Evidence-Based
Instructional Practices

» Lundon Pinneo, Stephanie Feola, Ronia Kattoum, Michael
Moore, Mark Baillie

Using Social Network Analysis to Explore Co-authorship of
Curricular Materials: Insight into the IONiC Community of
Practice

» Stephanie Frost, Jeffrey Raker, Anne Bentley, Shirley Lin, Justin
Pratt, Barbara Reisner, Joanne Stewart

A Community of Practice to Promote Best Practices in
Teaching General Chemistry

» Joshua Darr, Sachin Nedungadi, John Conrad, Alan Gift, Dana
Richter-Egger, Andrew Miller, Nikae Perkinson, Edmund Tisko,
Christopher Moore

S75: Alternative Pathways in General Chemistry: Meeting the
Needs of Varied Student Populations

CP-220
Chaired by: Rebecca Ricciardo

Introduction (S75)
» Elinor Soult

Above and Beyond Active Learning: Designing a Student
Centered Learning Environment through Assignments that
Encourage Student Metacognition and Planning

» Christine Altinis-Kiraz, Mary Emenike, Marc Muniz

Decoding Trends: Study Habits' Impact on General Chemistry
Performance in Online Homework and Exams

» Max Wallace, Kristina Proctor

CHEM 1 Solutions: A Student Support Course
» Karissa Addamane
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8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

The CHEM+ Program: An Alternative Approach to Teaching
General Chemistry at Emory

» Antonio Brathwaite, Tracy McGill, Christopher Beck

S31: Current Research on the Undergraduate Chemistry
Laboratory

CP-222
Chaired by: Nikita Burrows

Introduction (S31)
» April French

Community-Based Science in Environmental Chemistry
Research

» Kamila Deavers, Ph.D

Exploring the Science Practices Across Introductory
Chemistry, Biology, and Physics Labs

» Norda Stephenson, Lina Dahlberg, Tra Huynh, Lukas Spring,
Katherine Hunter, Elayna Worline

Managing Complexity in Laboratory Learning: Latour’s
Circulating Chain of Reference

» Donald Wink, Mustafa Demirbuga, Jim Coombs, Robert Milligan

Exploring the Interactions and Relationships Between
Student Engagement in the Organic Chemistry Laboratory

» Devin Pontigon

S114: Integrating Humanities into Chemistry Education
CP-287
Chaired by: Feier Hou and Rebecca Jones

Introduction (S114)
» Feier Hou

Recreating Historical Chemical Advertisements Using
Material Safety Data Sheets

» Julian Silverman
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8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

The Historical Lens: A Textbook Agnostic Approach to General
Chemistry

» Benjamin Wicker

Creating an Interdisciplinary WWII-Era Science Course

» Joseph Mullins

Design, Implementation, and Reflections of a Hybrid
Chemical Communication - Scientific Obligations Course at
Ursinus College

» Ryan Walvoord

S42: Scaffolding and Assessing Professional Skills and Science
Practices in the Undergraduate Curriculum: Addressing the
2023 ACS Guidelines

CP-297
Chaired by: Regina Frey

Introduction (S42)
» Regina Frey

Introduction to the new ACS Guidelines for Scaffolding and
Assessing Professional Skills and Science Practices in the
Undergraduate Curriculum

» Michelle Brooks, Ashley Mahoney, Kimberley Frederick, Renée
Cole, Regina Frey

A Backward Design Approach to Scaffolding Professional
Skills in a Chemistry and Biochemistry Program

» Kelly Neiles, Daniel Chase

Using Explicit Instruction on the Nature of Science to
Improve Science Practices

» Geri Kerstiens, Anne Baranger, Michelle Douskey

Going Beyond Content Knowledge: Aligning Outcomes,
Activities, and Assessment That Promote Skill Development

» Renée Cole, Juliette Lantz, Suzanne Ruder
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8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

S271: Pedagogical Innovations for Upper Division Labs
JSB-103
Chaired by: Marie van Staveren and Steve Mang

Introduction (S271)
» Marie van Staveren

Ungraded Methods to Help Students Make Meaning During
Lab Time

» Marie van Staveren

Master Chemist: Inorganic Edition—Gamifying an
Intermediate Inorganic Laboratory Course

» Paula Mazzer

SuperLab-An Immersive Writing-Intensive Course Focused on
Developing Research Skills and Building Community

» Karen Brewer, Yang (Vanessa) Song

Undergraduate Chemistry Labs: The Student View
» Russ Pearson, Lorna MacKenzie

S$174: Disrupting Grading
JSB-121
Chaired by: Clarissa Sorensen-Unruh and Kristi Closser

Introduction (S174)
» April French

Ungrading as Emancipation: Theory and Practice
» Clarissa Sorensen-Unruh

Lessons in Ungrading Chemistry
» Beth Haas

Ungrading as a compassionate tool for retaining first-year
STEM students: lessons, improvements, and challenges in the
general chemistry classroom

» Sydnie Aysen, Damjan Benoit, Judy Chauvin, Theodore Alivio
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9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

Ungrading and student engagement
» Cynthia Woodbridge

$299: Artificial Intelligence in Chemistry Education
JSB-203
Chaired by: Mike Christiansen

Introduction (S299)
» Elinor Soult

Metacognitive Strategies in Chemistry Problem Solving: A
Response-and-Critique Approach with Al

» Elizabeth Yuriev, Betty Exintaris, Nilushi Karunaratne

Evaluating the Precision of Generative Al in Solving
Computational General Chemistry Problems

» Johnathan Broome, Kayla Stan

Modeling environmentally relevant chemical reactions with
machine learning

» Huichun (Judy) Zhang

Towards metrics to assess A.l.-driven rubric grading in
chemistry labs

» Dane DeSutter

§267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (S267)
» Elinor Soult
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8:57am

9:18am

9:39am

8:30am

8:30am

Investigating the Help-Seeking Behaviors of Undergraduate
Organic Chemistry Students: How do we create a community
of inquiry?

» Alison Anderson, Josie Nardo

"Oh, so there's a problem": How students manage
uncertainty when engaging in group argumentation

» Mary Tess Urbanek, Amelie Cole, Alena Moon

How Can | Help: Asking students about problems they face in
introductory chemistry courses

» Zephaniah Greenwell, Stephen Burgin

The Impact of Learning Assistant Facilitation Practices on
Student In-the-Moment Learning

» Nicolette Maggiore, Kataleeya Powers, Krystal Lwanga, Ira
Caspari-Gnann

Inventorying in-lab opportunities to engage in expert-like
thinking

JSB-108

Chaired by: Robin Stoodley

Inventorying in-lab opportunities to engage in expert-like
thinking

» Robin Stoodley

Introduction to Machine Learning in Chemistry using Python.
Part 1: Working with a data set and building a chemistry
machine learning model. Part 2: Building data sets and
cheminformatics models

JSB-114
Chaired by: Ashley McDonald

Introduction to Machine Learning in Chemistry using Python.
Part 1: Working with a data set and building a chemistry
machine learning model. Part 2: Building data sets and
cheminformatics models

» Ashley McDonald, Bonnie Hall, Mohammad Mostafanejad
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8:30am

8:30am

8:30am

8:30am

Writing Competitive Grant Proposals
JSB-221
Chaired by: Allegra Liberman-Martin

Writing Competitive Grant Proposals
» Joerg Schlatterer, Allegra Liberman-Martin

The POGIL Project Workshop: Classroom Facilitation
JSB-231
Chaired by: Laura Trout

The POGIL Project Workshop: Classroom Facilitation
» Laura Trout, Rodney Austin

From Seed to Tree: Integrating Racial, Social, and
Environmental Justice Principles into your Chemistry
Curriculum

JSB-243
Chaired by: Amanda Glass

From Seed to Tree: Integrating Racial, Social, and
Environmental Justice Principles into your Chemistry
Curriculum

» Amanda Glass, Kristy Wittman Howell

3D Printable Resources for Engaging Students in the
Exploration of Instrument Design and Performance:

Inexpensive and User-Friendly Instrument Kits for STEM

Educators
JSB-244
Chaired by: Lon Porter

3D Printable Resources for Engaging Students in the
Exploration of Instrument Design and Performance:

Inexpensive and User-Friendly Instrument Kits for STEM

Educators
» Lon Porter
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8:30am

8:30am

10am

10:15am

10:15am

Active Learning in Organic Chemistry: Improve student learning
and engagement with formative assessment and collaborative
learning

JSB-337
Chaired by: Justin Houseknecht

Active Learning in Organic Chemistry: Improve student
learning and engagement with formative assessment and
collaborative learning

» Justin Houseknecht, Janell Mahoney

Transitioning from Excel to Python for Chemistry Lab Data
Analysis

JSB-347
Chaired by: Prajay Patel

Transitioning from Excel to Python for Chemistry Lab Data
Analysis

» Prajay Patel

Integrating Open Educational Resources (OER) into the
Chemistry Curriculum with OpenStax and Aktiv Chemistry

JSB-357
Chaired by: Justin Weinberg

Integrating Open Educational Resources (OER) into the
Chemistry Curriculum with OpenStax and Aktiv Chemistry

» Justin Weinberg, David Harris
Break

S204: Innovations, Practices, and Challenges in Large
Enrollment Laboratory Courses

CP-103
Chaired by: Katie Gesmundo

Introduction (5204)
» Katie Gesmundo
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How Much Does Lab Matter? Effect of Lab Enrolilment on DFW

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

Rates in a General Chemistry Lecture Course
» Margaret Hershberger

Applications of Water Treatment in a Large Enrollment
General Chemistry Laboratory Course

» Daphne Norton

Improving Student Confidence in General Chemistry Labs
Through Skill Check-Ins (SCls)

» Nolan Shepherd, Keying Chen, Binyomin Abrams

Writing a Laboratory Report in Parts Instead of a Complete
Assignment

» Sara Mata

$275: Integrating Forensic Science Courses Into the Curriculum

and Growing Forensic Science Programs
CP-111
Chaired by: David Cunningham

Introduction (S275)
» David Cunningham

Challenges and Opportunities Facing a Forensic Science
Program at a Regional University

» David Cunningham, Jim McGill

Design and Development of Discipline-based Growth Mindset
and Effective Learning Strategies Modules in Gateway
Chemistry Courses

» Li Ye, Julia Y.K. Chan, Coby Zadeh, Natalia Morales, Osvaldo
Rojas, Emily Pak

Q&A Session (5275)
» kim woodrum
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11:24am

10:15am

10:15am

10:21am

10:42am

11:03am

11:24am

10:15am

10:15am

10:21am

Panel Discussion (S275)
» kim woodrum

$164: Inside the Division of Chemical Education
CP-139
Chaired by: Stephanie Ryan and Resa Kelly

Introduction (S164)
» Stephanie Ryan

Financial Structure of DivCHED and the Finance Committee
» Rick Moog

Meet the Committee on Computers in Chemistry Education

» Derek Behmke, Robert Belford, Ehren Bucholtz, Carla Karen
Fortune, Jonathan Gutow

Chemical Safety in the Classroom: The Role of the DivCHED
Safety Committee

» Steven Wietstock, Jenine Maeyer

ACS DivCHED New Member Committee
» Mary Beth Anzovino

$59: Engaging Students & Curriculum Development in Large
Classes

CP-153
Chaired by: Alicia Paterno

Introduction (S59)
» Alicia Paterno

Metacognitive Reporting Promotes Student Success and
Instructor Beneficence in Introductory Chemistry

» Michelle Richards-Babb, Carly Gordon, David Mersing, Trina
Perrone, Betsy Ratcliff
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10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

Informative Utility Value Intervention: Assignments Designed
to Promote Students’ Personal Connections With Chemistry

» Jessica Young, Lisa Dawood, Scott Lewis

The Power of Scaffolding in Instruction: Using Multi-Mode
Student Interviews to Understand Learning Gains and
Changes in Scale Literacy

» Allison Tomczyk, Kristen Murphy

Q&A Session (S59)
» kim woodrum

S84: Active Learning in Organic Chemistry
CP-155
Chaired by: Cathy Welder and Danielle Jacobs

Introduction (S84)
» Danielle Jacobs

Using Active Learning Techniques to Foster a Growth Mindset
in Organic Chemistry

» Jennifer Chaytor

Effects of a Flipped Classroom Model on Perceived Stress,
Anxiety, and Preparedness of Students in a First Semester
Organic Chemistry Course

» Leslie Knecht, Francesca Pellegrini, Claire Landon, Aaron Heller

Transitioning From a Lecture-Centric Format to Partially
Flipped and Then Fully Flipped Formats for Organic
Chemistry at a Small Liberal Arts College

» lan Rhile

Q&A Session (S84)
» kim woodrum
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10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:21am

S244: Research Investigations in STEM Identity in Chemistry
Learning Environments

CP-179
Chaired by: Justin Carmel

Introduction (5244)
» Justin Carmel

Recognition Experiences and Chemistry Identity of Women of
Color

» Norda Stephenson, Ursula Abelsen

The Impacts of a Nuclear Science Internship Program on
Students’ Identity Construction, Self-Efficacy, and Career
Aspiration

» Kiera Wright, Resa Kelly

Application of the PISQ-5d survey: Comparing and
contrasting written responses of PISQ-5d questions based on
STEM Identity

» Cameron Bechard, Abigail Castillo, Jackson Ellis, Tamra Legron-
Rodriguez, Nicole Lapeyrouse

Undergraduate students’ self-perception regarding their
STEM professional futures

» Macayla Barnett, Cameron Bechard, Tamara Legron-Rodriguez,
Nicole Lapeyrouse

S76: Mixing It Up With Informal Chemistry Education: An
Unconventional Chemistry Circus - Where Formal Meets Fun!

CP-183

Introduction (S76)
» Matt Queen

Chemistry Under The Big Top
» Matt Queen
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10:42am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

The Chemistry and Technique of Formulating Organic Incense
in an Undergraduate Chemistry Laboratory

» Viniti Gupta, Sangeeta Kumar, Manisha Nigam

$131: Engaging Students using the Chemistry of Beverage
Alcohol

CP-201
Chaired by: Leonard Demoranville

Introduction (S131)
» April French

Brewing up a Program: The Development and
Implementation of an Undergraduate Major in Fermentation
Science at Eastern Michigan University

» Gregg Wilmes, Taylor Heckaman, Cory Emal

Craft Beverage Curriculum - A Duel Track Design
» Christian Paumi

From Beer to Boerewors: The First 10 Years of a Fermentation
Sciences Program

» Brett Taubman

The Chemistry of Food and Drink Across the World
» Luanne Tilstra, Fumie Sunahori

$138: Course-based Undergraduate Research Experiences
(CUREs): Assessments, Barriers and Opportunities

CP-208
Chaired by: Diana Habel-Rodriguez and Tracy Terry

Introduction (S138)
» Elinor Soult
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10:21am

10:42am

11:03am

11:24am

10:15am

10:15am

10:21am

10:42am

11:03am

Longitudinal Comparison of the Development of a Sense of
Belonging and Science Identity for Workshop-Based
Undergraduate Research Experience Students and
Traditional Lab Students

» Adrian Wierzchowski, Donald Wink

Expanding Course-Based Undergraduate Research
Experiences

» Timothy Schroeder

Design of Vertical CUREs in Organic Chemistry with
Assessments, Challenges, and Opportunities

» Marwa Abdel Latif

Exploring the Effects of Course-Based Undergraduate
Research Experiences (CUREs) on STEM Students with an
Emphasis on Chemistry Majors: A Qualitative Analysis of
Critical Reflections

» Mahdi Ghasemi, Abigail Dingess, Chazzidy Harper, Amy Buddie,
Kimberly Cortes

S40: Communities of Practice Transforming Chemistry
Education

CP-211
Chaired by: Jeffrey Raker

Introduction (S40)
» Elinor Soult

Constructing an Assessment Data-Driven Inquiry Community
of Practice for General Chemistry Instructors

» Casandra Koevoets-Beach, Morgan Balabanoff

A Promising Role for Communities of Practice to Promote
Social Interactions Associated with Chemistry Faculty
Members’ Adoption of Evidence-Based Instructional Practices

» Megan Connor, Jeffrey Raker
Faculty Influence on Transforming Chemistry Doctoral

Education
» Melissa A. Collini, Benedicta Donkor, Jordan Harshman
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11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

Lessons from a Cohort-Based Professional Development
Workshop on Improving Chemistry Faculty Members
Assessment Practices

» |effrey Raker, Thomas Pentecost, Kristen Murphy

S75: Alternative Pathways in General Chemistry: Meeting the
Needs of Varied Student Populations

CP-220
Chaired by: Rebecca Ricciardo and Kristina Proctor

Introduction (S75)
» Elinor Soult

Enhancing Student Success in General Chemistry with a
Focus on Diverse Approaches to Learning and Metacognitive
Skill Development.

» Clarice Kelleher, Alexsa Silva, Benjamin Turnpenny

Meeting Students where they are - Expanding Traditional
Support for Chemistry Learners

» Anja Blecking, Leah Johnson, Barbara Lucius, Tania Mertzman

Understanding the Impacts of a General Chemistry Adjunct
Course Through a Mixed-Methods Approach

» Abigail Hinojosa, Debjani Roy, Deseree Dufek, Charles Floyd,
Jake Barer, Anne Baranger

Parachute’: Can a Rescue Course for High Failure
Introductory STEM Courses Improve Student Retention?

» Sushilla Knottenbelt, K Joseph Ho, Alisha Ray

S31: Current Research on the Undergraduate Chemistry
Laboratory

CP-222
Chaired by: Nikita Burrows
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10:15am

10:217am

10:42am

11:03am

10:15am

10:15am

10:217am

10:42am

11:03am

Introduction (S31)
» April French

Chemistry Identity and Perceptions of Science Practice
Proficiency in Introductory Chemistry Labs

» Deborah Santos, Riona Soosaidas, Morgan Polk, Ryan Wiebold

Characterizing Laboratory Experiments used in
Undergraduate Analytical Chemistry Courses for
Opportunities of Engagement in Science Practices and
Inquiry

» Andrea Van Wyk, Ardith Bhinu, Kimberley Frederick, Marya
Lieberman, Renée Cole

Shifts in Chemical Thinking in Labs?!? The Role of Social
Interactions and Simulations

» Julia Eckhard, Ira Caspari-Gnann

S57: Art and Archaeology as a Vehicle to Teach Core Chemical
Concepts

CP-287
Chaired by: Kevin Braun

Introduction (S57)
» Kevin Braun, Kristin Labby, Annelise Gorensek-Benitez

Conservation science as a tool to enhance student learning

» Joan Esson

From Pigments to X-Rays: Exploring Chemistry and Art in an
Interdisciplinary Classroom

» Amanda Bowman

Ancient Art and Archaeology as Part of an Introductory
Chemistry Course

» Mary Virginia Orna, Patricia Smith
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11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

An Experimental and Case Studies Approach to Teaching
Chemical Principles Using Applications in Archaeology and
Art

» Christopher Vyhnal

S42: Scaffolding and Assessing Professional Skills and Science
Practices in the Undergraduate Curriculum: Addressing the
2023 ACS Guidelines

CP-297
Chaired by: Regina Frey

Introduction (S42)
» Regina Frey

SPIRAL Experiments: A Model for Intentionally Incorporating
Skills in the Laboratory

» Ashley Mahoney, Michael Garoutte, Craig Teague, Timothy
Herzog

Multidimensional Learning as a Framework for Achieving
Constructive Alignment in General Chemistry

» Sam Pazicni, Jaclyn Trate, Stephen Block

TEaMS-UR: Implementing Team Science and Professional
Skills into Organic Chemistry

» Evelyn Boyd, Joi Walker

A Career Development Model and Evaluative Toolkit in
Action: Impacting Undergraduate and Graduate Student
Professional Identity Development and IDP Use

» Corrie Kuniyoshi, Nancy Bakowski

S$271: Pedagogical Innovations for Upper Division Labs
JSB-103
Chaired by: Marie van Staveren
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10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

Introduction (5271)
» Marie van Staveren

Using In-Video Quizzes and Steps Recorder for Teaching
Instrument Use.

» David Peitz

The Chemistry of Color: An Advanced Capstone Lab
Experience

» Douglas Mulford

Designing the Undergraduate Integrated Lab Course for
Chemistry Majors to Incorporate Green Chemistry Principles:
Extraction and Purification of Lycopene from Tomatoes and
Investigation of Its Antioxidant Properties.

» Ajay Mallia

An Inorganic Lab Experiment Requiring Students to
Synthesize and Characterize a Transition Metal Compound
Without Any Instructor Direction

» B] Yoblinski

S$174: Disrupting Grading
JSB-121
Chaired by: Clarissa Sorensen-Unruh and Theodore Alivio

Introduction (S174)
» April French

Revitalizing Student Involvement in Post-Pandemic
Chemistry Classroom: The Role of Specifications Grading in
Large Introductory Chemistry Courses

» Shuai Sun

Outcomes from a (mostly) Department-wide Adoption of
Standards-Based Grading (SBG) and the CLUE Curriculum

» Dawn Del Carlo, Laura Strauss
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11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

11:03am

11:24am

10:15am

Standards-based grading in GenChem with LMS quizzes and
ALEKS

» John Farrar

Discussion (S174)
» kim woodrum

S74: Engaging Students in Physical Chemistry
JSB-213
Chaired by: Craig Teague

Introduction (S74)
» Craig Teague

Adding a CURE-Like Experience to the Physical Chemistry
Laboratory: Adsorption as a Flexible Framework

» Andrew DeJarnette, Michael McGuire, Britta Schwartz, Jacq
Vanoni, Kimberly Lawler-Sagarin

Honk if you passed P-Chem... and enjoyed it!
» Kelly Lancaster

A Mass Spectrometry Experiment on the Physical Chemistry
of Fragmentation

» David Keifer, Jose Juncosa

The myriad positive impacts of Smart Worksheets on
laboratory classes, quantitative chemistry methods and
physical chemistry courses

» Dudley Shallcross, Bill Heslop, lain Thistlethwaite

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge
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10:15am

10:21am

10:42am

11:03am

11:24am

10:15am

11:45am

2pm

2pm

Introduction (S267)
» Elinor Soult

Why Do They Do What They Do? The drivers of learning
assistant facilitation practices

» Nicolette Maggiore, Jessica Karch, Vesal Dini, Ira Caspari-Gnann

Reflective Practice of Undergraduate Learning Assistants
(ULAs) and Graduate Teaching Assistants (GTAs) Using the
Vitruvian Model of Reflective Practice (VMRP)

» Marjan Roshandel, Ethan Cote, Christopher Randles

Mindful Teaching: Identifying how graduate teaching
assistants support undergraduates’ metacognition in
introductory chemistry

» Leslie Bolda, Shaun Vecera, Renée Cole

Exploring the Nature of STEM Instructors’ Written Reflections
About Challenging Teaching Experiences

» Haleigh Machost, Emily Kable, Jherian Mitchell-Jones, Brandon
Yik, Marilyne Stains

Engaging Organic Chemistry Students Using an Effective Active-
Learning Approach

JSB-108
Chaired by: Barbara van Kuiken

Engaging Organic Chemistry Students Using an Effective
Active-Learning Approach

» Barbara van Kuiken
Lunch

S204: Innovations, Practices, and Challenges in Large
Enrollment Laboratory Courses

CP-103
Chaired by: Katie Gesmundo

Introduction (5204)
» Katie Gesmundo
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2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

Assessing Lab Skills in a Non-Majors' Organic Chemistry Lab:

Lessons Learned from Developing, Implementing, and
Evaluating a Digital Badge Assignment

» Geeta Govindarajoo, Mary Emenike

Mitigating Variations in Students' Learning Experience in
Large-Enrollment Organic Lab Courses

» Rachael Karugu

Streamlining Organic Chemistry Lab Report Grading for
Teaching Assistants Using Canvas Rubrics

» Ash Winkler, Christy Bagwill, Kelsey Schlund

Implementing hierarchical structures and leadership skills
for student workers

» Alan Chant

$103: Opportunities from AACT: Programs and Professional
Learning

CP-111
Chaired by: Jennifer Fees and Jeramy DeBry

Introduction (S103)
» lennifer Fees

Incorporating Science and Engineering Practices into
Classroom Activities

» Jeramy DeBry

The ChemClub Program
» Jennifer Fees, Dorothy Holley

Science Coaches Program
» Pradip Misra

Powered by Ex Ordo, everything you need to run a research conference.

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

Incorporating American Association of Chemistry Teachers
(AACT) multimedia resources into your chemistry curriculum

» Jeramy DeBry

$163: ChatGPT in the Classroom: Empowering Educators with Al
CP-114
Chaired by: Corey Beck

Introduction (S163)
» Elinor Soult

The Evolution of Technology in Education: Unraveling the
Potential of Artificial Intelligence

» Caleb Evans

Can't Fight the Machine: Using Generative Al in Upper-
Division Writing-Intensive Chemistry Courses

» Steve Mang

Innovative Integration of ChatGPT in Chemistry Education:
Designing Law and Order Style Lab for GOB Students

» Sara Drenkhahn-Weinaug

Illuminating Understanding: Leveraging Al to Clarify the
Muddiest Points in Large Classrooms

» Matt Stoltzfus

S$164: Inside the Division of Chemical Education
CP-139
Chaired by: Stephanie Ryan and Resa Kelly

Introduction (S164)
» Stephanie Ryan

Passer Award Committee Keeps Alive the Vision of Dorothy
and Moses Passer

» Daniel Albert, Niina Ronkainen
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2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

Taming Communication: CHED Public Relations Committee
» Clarissa Sorensen-Unruh

Life Before College
» Roxie Allen

Committee on Chemistry in Two-Year Colleges: Building
Community for First- and Second Year College Chemistry
Education

» Laura Anna, Kenneth Friedrich

S84: Active Learning in Organic Chemistry
CP-155
Chaired by: Cathy Welder and Vince Maloney

Introduction (S84)

» Vince Maloney

Beyond A-B-C-D: Opening Up New Possibilities for Clicker
Engagement in Organic Chemistry Using Nearpod

» John Milligan

First Few, Last Few: Engaging Students in Organic Chemistry

» Jenny Vu

Game Based Active Learning in Organic Chemistry
» Kristen Barrett

Teaching Organic Chemistry: Pushing the Limits With
Chemdraw-Direct

» Sreekumar Pankajakshan

S244: Research Investigations in STEM Identity in Chemistry
Learning Environments

CP-179
Chaired by: Justin Carmel
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2pm

2:06pm

2:27pm

2:48pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

Introduction (5244)
» Justin Carmel

"l Feel I Live Two Lives” - Transgender Chemistry Graduate
Students Navigating Tension Between Trans and STEM
Identities

» Michelle Nolan, Isaac Blythe, Paulette Vincent-Ruz

Navigating the hidden curriculum: Latine undergraduate
students’ science identity development

» Danielle Maxwell, Jorge Rivera-Colén, Paulette Vincent-Ruz,
Ginger Shultz

Structural Equation Model Predicting Undergraduate
Chemistry Student Science Career Choice from Scientific
Values, Identity, and Self-Efficacy

» Regis Komperda, Abel Sekone

$194: Trends in GOB Chemistry
CP-201
Chaired by: Corina Brown and Laura Frost

Introduction (5194)
» Corina Brown

“WDWC"” Why Do We Care?
» William Urban

Framing GOB chemistry content using medical case studies
» Steve Cessna

Exploring student (dis)connections between vocabulary and
particle-level representations

» Melody |ewell

GOB Chemistry topics: Beyond integration
» Corina Brown
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2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

$138: Course-based Undergraduate Research Experiences
(CURESs): Assessments, Barriers and Opportunities

CP-208
Chaired by: K Joseph Ho and Diana Habel-Rodriguez and Tracy Terry

Introduction (S138)
» Elinor Soult

Assessment and Grading Strategies for CUREs

» KJoseph Ho

CUREs in the Classroom and Laboratory at Alabama State
University

» Harvey Hou

Course-based Research Experiences for the High School
Curriculum: Navigating Barriers and Leveraging
Opportunities

» Tracy Terry

A Preliminary Report of a Community CURE Based on
Catechol Oxidases

» Kari Stone, Kyle Grice

$40: Communities of Practice Transforming Chemistry
Education

CP-211
Chaired by: Jeffrey Raker

Introduction (S40)
» Elinor Soult

Results of the 2021-23 Active Learning in Organic Chemistry
Workshops and Faculty Learning Communities

» Justin Houseknecht, Alexey Leontyev, Jennifer Muzyka, Cathy
Welder
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2:27pm

2:48pm

2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

Aurora University Noyce Program: Recruiting STEM Teachers
and Cultivating a Community

» Chetna Patel, Alma Rodriguez Estrada, Lindsey Hill, Aubrey
Southall

The Use of Al to Grade Open-Ended Questions in a Large
Enroliment Lab Course

» John Wiginton, Olivia Harwick, Jason Pearson

S75: Alternative Pathways in General Chemistry: Meeting the
Needs of Varied Student Populations

CP-220
Chaired by: Rebecca Ricciardo and Kristina Proctor

Introduction (S75)
» Elinor Soult

Implementing an Introductory Chemistry Course as a Tool for
Bridging the Knowledge Gap for General Chemistry

» Alicia Paterno

Design, Evolution, and Evaluation of a General Chemistry
Bridging Course
» Scott Reid

Student Preparedness for General Chemistry 1 Following a
Preparatory Course at Saint Louis University.

» Natalie R. Schleper

Alternative pathway to General Chemistry | at UTSA

» Blain Mamiya, Joyce Macalling, Hadi Arman, Mark Davidson,
Sarah Oerther

S31: Current Research on the Undergraduate Chemistry
Laboratory

CP-222
Chaired by: Nikita Burrows

Introduction (S31)
» April French
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2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

Chemistry Laboratory Creation Through Backward Design
Principles

» Kelly Neiles, Kimberley Frederick, Maury Howard, Daniel Scott,
Rebecca Hunter

Student Explanations of Chemical Reactions in Organic
Chemistry at the Macroscopic and Symbolic Levels

» Isaiah Nelsen, Scott Lewis

Revealing Students' Learning and Experience in a
Fluorescence Laboratory in General Chemistry

» Mustafa Demirbuga, Donald Wink

Climbing the Ladder: Vertical Integration of Lab Skills Badges
in the Curriculum

» Mary Ross, James Dunne

S57: Art and Archaeology as a Vehicle to Teach Core Chemical
Concepts

CP-287
Chaired by: Kevin Braun

Introduction (S57)
» Kevin Braun, Kristin Labby, Annelise Gorensek-Benitez

Integrating an Inquiry-Based Chemistry and Art Travel Course
for Non-Science Majors into the Liberal Arts Curriculum

» Christine Theodore

Developing intrapersonal, interpersonal, and creative
thinking skills through a first-year seminar style course on
the interrelationship between art and science

» Pamela Lundin

A Chemical Imaging Science Course at the Interface of Art,
Medicine, and Astronomy

» Erich Uffelman, Evan Robyns, Alyssa Cirrincione, Kelcie Comisac
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2pm

2pm

2:06pm

2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

Unraveling a museum textile mystery with ‘Chemistry of Art’
students

» Gregory Smith, Mark Vitha, Victor Chen, Amanda Holden

S72: Re-envisioning Grading and Assessments for Enhanced
Student’s Learning Experience

JSB-121
Chaired by: Marwa Abdel Latif

Introduction (S72)
» Marwa Abdel Latif

Alternative Grading Strategies in Organic Chemistry: A
Journey

» Matthew Mio

Student Perspectives on Two-Stage Collaborative Exams in
Introductory Chemistry

» Elizabeth McGinitie, Brian Rempel, James Kariuki, Hope
Zimmerman, Tyler Weenink, Mia Spreen

Reforming the Assessment Structure of an Introductory
Biochemistry Course: Nontraditional Grading for our Future
Healthcare Professionals Who Still Need Traditional Grades

» Didem Vardar Ulu

Ditch the Lab Reports! Adopt Digital Badges to Certify your
Students’ Lab Skill Mastery

» [sabelle Lagadic

S74: Engaging Students in Physical Chemistry
JSB-213
Chaired by: Craig Teague

Introduction (S74)
» Elinor Soult

Towards Authentic Laboratory Activities in Physical
Chemistry

» Kristi Closser
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2:27pm

2:48pm

3:09pm

2pm

2pm

2:06pm

2:27pm

2:48pm

2pm

Where does ambiguity end and certainty begin in the pursuit
of identifying an uknown artist pigment

» Samantha Glazier

Developing and utilizing Student-Generated Mathematica
Demonstrations in Physical and General Chemistry Courses

» Heidi Hendrickson, Theresa Chua, Vedit Venkatesh, Tracie Addy

The 2-D fluorescence playground
» David Gardner

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (S267)
» Elinor Soult

Grading With Artificial Intelligence in General Chemistry Lab |
» Olivia Harwick, John Wiginton, Jason Pearson

Exploring Experiences and Perspectives in the Chemistry
Community

» Devin Pontigon

Focus Group Discussions of Scientific Information Literacy in
Central Florida's K-12 Classrooms

» Matilynn Lam, Christopher Randles

Do we test what we want to test?: From learning outcomes to
an assessment plan to using assessment results to inform
classroom and programmatic targets

JSB-108
Chaired by: Jaclyn Trate
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2pm

2pm

2pm

2pm

Do we test what we want to test?: From learning outcomes to
an assessment plan to using assessment results to inform
classroom and programmatic targets

» laclyn Trate, Kristen Murphy, David Schreurs, Chrystal Bruce,
Thomas Pentecost, Melissa Reeves, Patricia Kreke, Olga Michels,
Sachin Nedungadi

The POGIL Project Workshop: Teaching computational
chemistry using Chemcompute

JSB-231
Chaired by: Melissa Reeves

The POGIL Project Workshop: Teaching computational
chemistry using Chemcompute

» Melissa Reeves, Laine Berghout

The POGIL Project Workshop: Development and
Implementation of Guided Inquiry Experiments for Physical
Chemistry

JSB-244
Chaired by: Rob Whitnell

The POGIL Project Workshop: Development and
Implementation of Guided Inquiry Experiments for Physical
Chemistry

» Rob Whitnell, Jordan Beck

OK I know about active learning but how do | do it?
JSB-337
Chaired by: Scott Donnelly

OK I know about active learning but how do I do it?
» Scott Donnelly, Michelle Brooks

Introduction to IONiC / VIPEr: Using and Sharing Inorganic
Chemistry Education Resources

JSB-347
Chaired by: Anne Bentley
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2pm

3:30pm

3:45pm

3:45pm

3:51pm

4:12pm

3:45pm

3:45pm

Introduction to IONiC / VIPEr: Using and Sharing Inorganic
Chemistry Education Resources

» Amanda Reig, Meghan Porter, Sarah Shaner, Catherine
McCusker, Anne Bentley

Enhancing Assessment of Student Learning in Your CURE
JSB-357
Chaired by: Erika Offerdahl

Enhancing Assessment of Student Learning in Your CURE
» Erika Offerdahl, Diane Ugwu

Break

S$204: Innovations, Practices, and Challenges in Large
Enrollment Laboratory Courses

CP-103
Chaired by: Katie Gesmundo

Introduction (S204)
» Katie Gesmundo

The Use of Al to Grade Open-Ended Questions in a Large
Enrolilment Lab Course

» John Wiginton, Olivia Harwick, Jason Pearson

Lab Teaching and Learning at Scale: Building Effective
Learning Experiences Using Technology Purpose-Built for
Large Lab Courses

» James Caras, Serenity Desmond, Marybeth Miller

$163: ChatGPT in the Classroom: Empowering Educators with Al

CP-114

Introduction (S163)
» Elinor Soult

Powered by Ex Ordo, everything you need to run a research conference.

4:12pm

3:45pm

3:45pm

3:51pm

4:12pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

Chemical Superpowers with Wolfram GPT

» Jason Sonnenberg

Generative Al in Chemistry Online Homework Systems
» |essica Moro, Chris Hess, Tim Wilson

S164: nside the Division of Chemical Education
CP-139

Introduction (S164)
» Stephanie Ryan

DivCHED Potpourri
» Kimberly Cortes

Q&A (S164)
» Stephanie Ryan

$231: Active Learning in the Organic Chemistry Laboratory
CP-153
Chaired by: Benjamin Burlingham

Introduction (5231)
» Sara Mata

Graduate Student Perspectives on Starting Up a New CURE

» Michaela Loveless, Amanda Morgan, Benjamin Burlingham,
Amar Flood

A sequence of linked experiments for teaching and
reinforcing laboratory techniques in undergraduate organic
lab courses

» Kasey Clear

Bring Paper Analytical Device to Organic Chemistry Lab:
Colorimetric Tests to Identify Substandard and Falsified
Drugs

» Zhutian Zhang, Rachel Roller, Katherine Barrett, Marya
Lieberman
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4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

Development and implementation of new laboratory
experiments for the organic chemistry course focused on the
synthesis of ferrocenyl derivatives

» Raul Rodriguez-Berrios, Uriel Rivera-Gonzalez, Ulises
Maldonado-Rivas, Guillermo Narvaez-Lozano, Ricardo Perez-
Martinez

S84: Active Learning in Organic Chemistry
CP-155
Chaired by: Cathy Welder and Vince Maloney

Introduction (S84)
» Vince Maloney

Active Learning Exercises With 3D Printed Space-Filling
Molecular Models

» Ava Rocio, Nicole Nolan, Jeremy Klosterman

Connecting Organic Chemistry Fundamentals to Real-World
Pharma Through Active Learning Review Modules

» Robert Perkins

A Picture Is Worth a Thousand Words: Leveraging Concept
Mapping to Help Students Dissect the Complexities of
Isomerism.

» Janell Mahoney

Student Involvement in Learning Organic Chemistry
» Christine Hermann

S244: Research Investigations in STEM Identity in Chemistry
Learning Environments

CP-179
Chaired by: Justin Carmel

Introduction (S244)
» Justin Carmel
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4:12pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

Impact of the Phone A STEM Professional assignment on
undergraduate chemistry students’ sense of belonging and
persistence

» Sara Martin, Melissa Schen, Kyla Babics

Learning Assistants in Science Classrooms and Students’
Science Identity

» O. Theresa Ayangbola, Katy Hosbein

$194: Trends in GOB Chemistry
CP-201
Chaired by: Corina Brown

Introduction (5194)
» Corina Brown

Exploring Interdisciplinary Knowledge Integration using
Systems Thinking and Mechanistic Reasoning frameworks

» Vinutha Ravinageswaran, Maria Oliver-Hoyo

Gamifying the Math Content in a GOB Course
» Breeyawn Lybbert

Teaching metacognition, effective learning practices, and
strategies for enhancing focus with short pre-class videos
and in-class quizzes.

» Doug Schirch

Panel Discussion (S194)
» kim woodrum

S$138: Course-based Undergraduate Research Experiences
(CUREs): Assessments, Barriers and Opportunities

CP-208

Chaired by: K Joseph Ho and Tracy Terry and Diana Habel-Rodriguez

Introduction (S138)
» Elinor Soult
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3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

Experiences Incorporating a Research-Based NMR Activity
Into the General Chemistry Lab

» Janice Hall Tomasik, Cassie Gardyszewski, Kyle Biegas, Milah
Curry, Jordan Kobielus, Anja Mueller, Benjamin Swarts, Itzel
Marquez, Bradley Fahlman

Chalcones for SARS-CoV2 in Organic Chemistry Lab CURE
» Jennifer Muzyka

A Small First-Semester General Chemistry CURE to Help
Chemistry Majors Gain Confidence in Pursuing Research
Opportunities at a Large R1 Institution

» Angela Bischof

The BASIL Biochemistry CURE: Fundamental Biochemistry
Concepts Taught Through the Analysis of Proteins of
Unknown Function.

» Stephen Mills, Jon Dattelbaum, Anya Goodman, Bonnie Hall,
Julia Koeppe, Ashley McDonald, Erika Offerdahl, Suzanne
O'Handley, Michael Pikaart, Rebecca Roberts, Arthur Sikora, Paul
Craig

$258: Teaching and Learning in the Al Revolution
CP-211
Chaired by: Jennifer Garcia Ramos

Introduction (S258)
» Jennifer Garcia Ramos

Teaching & Learning Theories in the Al Revolution
» Jennifer Garcia Ramos, Zakiya Wilson-Kennedy

Teaching and Learning with ChatGPT in General Chemistry
» Leslie Butler, Jennifer Garcia Ramos, Zakiya Wilson-Kennedy
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4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

Touch of Al on Chemistry Visuals: Chemistry Preservice

Teachers' Experiences and Reflections on Visuals Generated

by Artificial Intelligence
» Sevil Akaygun

Generative Al: Student Perspectives and Expectations
» Chloe Sells, Michelle Herridge

S75: Alternative Pathways in General Chemistry: Meeting the

Needs of Varied Student Populations
CP-220
Chaired by: Rebecca Ricciardo

Introduction (S75)
» Elinor Soult

On-line Homework in General Chemistry: Friend or Foe?
» Kristina Proctor

Dual-Enroliment Introductory Chemistry for Rural School
Systems

» Kevin Revell

Introducing Math in Introductory Chemistry
» Deborah Rosenthal

Group Discussion (S75)
» kKim woodrum

S$31: Current Research on the Undergraduate Chemistry
Laboratory

CP-222
Chaired by: Nikita Burrows

Introduction (S31)
» April French
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Continued from Wednesday, 31 July 3:45pm

3:51pm

4:12pm

4:33pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

Development of Pseudoscience-Based Independent Study
Research Projects at a Regional University Satellite Campus

» James Kabrhel

Teaching Research Skills to Undergraduates via a Novel
Rotations Model

» Stephanie Poland, Ross Weatherman, Rebecca DeVasher, Fumie
Sunahori

Grading with Artificial Intelligence in General Chemistry Lab |
» Olivia Harwick, John Wiginton, Jason Pearson

S57: Art and Archaeology as a Vehicle to Teach Core Chemical
Concepts

CP-287
Chaired by: Kevin Braun

Introduction (S57)
» Kevin Braun, Kristin Labby, Annelise Gorensek-Benitez

The Chemistry of Artist's Materials: Using Historical Dye
Extraction Procedures and the Identification of Unknown
Dyes Via Photoluminescence to Teach Principles in Acid-Base
Chemistry, Solubility, and Spectroscopy

» Hannah Lant

Chemical Analysis of Simulated Ancient Ceramics as a Final
Project in General Chemistry

» Donald Storer

Chemistry of Tattoos: Employing the Art on Skin to Convey
Chemistry Concepts

» Geeta Govindarajoo

Q&A Session (S57)
» Kevin Braun, Kristin Labby, Annelise Gorensek-Benitez
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3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

S72: Re-envisioning Grading and Assessments for Enhanced
Student’s Learning Experience

JSB-121
Chaired by: Marwa Abdel Latif

Introduction (S72)
» Marwa Abdel Latif

Implementing an Exam Retake Grading System in Organic
Chemistry

» Alexis Courtney

The DUCKs System: Laboratory Skills Assessments Linking
First-Year Chemistry and Biology Courses

» Mary Ross, Tim Sonbuchner

Targeting Students at the Cusp of the Hyperpersistent Zone:
Implementation of Metacognitive and Utility-Value
Assessments in a First Semester General Chemistry Course

» |essica Siemer

Never out of Style: Improving Student Learning Through
Learner-Focused Assignment Design

» Bridget Trogden, Abby Boyd

S74: Engaging Students in Physical Chemistry
JSB-213
Chaired by: Craig Teague

Introduction (S74)
» Elinor Soult

Connecting Molecular Orbital Theory to UV-Vis Absorption
for the Particle in a Box Experiment
» Prajay Patel

Opening the Black Box: Density Functional Theory by Hand
» |esse Tye
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4:33pm

4:54pm

3:45pm

3:45pm

3:51pm

4:12pm

4:33pm

4:54pm

Structuring Student Developed Procedures and Analysis in
the Physical Chemistry Laboratory

» Daniel Albert

Q&A Session (S74)
» Craig Teague

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (S267)
» Elinor Soult

Information Literacy in the Science Classroom: A national
survey of the United States K-12 science teachers

» Matilynn Lam, Christopher Randles

Interviews with Undergraduate Chemistry Faculty:
Exploration of perceptions and implementation of
alternative grading

» Ariana McDarby, Megan Gibas, Alexey Leontyev

General Chemistry Instructors’ Perceptions of Research-
Based Assessment Tools

» Emily Kable, Ying Wang, Lu Shi, Marilyne Stains

Chemistry as a Discipline of Practice: Rubrics to assess and
provide feedback on science practices

» Vinay Bapu Ramesh, Renée Cole

Powered by Ex Ordo, everything you need to run a research conference.

Thursday, 1 August

7am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

Breakfast
Champions Kitchen, inside Gatton Student Center

$106: Al and Machine Learning as Agents of Change in
Chemistry Education

CP-114
Chaired by: Serenity Desmond

Introduction (S106)
» Elinor Soult

The Frontier is Here: Bringing Al/ML and Automated
Synthesis to Undergraduate Labs

» Nolan Green, James Planey, Serenity Desmond, Martin Burke

Using ChatGPT to Support Lesson Planning for Historical
Experiments in General Chemistry

» Ted Clark, Matt Queen, Matthew Fhaner, Matthew Stoltzfus

Bridging Research and Learning in Al Chemistry with the
Digital Molecule Maker

» James Planey, Sabrina Abdulla

Stemble: Leveraging Artificial Intelligence to Accelerate
Learning and Empower Educators in Chemistry

» ]Jason Pearson
$231: Active Learning in the Organic Chemistry Laboratory
CP-153

Chaired by: Sara Mata and Benjamin Burlingham

Introduction (S231)
» Sara Mata
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8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

Alkylation of Anisole using Alkenes and Alcohols as
Electrophile Precursors

» John Struss

Writing in Authentic Science Genres in the Organic Chemistry
Il Laboratory to Improve Student Perceptions of Themselves
as Writers and Belonging in STEM

» Rebecca Black

Measuring engagement in the laboratory through multi-step
synthesis and in its lecture through ungraded participation

» Sara Mata

Recognize Me?: Evaluation of an Inquiry-Based, Unknown
Identification Laboratory Using Student-Synthesized
Compounds

» Margaret Meadows

S84: Active Learning in Organic Chemistry
CP-155
Chaired by: Cathy Welder and Matt Leathen

Introduction (S84)
» Matt Leathen

Mastery Quizzes for Essential Topics in Organic Chemistry
» Matt Leathen

Specifications Grading: Initial Implementation Results and
Impressions

» Richard Macri

Incorporating a Variety of Active Learning Strategies in an
Elementary Organic Chemistry Course Creates a Pathway for
Student Success

» Thomas Greenbowe
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8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

Structure, Structure, Structure: Development of 1H and 13C
NMR and GCMS OChem Active Learning Modules

» Scott Donnelly

$261: STEM Outreach
CP-183
Chaired by: Jacquelyn Cole

Introduction (5261)
» Matt Queen

Community Outreach in Chemistry - How to Get Started
» Angela Miller

Volunteer engagement, training and recognition in outreach
to the community: how do I find resources?

» Lori Stepan

Undergraduate Student Practitioners’ Confidence in
Participating in Chemistry Outreach Activities

» KatieMarie Magnone, Merryn Cole, Justin Pratt

Grab-a-Lab STEAM Tote Kits
» Jacquelyn Cole, Haley Albright, Sytil Murphy

$194: Trends in GOB Chemistry
CP-201
Chaired by: Corina Brown and Ann Murkowski

Introduction (S194)
» Corina Brown

Strategies to encourage and evaluate learning in a one
semester GOB course.

» Brenda Miller
Implementation of Specifications Grading in a One-Semester

GOB Course
» Kevin Welch
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9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

8:30am

8:30am

Creativity in an (Inter)Active GOB Classroom: 7:30 am
Chemistry Class Was Never Such Fun!

» Sheryl Mason

Students as Partners (SaPs) and Learning Assistants (LAs):
Valuable partners in the quest to promote student
engagement and learning in a large enrollment General,
Organic, and Biological (GOB) Chemistry course.

» Mona Maalouf

$138: Course-based Undergraduate Research Experiences
(CURESs): Assessments, Barriers and Opportunities

CP-208
Chaired by: K Joseph Ho and Tracy Terry and Diana Habel-Rodriguez

Introduction (S138)
» Elinor Soult

Research Spine: Towards Building Future Leaders and
Innovators

» Sesha Sridevi Alluri

Development, Teaching, and Assessment of an
Interdisciplinary Course-Based Undergraduate Research
Experience (CURE) to Engage Students in STEM

» Whitney Duim, Emily Liu

Catalyzing Collaboration: Unveiling the Impact of
Interdisciplinary Teams in the NSF SSTEM INSPIRE Program
» wendy schatzberg

$176: Lessons Learned as a Chemistry Lecture/Lab Coordinator
CP-211
Chaired by: Stephanie Jones

Introduction (S176)
» Stephanie Jones
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8:57am

9:18am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

Coordination of Lecture and Laboratory Courses at UTSA

» Susan Thomas, Hadi Arman, Mark Davidson, Victoria Dougherty,
Gerardo Elguezabal, Blain Mamiya, Sarah Oerther, Wei Reeves

Formative Assessment Decisions: How Many, How Flexible,
and How Well-Aligned

» Liana Lamont, Rachel Bain, Jaclyn Trate, Jeremy Weaver

Simplifying for Success: General Chemistry Lecture
Coordination at the University of Cincinnati

» Daniel Waddell, Megan Bucks

$20: ChemEd X: Engaging with Contributors
CP-220
Chaired by: Jon Holmes

Introduction (S20)
» Elinor Soult

The Best (!) Order of Topics for 11 and AP Chemistry
» Michael Jansen

Fake science? Using current media resources to develop CER
skills

» Karen Sorensen

Change "Do Nows" into Team Think Tank Problems
» Kristen Drury

Social Justice Science Issues in Your Chemistry Classroom
» Nina Hike

$195: Big 10 Gen Chem Labs: Advances, Innovations, and
Challenges

CP-222
Chaired by: Eric Malina

Introduction (S195)
» Elinor Soult
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8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

College- and Course-level strategies for pedagogical
development of undergraduate learning assistants in general
chemistry labs

» Rachel Barnard

TA Training on Grading: Introducing “Grading Philosophy” and
“Conversations with Students About Grades” sessions to
incoming graduate TAs

» Katie Gesmundo, Casandra Moisanu

(Re)conceptualizing Laboratory Teaching Assistants’
Identities-in-Practice: Insights for LTA Training and Growth
toward both Equity and Excellence in General Chemistry.

» Matt Wu, Dalyanne Hernandez-Sanchez, Cassandra Miller

Work smarter not harder. Using automated workflows to
reduce administrative workload in large-enroliment
laboratory courses.

» Angela Bischof

S57: Art and Archaeology as a Vehicle to Teach Core Chemical
Concepts

CP-287
Chaired by: Kevin Braun

Introduction (S57)
» Kevin Braun, Kristin Labby, Annelise Gorensek-Benitez

Identifying Wine Residue in Archaeological Pottery: An
Advanced Undergraduate Laboratory in Archaeological
Chemistry

» Kevin Braun

Teaching and learning about light and color with Josef Albers
Interactions of Color

» Gemma D'Ambruoso, Jennifer Shepherd
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9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

From Pigments to Paintings: Integrating Collaborative Art
Projects into the Chemistry Laboratory

» Brian McBurnett

Exploring Natural Dyes through Reflectance Spectroscopy
» Annelise Gorensek-Benitez

$203: Learning from Failure
CP-297
Chaired by: Stephanie Myers

Introduction (S203)
» Stephanie Myers

“Having a Bad Day” Test Score Mitigation Strategies
» Stephanie Myers, Jennifer Staude

Heeding the Lessons of Failure: Crystal Growing Edition
» Rachel A Morgan Theall

Inviting Failure and Rewarding Iterative Improvement in the
General Chemistry Lab

» Eli Fahrenkrug, Annelise Gorensek-Benitez, Timothy Gould, Jared
Harris

Students’ Experiences with Failure in a Workshop-based
Undergraduate Research Experience

» Adrian Wierzchowski, Donald Wink

$276: Designing and Implementing CUREs for 1st and 2nd year
Chemistry Courses

JSB-103
Chaired by: Melanie Harvey

Introduction (5276)
» April French
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8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:36am

8:57am

9:18am

A Course-Based Undergraduate Research Experience for a
Nonmajors GOB Course at a Community College

» Melanie Harvey

Expanding a General Chemistry Laboratory Course Into a
Research-Based Learning Environment: A More Engaging
Student Learning Experience

» Hasani Jayasinghe

Incorporating Local Natural Resource Research Into a
General Chemistry Il Laboratory Curriculum

» James Doble, Jacob Wainman

Evaluating a Course-Based Undergraduate Research
Experience for Deaf/Hard-of-Hearing Students and its Place
Within the Curriculum

» Annemarie Ross

§72: Re-envisioning Grading and Assessments for Enhanced
Student’s Learning Experience

JSB-121
Chaired by: Marwa Abdel Latif

Introduction (572)
» Marwa Abdel Latif

Assessing for Growth: Revising Evaluations to Cultivate
Growth Mindset and Advance Student Success

» Meghan Porter, [ill Robinson

Fostering Exam Success by Providing Interactive Online
learning Environments for Self-Regulated Learning

» Florian Trauten, Carolin Eitemuller, Maik Walpuski

The Carrot and Stick Approaches to Assessment: Points vs
Percentage

» John Suchocki
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8:30am

8:30am

8:36am

8:57am

9:18am

9:39am

8:30am

8:30am

8:5Tam

Integrating a Negotiable Grading Scheme in General
Chemistry

» Amy Kabrhel

S74: Engaging Students in Physical Chemistry
JSB-213
Chaired by: Craig Teague

Introduction (S74)
» Elinor Soult

Developing a Practical Guide to Curve Fitting and
Experimental Data Analysis

» Kyle Schnitzenbaumer

Using Jupyter Notebooks in a Guided Inquiry Lab
Environment

» Melissa Reeves, Rob Whitnell, Laine Berghout, Timothy Brewer,
Hanae Haouari, Sally Hunnicutt, Jessica Johnston

Exploring Luminescent Halide Materials: An Adaptable,
Inquiry-Based Lab for Short Laboratory Sessions

» Max Wallace

Green-er PChem labs
» Cynthia Woodbridge, Grayson Watts

$267: Chemistry Education Research: Graduate Student
Research Symposium

JSB-321
Chaired by: Michelle Herridge

Introduction (5267)
» Michelle Herridge

Utilizing Eye-Tracking in a Chemistry Online Homework
Gamification Study

» Morgan Clark, Thomas Holme
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9:12am

9:33am

9:54am

8:30am

8:30am

8:30am

How General Chemistry Students Gesture About Gas Laws
and Gas Molecules

» Ashley Manning, Mike Stieff

“I just go with what | think studying should be": General
chemistry students insights on studying choices

» Kendra Keenan, Andrew Baquero, Ebtisam Alsharabi, Justin Pratt

8:30am

Factors that Influence General Chemistry Students’ Decision
Making in Study Strategies

» Pallavi Nayyar, Betul Demirdogen, Scott Lewis

Real Intelligence (Still) Beats Artificial Intelligence: Engaging
Students with Inquisitive Molecular Modeling

JSB-108
Chaired by: Jurgen Schnitker
8:30am

Real Intelligence (Still) Beats Artificial Intelligence: Engaging
Students with Inquisitive Molecular Modeling

» Jurgen Schnitker

WebMO Hands-On Workshop
JSB-114
Chaired by: William Polik

WebMO Hands-On Workshop

» William Polik, JR Schmidt Ll

. . . 10:15am
Chemistry with Unity

JSB-243
Chaired by: Steven Sogo

Chemistry with Unity
» Steven Sogo, Peggy Au

10:15am
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Aligning ELIPSS transferable skill rubrics with assessment
needs

JSB-337
Chaired by: Suzanne Ruder

Aligning ELIPSS transferable skill rubrics with assessment
needs

» Suzanne Ruder, Juliette Lantz, Renée Cole

Development and Implementation of a Learning Model Where
Students Experience the Scientific Research Process Through
Bioinformatic Protein Modeling

JSB-347
Chaired by: Arthur Sikora

Development and Implementation of a Learning Model
Where Students Experience the Scientific Research Process
Through Bioinformatic Protein Modeling

» Arthur Sikora, Omar Saleh, Emily Schmitt Lavin

Online certification courses to help experimental graduate
students incorporate molecular modeling into their research

JSB-357
Chaired by: Rachel Clune

Online certification courses to help experimental graduate
students incorporate molecular modeling into their research

» Rachel Clune, Katie Dahlquist, Aisha Oza, Sriram Krishnamurthy,
Mathew Halls, Michael Rauch

Break

$106: Al and Machine Learning as Agents of Change in
Chemistry Education

CP-114
Chaired by: Serenity Desmond

Introduction (5106)
» Elinor Soult
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10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:15am

10:15am

10:217am

Enhancing Chemistry Instruction through Artificial
Intelligence: A Case Study from Tulsa Community College

» Luis Bello

Integrating Machine Learning into a Chemistry Elective: No
Prior Coding Experience Required

» Bonnie Hall

Leveraging Generative Al to Teach Effective Design of Data
Visualizations

» Benjamin Lear

MolSSI Industrial Training Program: Connecting Innovative
Minds with Industrial Skills

» Mohammad Mostafanejad, Ashley McDonald

$231: Active Learning in the Organic Chemistry Laboratory
CP-153
Chaired by: Sara Mata and Benjamin Burlingham

Introduction (S231)
» Sara Mata

Multi-outcome, Guided Inquiry-Based Laboratories for
Introductory Organic Chemistry

» Kylie Luska

S84: Active Learning in Organic Chemistry
CP-155
Chaired by: Cathy Welder and Matt Leathen

Introduction (S84)
» Matt Leathen

Large Class Organic Chemistry Teaching Method Which
Students Enjoy

» Donna Nelson
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10:42am

11:03am

10:15am

10:15am

10:21am

10:42am

11:03am

11:24am

10:15am

10:15am

How Does That Work? A Brief Organic Reaction Mechanisms
Course

» Justine Olson, Anne Moody

Q&A Session (S84)
» kim woodrum

$261: STEM Outreach
CP-183
Chaired by: Jacquelyn Cole

Introduction (5261)
» kKim woodrum

Engaging your Local ACS Section in Community Outreach
» Phil McBride

Imaging the World: Bringing Atomic Scale Imaging to High
School Students

» Benjamin Smith, Edward Zovinka, Rose Clark, Ashley Smith-
Diemler, Jessica Campbell

Effectiveness of Hands-On Outreach Workshops on High
School Students' Perception of Chemistry

» Ajay Mallia, Patrice Bell

A Data Driven Look at Outcomes from an Informal Science
Lab Training for underserved STEM Students

» Brandon White, Becky Mercer

$194: Trends in GOB Chemistry
CP-201
Chaired by: Corina Brown and Lafayette Eaton

Introduction (5194)
» Corina Brown
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10:217am

10:42am

11:03am

11:24am

10:15am

10:15am

10:217am

10:42am

10:15am

Predicting Chemical Behavior Through Patterns in Bonding:
Targeting Fundamentals Using an Online Learning Tool

» Laura Van Dorn

Leveraging Undergraduate Research to Reduce Equity Gaps
in Gateway Chemistry Courses

» Ann Murkowski

Implementation of a Combined GOB Lecture/Lab Course: A
Look at Student Performance and Perceptions

» Thomas Stringfield

Panel Discussion (S194)
» kim woodrum

S$138: Course-based Undergraduate Research Experiences
(CURESs): Assessments, Barriers and Opportunities

CP-208
Chaired by: K Joseph Ho and Tracy Terry and Diana Habel-Rodriguez

Introduction (S138)
» K]oseph Ho

Future Professors, Scientists, and Engineers: Integrating
Career Development Into Undergraduate Teaching in a
Classroom

» Chao Guan

Development of an Interdisciplinary CURE for First Year
Students: Challenges and Opportunities

» Cesar Gonzalez

S$176: Lessons Learned as a Chemistry Lecture/Lab Coordinator
CP-211
Chaired by: Stephanie Jones

Powered by Ex Ordo, everything you need to run a research conference.

10:15am

10:217am

10:42am

10:15am

10:15am

10:217am

10:42am

11:03am

10:15am

10:15am

Introduction (S176)
» Stephanie Jones

Ways to Improve Student and Instructional Team Experience
When You Like Your Curriculum

» Rachel Barnard

Optimizing Coordination: Insights from Coordinating PUI
Majors and Non-Majors Freshman Chemistry Courses

» Amanda Waters, Stephanie Jones

$20: ChemEd X: Engaging with Contributors
CP-220
Chaired by: Jon Holmes

Introduction (S20)
» Elinor Soult

Sugar and Spice and Everything Nice: Teaching a High School
Food Chemistry Elective

» Ariel Serkin

Using interactive manipulatives to build contextual
connections (with or without notebooking)

» Nora Walsh

Siberian Tiger Urine, Locusts Plagues, and Dying Salmon:
Engaging Chemistry to Engage Students

» Scott Donnelly

$195: Big 10 Gen Chem Labs: Advances, Innovations, and
Challenges

CP-222
Chaired by: Eric Malina

Introduction (5195)
» Elinor Soult
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10:217am

10:42am

10:15am

10:15am

10:217am

10:42am

11:03am

10:15am

10:15am

Insights from End-of-Semester Surveys: Common Learning
Outcomes in Students' Favorite General Chemistry
Laboratory Experiments

» Bernice Opoku-Agyeman, Camila Fontes

Examining Knowledge Retention and Attitude towards
Chemistry in a Large Enrollment General Chemistry Course

» Angelique Ithier

S57: Art and Archaeology as a Vehicle to Teach Core Chemical
Concepts

CP-287
Chaired by: Kevin Braun

Introduction (S57)
» Kevin Braun, Kristin Labby, Annelise Gorensek-Benitez

Advanced Chemistry Hiding in Pottery and Glazes
» Ryan Coppage

Ceramic Glazes - Adventures in the Chemistry of Art

» Carol Ann Miderski, ChaMarra Sanar, Lorraine Laguerre, Rachel
Gunsch

Visualizing the Chemical Structures of Colorants: An
Adventure in Building “Games” and Making Exhibitions

» Patricia Jue

$203: Learning from Failure
CP-297
Chaired by: Stephanie Myers

Introduction (S203)
» Stephanie Myers
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10:21am

10:42am

11:03am

10:15am

10:15am

10:217am

10:42am

11:03am

10:15am

10:15am

Change the Course with Errors - Influence of Erroneous
Examples on Learning Outcomes

» Sonja Dieterich, Stefan Rumann, Marc Rodemer

Reframing Failure: Reflecting on Learning Opportunities in
Research Framework Development

» Natalie Ulrich, Eileen Kowalski

Panel Discussion (5203)
» Stephanie Myers

$276: Designing and Implementing CUREs for 1st and 2nd year
Chemistry Courses

JSB-103
Chaired by: Melanie Harvey

Introduction (S276)
» April French

Design, Synthesis, and Analysis of Quorum Sensing in Vibrio:
A Year-Long CURE for First and Second-Year Students.

» Laura Brown

Developing a Sustainable CURE Focused on Water Quality for
a First-Semester, General Chemistry Course at an Open-
Access Suburban Community College

» Amanda Glass, Lori Slavin

Panel Discussion (S276)
» kim woodrum

S72: Re-envisioning Grading and Assessments for Enhanced
Student’s Learning Experience

JSB-121
Chaired by: Marwa Abdel Latif

Introduction (S72)
» Marwa Abdel Latif
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10:217am

10:42am

11:03am

10:15am

10:15am

10:217am

10:42am

11:03am

Quasi-Group Exams - How to Make Them Work in Large
Science Courses

» Rachel Branco

Exam Performance as a Measure of Learning: Impact of
Timed Pre-Exam Quizzes on Student Preparedness and
Performance in General Chemistry Exams

» Christopher DeSantis, Bhavani Balasubramanian, Mieke Peels

Assessment in the Classroom: Perspectives of General
Chemistry Students and Instructors

» Morgan Balabanoff, Oluwatobi Odeleye

S74: Engaging Students in Physical Chemistry
JSB-213
Chaired by: Craig Teague

Introduction (S74)
» Elinor Soult

Engaging Students in Scientific Practices Using the POGIL-PCL
Framework

» Diane Miller, Jordan Beck

Introducing physical chemistry students to FRET using a
POGIL-PCL experiment

» Jordan Beck, Diane Miller, Andrea Carter

Q&A Session (S74)
» Craig Teague
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